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Preface

Thank you for purchasing TOSHIBA Multifunctional Digital Systems. Also this guide describes instructions on how to set
up the printer drivers required for this equipment, and how to print with them. Read this manual before using your
Multifunctional Digital Systems. Keep this manual within easy reach, and use it to configure an environment that makes
best use of the e-STUDIO’s functions.

Bl How to read this manual

0 Symbols in this manual

In this manual, some important items are described with the symbols shown below. Be sure to read these items before
using this equipment.

A WARNING Indicates a potentially hazardous situation which, if not avoided, could result in death, serious
injury, serious damage, or fire in the equipment or surrounding assets.

A CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate
injury, partial damage to the equipment or surrounding assets, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with
the following signage:

Tip Describes handy information that is useful to know when operating the equipment.
(e Pages describing items related to what you are currently doing. See these pages as required.

U Model and series names in this manual

In this manual, each model name is replaced with the series name as shown below.

Model name Series name in this manual
e-STUDIO287CS/347CS/407CS e-STUDIO407CS Series

0 Screens and Operation Procedures

¢ In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the installed
options, the OS version and the applications.

* If you use Windows Server 2008 R2, refer to the operation procedure for Windows 7, though the screens or the menu
names, etc. may differ.

¢ In this manual, the screens and the operation procedures in Macintosh are described for Mac OS X 10.6.x and Mac
0OS X 10.8.x.
The details on the screens may differ depending on how the equipment is used, such as the status of the installed
options, the OS version and the applications.

* In this manual, the initial values of the setting items are underlined.

Q Install Disk co-packed with the equipment

In this manual, the disks for installing the software are generically described in "Install Disk".
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O Trademarks

* The official name of Windows XP is Microsoft Windows XP Operating System.

* The official name of Windows Vista is Microsoft Windows Vista Operating System.

* The official name of Windows 7 is Microsoft Windows 7 Operating System.

* The official name of Windows 8 is Microsoft Windows 8 Operating System.

* The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.

* The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.

* The official name of Windows Server 2012 is Microsoft Windows Server 2012 Operating System.

¢ Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are
trademarks of Microsoft Corporation in the US and other countries.

* Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple Inc. in the US and other
countries.

* Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

* Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and other
countries.

* IBM, AT and AlX are trademarks of International Business Machines Corporation.

* NOVELL, NetWare, and NDS are trademarks of Novell, Inc.

* TopAccess is a trademark of Toshiba Tec Corporation.

* Other company and product names given in this manual or displayed in this software may be the trademarks of their
respective companies.
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End User Software License Agreement

INSTALLING OR OTHERWISE USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR ACCEPTANCE OF THE
FOLLOWING TERMS AND CONDITIONS (UNLESS A SEPARATE LICENSE IS PROVIDED BY THE SUPPLIER OF
APPLICABLE SOFTWARE IN WHICH CASE SUCH SEPARATE LICENSE SHALL APPLY). IF YOU DO NOT ACCEPT
THESE TERMS, YOU MAY NOT INSTALL OR USE THIS SOFTWARE, AND YOU MUST PROMPTLY RETURN THE
SOFTWARE TO THE LOCATION WHERE YOU OBTAINED IT.

Grant of License:

This is a legal agreement between you, the end-user (“You”), and TOSHIBA TEC Corporation (“TTEC”). This software,
fonts (including their typefaces) and related documentation (“Software”) is licensed for use with the system CPU on which
it was installed (“System”) in accordance with the terms contained in this Agreement. This Software is proprietary to TTEC.
TTEC disclaim responsibility for the installation and/or use of this Software, and for the results obtained by using this
Software. You may use one copy of the Software as installed on a single System, and may not copy the Software for any
reason except as necessary to use the Software on a single System. Any copies of the Software shall be subject to the
conditions of this Agreement. You may not, nor cause or permit any third party to, modify, adapt, merge, translate, reverse
compile, reverse assemble, or reverse engineer the Software. You may not use the Software, except in accordance with
this license. No title to the intellectual property in the Software is transferred to you and full ownership is retained by TTEC.
Source code of the Software is not licensed to you. You may not perform modification, deletion, etc. about copyright notice
of the Software (including in duplicate).You will be held legally responsible for any copyright infringement, unauthorized
transfer, reproduction or use of the Software or its documentation.

Term:

This license is effective until terminated by TTEC or upon your failure to comply with any term of this Agreement. Upon
termination, you agree to destroy all copies of the Software and its documentation. You may terminate this license at any
time by destroying the Software and its documentation and all copies.

Disclaimer of Warranty:

This Software is provided “AS IS” without warranty of any kind, either express or implied, including, but not limited to, the
implied warranties of merchantability, fitness for a particular purpose, title, and non-infringement. TTEC disclaim any
warranty relating to the quality and performance of the Software. If the Software proves defective, You (and not TTEC)
shall be responsible for the entire cost of all necessary servicing, repair or correction. TTEC do not warrant that the
functions contained in the Software will meet your requirements or that the operation of the Software will be uninterrupted
or error free.

Limitation of Liability:

IN NO EVENT WILL TTEC BE LIABLE TO YOU FOR ANY DAMAGES, WHETHER IN CONTRACT, TORT, OR
OTHERWISE (except personal injury or death resulting from negligence on the part of TTEC), INCLUDING WITHOUT
LIMITATION ANY LOST PROFITS, LOST DATA, LOST SAVINGS OR OTHER INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF TTEC
OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, NOR FOR THIRD PARTY
CLAIMS.

U.S. Government Restricted Rights:

The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. Government is subject to
restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the Rights in Technical Data and Computer Software Clause set
forth in 2562.227-7013, or 52.227-19 (c) (2) of the DOD FAR, as appropriate. Contractor/Manufacturer is TOSHIBA TEC
Corporation, 1-11-1, Ohsaki, Shinagawa-ku, Tokyo, 141-0032, Japan

General:

You may not sublicense, lease, rent, assign or transfer this license or the Software. Any attempt to sublicense, lease, rent,
assign or transfer any of the rights, duties or obligations hereunder is void. You agree that you do not intend to, and will not
ship, transmit (directly or indirectly) the Software, including any copies of the Software, or any technical data contained in
the Software or its media, or any direct product thereof, to any country or destination prohibited by the United States
Government. This license shall be governed by the laws of Japan or, at the election of a Supplier of TTEC concerned with
a dispute arising from or relating to this Agreement, the laws of the Country designated from time to time by the relevant
Supplier of TTEC. If any provision or portion of this Agreement shall be found to be illegal, invalid or unenforceable, the
remaining provisions or portions shall remain in full force and effect.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT YOU UNDERSTAND ITS
PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT THIS
LICENSE AGREEMENT CONTAINS THE COMPLETE AND EXCLUSIVE AGREEMENT BETWEEN YOU AND TTEC
AND ITS SUPPLIERS AND SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, OR ANY
OTHER COMMUNICATION RELATING TO THE SUBJECT MATTER OF THIS LICENSE AGREEMENT.

TOSHIBA TEC Corporation, 1-11-1, Ohsaki, Shinagawa-ku, Tokyo, 141-0032, Japan
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OVERVIEW

This chapter provides an overview of the printing functions.
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Features and Functions

Extensive Client Platform Support

This equipment supports printing from IBM-compatible PC, Macintosh, and UNIX/Linux workstations. Not all features are
supported on all platforms, however.

Various Port Options
You can map this equipment to print to an SMB, IPP, Raw TCP, WSD, or LPR port.

Multiple Job Types

Job Types refer to the way this equipment handles a print job.

* The Normal mode requires no special handling and is the most frequently used printing mode.

» Scheduled Print lets you specify the time and date at which to print a job.

* The Private Print mode allows you to hold a job in the print queue until you enter a password at the copier touch panel
to print the job.

¢ The Hold Print mode allows you to hold a job in the hold queue until you continue the job from the touch panel.

* The Proof Print mode prints the first copy of a multi-copy job and then awaits your approval before printing the
remaining copies.

» Overlay File prints a document element, such as text or graphics, to a file for superimposing on the background of
other documents.

* The Store to e-Filing mode allows you to store the printed document in e-Filing.

e The Multiple Job Type feature allows you to print jobs of more than one type together. For example, you can store a job
in the specified e-Filing and print it at the specified time by combining Scheduled Print and Store to e-Filing.

These functions below are available only when the hard disk is installed in the equipment.
- Scheduled Print

- Private Print

- Hold Print

- Proof Print

- Store to e-Filing

- Multiple Job Type

Sophisticated Document Layout and Assembly Options

You can choose whether to print your document as you have set it up in the application, or to impose printer-driven
document layout options such as printing in Book Format or printing Multiple Pages per Sheet.

Additionally, the printer drivers provide the ability to print selected pages on different media. This includes printing front
and back covers, inserting sheets at predefined positions within the document, or interleaving pages so that every other
page is inserted blank or printed on a different type of media.

Various Sizes of Printing Paper Available

You can use paper larger than the standard sizes defined in the custom paper size setting when you print data created
with applications.

Watermark and Image Overlay Support

Watermarks are a great way to subtly convey useful information about your printed documents. Common watermarks are
“Confidential,” “Draft,” and “Original.” Several watermarks have been pre-defined for use with your documents, or you can
create and save your own custom watermarks.

Watermarks consist of text. Image Overlays can be any combination of text, graphics or other document elements.
Printing watermarks consumes fewer resources than using Image Overlays, so you should use watermarks wherever
possible, particularly when printing speed is an issue.
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About Printer Drivers

Printer drivers required for each OS are included in the Install Disk. For instructions on how to install them, refer to the
Software Installation Guide. n

B For Macintosh

Printer drivers required for Macintosh OSs are included in the following folders of the Install Disk:

Macintosh PPD files

¢ [Install Disk]: MacPPD
This includes the PPD files to enable printing from Macintosh on the Mac OS X 10.4.x to 10.6.x and Mac OS X 10.7 or
later, and the plug-in files used for printing from Macintosh computers.

B For UNIX/Linux

Printer drivers required for UNIX/Linux are included in the following folders of the Install Disk:

Solaris filter

The tar file for Solaris v2.6/2.7/7.8/8/9/10 is included in the following folder:
Choose the appropriate file depending on the model to be used.
* Color MFP
[Install Disk]/Admin/Color_Unix_Linux/SolarisFilter/Usa/
* Black and White MFP
[Install Disk]/Admin/BW_Unix_Linux/SolarisFilter/Usa/

HP-UX filter

The tar file for HP-UX ver.10.20/11.x and HP-UX64 ver.11.31 is included in the following folder:
Choose the appropriate file depending on the model to be used.
* Color MFP
[Install Disk])/Admin/Color_Unix_Linux/HP-UXFilter/Usa/
* Black and White MFP
[Install Disk]/Admin/BW_Unix_Linux/HP-UXFilter/Usa/

AIX filter

The tar file for AIX 4.3.3 is included in the following folder:
Choose the appropriate file depending on the model to be used.
* Color MFP

[Install Disk]/Admin/Color_Unix_Linux/AlIXFilter/Usa/
* Black and White MFP

[Install Disk]/Admin/BW_Unix_Linux/AlIXFilter/Usa/

Linux filter
The tar file for Red Hat 7.x/8.x/9.x, Red Hat Enterprise WS2, SuSE Linux 7.x/8.x/9.x, Mandrake Linux 7.x/8.x/9.x and
Turbolinux 8/10 is included in the following folder:
Choose the appropriate file depending on the model to be used.
e Color MFP
[Install Disk]/Admin/Color_Unix_Linux/LinuxFilter/Usa/
* Black and White MFP
[Install Disk]/Admin/BW_Unix_Linux/LinuxFilter/Usa/

SCO UNIX filter

The tar file for SCO UnixWare 7 and SCO Open UNIX 8 is included in the following folder:
Choose the appropriate file depending on the model to be used.
e Color MFP
[Install Disk]/Admin/Color_Unix_Linux/OpenUnixFilter/Usa/
* Black and White MFP
[Install Disk]/Admin/BW_Unix_Linux/OpenUnixFilter/Usa/
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CUPS PPD file

The PPD file to enable printing from CUPS is included in the following folder:
Choose the appropriate file depending on the model to be used.
* Color MFP
- [Install Disk]/Admin/Color_Unix_Linux/CUPS/Usa/2-sided_default/
This PPD file enables to set 2-sided printing by default.
- [Install Disk]/Admin/Color_Unix_Linux/CUPS/Usa/normal/
This PPD file enables to set 1-sided printing by default.
* Black and White MFP
- [Install Disk]/Admin/BW_Unix_Linux/CUPS/Usa/2-sided_default/
This PPD file enables to set 2-sided printing by default.
- [Install Disk[/Admin/BW_Unix_Linux/CUPS/Usa/normal/
This PPD file enables to set 1-sided printing by default.
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PRINTING FROM WINDOWS

This chapter provides instructions on how to print from a Windows computer.
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Before Using the Printer Driver

Before printing, you have to configure the following options:

¢ Configuration Settings
To use optional devices such as optional drawers and the Finisher, you must first configure these devices. The
features of these optional devices are not available unless you inform the system that the optional devices are
installed.

Before printing, you can configure the following option if necessary:

¢ Department Code
You can use department codes to manage each job. For example, a system administrator can check how many sheets
of copies a certain department has made. When the Department code is enabled, you are prompted to enter a
department code before printing. If you enter the department code in the corresponding field in advance, you can print
without having to do this every time. Ask your administrator about the codes. When SNMP communication between
the equipment and your computer is enabled, you are also prompted to enter the code before printing.

H Configuring the options

To use this equipment properly, you need to save the configuration of the options installed on the [Device Settings] tab
menu after you installed the printer drivers. In the default setting, you can obtain the configuration data of options installed
automatically by opening the [Device Settings] tab menu. If SNMP communication between this equipment and your
computer is not available, or you want to configure options manually, see the following page:

P.13 “Configuring options manually”

When SNMP communication between this equipment and your computer is enabled, you can retrieve the option
configuration information by clicking [Update Now].

Device Settings Fetriewval
| Update Automatically

| Update Mow

| Fiestore Defaults |
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QO Configuring options manually

If SNMP communication between this equipment and your computer is not available:

Setting the [Device Settings] tab manually

You need to log in to Windows with the “Administrator” privilege.

1 Click [Start] menu and select [Devices and Printers].
The Printers folder appears.

Tips

* For Windows Vista or Windows Server 2008
Click [Start] menu, [Control Panel], [Hardware and Sound] and select [Printers].

¢ For Windows XP or Windows Server 2003
Click [Start] menu and select [Printers and Faxes].

* For Windows 8 or Windows Server 2012, see the procedures in the following section.
LD P.16 “Accessing the printers folder on Windows 8 / Windows Server 2012”

2 Select the printer driver for this equipment, and then click [Printer properties] in the
[File] menu.
The printer driver properties dialog box appears.

o= ]
Q\J [ <« Hardware and .. » Devices and Printers » ~ [ 4 ||| Search Devices and Printe )
Edit View Tools Help
See what's printing See what's printing Print server properties > = - @
v 265(|efau|tprmter
1 Printing preferences
Printer properties
Create sharteut %3
Delete b
Rename
Properties
Clase
Troubleshaot
Remove device
= " . v " }
Fax Microsoft XPS TOSHIBA ~ TOSHIBA TOSHIBA
Document Writer  e-STUDIO Fax | Universal Printer | Universal PS3
2
) TOSHIBA Universal Printer 2 State: ‘\':l‘ Default I Status: 0 document(s) in queue
{ Model: TOSHIBA Universal Prin...
W Category: Printer

e For Windows XP / Windows Vista / Windows Server 2003 / Windows Server 2008, click [Properties] in the [File]
menu and select the printer driver for this equipment.
» If the [File] menu is not displayed, press [Alt].
» If the dialog box displayed does not allow the printer driver properties to be changed, follow the procedure
below.
- For Windows Vista, click [Run as administrator] and [Properties] in the [File] menu.
If the password entry screen appears, enter the administrator password.
The [User Account Control] dialog box appears. Click [Continue].

- For Windows 7, some tab menus have a '&' button in the printer driver properties. To change the
properties, click on it. If the properties cannot be changed, ask your system administrator.
* To change a network-installed printer driver, the administrator privilege is necessary. Ask your system
administrator for details.
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3 Display the [Device Settings] tab menu, and set the following options.

= TOSHIBA Universal Printer 2 Properties [

| Generall Sharing | Parts | Advanced | ColorManagemenlI Seculilyl Device Settings

Maodel Selection:
[e-sTUDIO407CS -
Option
Drawvers:
lDrawer 1.2 & Drawer 3,4 vl
Finisher:
IInnerFimsher(lTray} vl
Mane
Mone
Inserter Unit
Autamatic Duplexing Unit
Device Settings Retrieval Harddish
Update Automatically!
lUpdate Automatically [ Drogwer Settings ] | Account Setfings
[ Restore Defaults ] l Version Information ]
[ ak ] [ Cancel ] [ Apply ] [ Help ]

Model Selection — This sets the model type. The setup items of the printer driver are changed according to the
model selected.

Selecting [Universal] restricts the printer driver functions to those common to all printers on the network, which
is convenient for using other printers with your printer driver.

Option — This option sets whether the following optional devices are installed.
* Drawers — This sets whether or not the drawers (2/3/4) and the Large Capacity Feeder are installed.
* Finisher — This sets whether or not the Inner Finisher is installed.

Tips

* Setup items differ depending on the option configuration.
* For more information about each item, see the descriptions about the [Device Settings] tab.
P.67 “[Device Settings] tab”

Click [Drawer Settings].

The [Drawer Settings] dialog box appears.
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5 Set the following options and click [OK].

s )
Paper Size: Paper Type: Attribute:
Drawer L: ‘M v| |p|ain v| |Nnne '|
Drawer2: (a5 ~| [piain ~| [mone -
Drawer 3. [gs ~| [prain ~| [mone -
Do ‘Letter v| |Plain v| |Nnne v|
Ad Plain None
Ad Plain None
Bypass Tray: |4 ramatic v| |Plain v| |Nnne v|
[] Ovenride Application Paper Source Seftings
Restore Defauits
[Ir] | Cancel
|

AT
N

Drawer 1 — Select the size and type of paper that is loaded in the 1st Drawer.

Drawer 2 — Select the size and type of paper that is loaded in the 2nd Drawer.

Drawer 3 — Select the size and type of paper that is loaded in the 3rd Drawer.

Drawer 4 — Select the size and type of paper that is loaded in the 4th Drawer.

LCF — Select the size and type of paper that is loaded in the Large Capacity Feeder when it is installed.
Bypass Tray — Select the type of paper that is loaded in the Bypass Tray.

Override Application Paper Source Settings — Select this check box to use the paper source setting in the
printer driver rather than the application setting.

Tips

* Setup items differ depending on the option configuration.
* For more information about each item, see the descriptions about the Drawer Settings.
P.69 “Drawer Settings”

6 Click [Apply] or [OK] to save settings.
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Accessing the printers folder on Windows 8 / Windows Server 2012

Follow the steps below to access the printers folder on Windows 8 / Windows Server 2012.

Move the cursor to the upper right corner or lower right corner of the computer screen,
and then select [Start] in the menu that appears.

Thursday
October 4

The [Start] screen appears.

2 Right-click in the blank area in the [Start] screen, and then click [All apps] that appears.

test0l &

Budapest, Hungary
1

Ga
"

) =]

mes Camera

Video

The [Apps] screen appears.
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3 Click [Control Panell].

Snipping Tool

People g Sound
Microsoft Word ps Recorde /1| Command Prompt
2010
Reader o | Mia p otes W Computer
Organizer
SkyDrive Microso a indows Fax and
Sports InfoPath Tera Term — ws Journal
InfoPath
Filler 2010

WordPad nd Support

Math Input Panel Manager
OneNote Notepad Magnifier
utiook Paint

Desktop
oint 2010 ion

The [All Control Panel Items] screen appears.

4 Click [Devices and Printers].

= All Control Panel items o
1 B » ControlPanel » All Control Panel ltems. v| ¢ | | Search Control Panel p
Adjust your computer’s settings Viewby: Smallicons
W Action Center B9 Add features to Windows 8 Administrative Tools
53 AutoPlay 8 BitLocker Drve Encryption K8 Color Management
@ Credentiol Manager 9 Date and Time (53 Defautt Programs
&8 Device Manager & Devices and Printers B Display
@ Esse of Access Center & Farmily Safety @ File History
Flash Player older Options I Fonts
@ HomeGroup & Indesing Options Intemet Options
& Keyboard € Langusge Location Settings
D wai 2 Mouse etwork and Sharing Center
otfication Area lcons = andTools &
5 Phone and Modem B Power Options Programs and Features
& Recovery & Region 145 RemoteApp and Desktop Connections
{ Sound & Speech Recognition B Storage Spaces
@ Sync Center 19 System 2, Taskbar
[ Troubleshooting 8 User Accounts ¥ Windows 7 File Recovery
6 Windows Defender & Windows Firewal B Windows Update

The [Devices and Printers] folder appears.
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H Setting the department code

When this equipment is managed by department codes, you have to enter yours on the printer driver.

This allows a network administrator to check the number of copies printed by specific department members. Also users
can check who submitted the print jobs, by touch panel display and monitoring tools.

Please ask your administrator whether you should enter the Department Code.

* When the User Management setting is enabled, it is used to manage a print job instead of the Department Code
Management setting. In this case, a user name that has been entered to log in to your computer is used for the
authentication of the print job. Therefore, you do not need to set your department code to the printer driver but you
must register your user name in advance. If your user name is not registered, the print job is processed as an
invalid one according to the User Authentication Enforcement setting. Also if a print job is sent in RAW format, it is
processed according to the RAW Print Job setting. For more information about the User Authentication
Enforcement setting or the RAW Print Job setting, refer to the TopAccess Guide.

» If the No Limit Black function is enabled, you do not have to specify the department code when you print a
document with [Black and White] selected for the [Color] option in the [Basic] tab of printer driver.

Tips

* How the equipment performs printing for an invalid department code print job, for which an invalid department code
is specified, varies depending on the Invalid Department Code Print Job setting that can be set in the TopAccess
Administrator mode and whether SNMP communication is enabled or not.

- When SNMP communication is enabled and Invalid Department Code Print Job is set to [Store to invalid job
list], an error message will be displayed when an invalid department code is entered.

- When SNMP communication is disabled and Invalid Department Code Print Job is set to [Store to invalid job
list], the invalid department code print job will be stored in the invalid department code print job list without

printing.

- When the Invalid Department Code Print Job is set to [Print], the invalid department code print job will be
printed.

- When the Invalid Department Code Print Job is set to [Delete], the invalid department code print job will be
deleted.

* A department code needs to be entered every time you begin printing. If you have to use a different department
code for each print job, enter it when you begin printing.

Entering department code

Click [Start] menu and select [Devices and Printers].
The Printers folder appears.

Tips

* For Windows Vista or Windows Server 2008
Click [Start] menu, [Control Panel], [Hardware and Sound] and select [Printers].

* For Windows XP or Windows Server 2003
Click [Start] menu and select [Printers and Faxes].

* For Windows 8 or Windows Server 2012, see the procedures in the following section.
P.16 “Accessing the printers folder on Windows 8 / Windows Server 2012”
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Select the printer driver of this equipment, and then click [File] menu and select
[Printing Preferences].

== s
(). [ « Hardwareand .. » Devices and Printers » « [ 3 ||| Search Devices and Printer o
i) e +
Edit  View Tools Help
(- iy See what's printing Print server properties  » = - @
7 215:\efau\tprintar

Printing preferences
Printer praperties %3
Create sharteut

Delete

Rename

Properties

Clase

Troubleshoat

Remove device

/

ol el ! | 7

Fax Micrasoft XPS TOSHIEA  TOSHEA TOSHIBA
Document Writer  e-STUDIO Fax | Universal Priter | Universal PS3

state: @ Defauit 1 st 0 documentts)in quese
Meodel: TOSHIBA Universal Prin...

TOSHIBA Universal Printer 2

/
=

Category: Printer

If the [File] menu is not displayed, press [Alt].

* The printing preferences dialog box appears.

3 Display the [Others] tab menu and enter your department code in the [Department
Code] box.

= TOSHIBA Universal Printer 2 Printing Preferences @
Basic | Fimshingl Paper Handling | Image Qua\ityl Effect | Others ‘ Templatesl
Print Joh: D Qefa.ult Menu Sef 1
E| Mormal Print .. Eniic TopAccess
: : [C] Toner Save
"] Do not Print Blank Pages
[ Letterhead Print Mode
[Z] SMMP Communication SNME Settings
[ Output Devices l [ Acld Printer ]
100% [ LCustam Paper Size ]
Letter User name {Alias): User0dl
JJJW 23 JJJW 23
J Department Cade:
Settings... ]%
7L <
Profile: [¥] Hide Depa z ade(@)
Sl S
Saye Profile Delete Custom Settings File: [ mpot || Export ]
Restore Defaults
[ Restore All Defaults ] [ Version Information ]
I Ok J [ Cancel ] I Lpply I [ Help ]

In the [Department Code] box, you can enter a department code within 63 characters.
Tip

A department code must consist of one-byte characters such as numbers from 0 to 9, letters of the alphabet
from A to Z (both capital and small ones), a hyphen (-), an underscore (_), and a period (.).

4 Click [Apply] or [OK] to save the settings.

H Copying the PPD file for Windows

The Install Disk contains a printer description file for popular Windows applications. For applications not allowing the
automatic installation of PPD files, copy the PPD file to a proper directory in order to enable printer-specific settings in the
[Print] dialog box or the [Page] Setup dialog box.

For more information about copying PPD files, refer to the Software Installation Guide.
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Printing From Application

This section describes how to print a document from application.
L3 P.20 “Considerations and limitations”
3 P.20 “How to print”

B Considerations and limitations

* When the User Management setting is enabled, it is used to manage a print job instead of the Department Code

Management setting. In this case, a user name that has been entered to log in to your computer is used for the
authentication of the print job. Therefore, you do not need to set your department code to the printer driver but you
must register your user name in advance. If your user name is not registered, the print job is processed as an invalid
one according to the User Authentication Enforcement setting. Also if a print job is sent in RAW format, it is processed
according to the RAW Print Job setting. For more information about the User Authentication Enforcement setting or the
RAW Print Job setting, refer to the TopAccess Guide.

When the Windows Domain Authentication is used for the User Management Setting, your computer must log in the
domain.

If the No Limit Black function is enabled, you do not have to specify the department code when you print a document
selecting [Black and White] in the [Color] option in the [Basic] tab of printer driver.

Some print options can be set from both the application and the printer driver, such as collation. If the collation is set
from the application, documents may not be properly printed. If that happens, use the printer driver to set the collation.
Depending on the application, some print options such as the orientation need to be set from the application. For print
options that can be set from both the application and the driver, refer to the manual of the application.

Cautionary points when using the Universal PS3 printer driver
* When printing with the Universal PS3 printer driver from Adobe Acrobat, this option is disabled. To use this option with

PostScript, use the Universal Printer 2 printer driver, click [Customization] on the [Device Settings] tab, and select
[PostScript] in the [Output PDL] box of the [PDL Settings] tab.

When any of the following functions is set in the Universal PS3 printer driver, the print function will work appropriately
even if print data are generated in the application side since this happens in the printer driver side by ignoring the pass-
through printing of the application.

- Print to Overlay file

- Print Overlay Image

- Nin1

- Booklet

- Interleave (Duplicate)

- Templates printing

- Print Paper Size

- Image Scale

- Poster Print

- Tandem Print

H How to print

Once you have installed the printer driver and configured it properly, you can print directly from most Windows
applications. Simply choose the Print command from your application.
You can print using the various functions by setting print options on the printer driver.

Printing from Windows applications

The following describes an example for printing from Notepad on Windows 7.

Open a file and select [Print] from the [File] menu of the applications.
The [Print] dialog box appears.
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2 Select the printer driver of the equipment to be used and click [Preferences].

= Print =5
General

Select Printer

s TOSHIBA e-STUDIO Fax
S TOSHIBA Universal Printer 2 N

= TOSHIBA Universal PS3 [,%1

Pl e om
Status: Ready [T Print to file:
Lacation:
Comment: Find Frinter \ 2’
Page Ranges
@ Al Nurmber of copies: 1 =
Selection Current Page

) Pages: 1-65535 Collate

. . 2|3 213
Enter either a single page number or a single 1= 1=

page range. For example, 512

o

The printing preferences dialog box appears.

Tip
The procedures for displaying the properties dialog for the printer driver may be different depending on the application
that you are using. See your application’s manual about displaying the printer properties dialog box.

3 Setting the print options on each tab according to how you want to print.

= TOSHIBA Universal Printer 2 Printing Preferences @

Basic |F|msh|ng| Paper Handling | Image Uuahlyl Effect | Ulhersl Tsmplalesl

Print Job: Original Paper Size:
D Mormal Print - [Letter (8 L/2x11") 'I
= =
%@ Print Paper Size: [ Image Scale:
E [same as Original Size =] Moo 24(25-400)

Paper Source:

S r—

Paper Type:
|
10025 Destination:
L 3 —
Jree 2
1.23 1.2.3 BS
Bl
Profile:
Orietsion:
Save Profile Delete @ Portrait () Landscape

Restore Defaults opo Color
**e Detais

» Setting the print options varies depending on how you want to print a document.
P.31 “Print options”

* You can also set the print options using setting profiles.
P.25 “Setting print options using profiles”

4 Click [OK] to save the settings.
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5 Click [Print] to print a document.

= Print [=3a]
General

Select Printer

e TOSHIBA &-STUDIO Fax
#5 TOSHIBA Universal Printer 2
e TOSHIBA Universal PS3

< 1 3

Status: Feady Prirk ta fle { F
Location: .
Comment Find Frinter...
Page Range
@ Al Mumber of copies: 1 —
Selection Curnent Page
Pages: 1-65535 Collate
231 71213

Enter either a single page number or a single 1f

page range. For example, 512
| FPrint ‘ Cancel H Apply
|
N

Cautionary points when the [Enter the user credentials manually] option is used
When this option is enabled on this equipment, you are prompted to enter your user name and password before printing a

document.
When the dialog box below appears, enter your user name and password, and then click [OK].

oS

3 —HBEAD—FEA D LTS,

I -HEL:

User01

JEAT R

1%1 [ ok ] [[Feubn |
L& |'\\ by )
Ve

* Up to 128 characters can be entered in the [User Name] box, and up to 64 characters in the [Password] box.

* The values entered in the above boxes are not stored. Therefore, you must enter your user name and password
every time you print a document.

* You can make settings for this option on the [Device Settings] tab.
P.70 “Account Settings”
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2 PRINTING FROM WINDOWS

Cautionary points when LDAP authentication is used

When LDAP authentication is enabled on this equipment, you must specify an LDAP server in the [Server Name] box on
the [Others] tab before printing a document.

Basic. | Finishing | Paper Handing | Image Guaity | Efect | Dthers | Templates |

Print Job: Default Menu Setting:
Normal Print =[] _ > TopAccess

Toner Save

Do not Print Blank Pages

Letterhead Print Mocde

SMMP Communication SHME Settings

[ Dutput Devices ] [ Add Printer ]

[ Custom Paper Size ]

User name {Aliash: User0i1

Department Code:

Hide Department Code(Z)

Profile:

et i ]
---- Select from ----

SageProfie] [ Delete | ml-gs DAoL

LDAPO2

e |

If you attempt to send a print job without specifying an LDAP server, the [Specify LDAP Server] dialog box will appear to
ask you to do so.

You have not selected any server for LDAP authentication.

Please select a valid server.

Server Mame:

[ OK ][ Cancel ]

In this case, specify the desired LDAP server in the [Server Name] box and click [OK] to send the job.

You have not selected any server for LDAP authentication.

Please select a valid server.

[ Cancel ]

2

You can make settings for LDAP authentication on the [Device Settings] tab.
P.71 “Setting up LDAP servers”
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Setting Up Print Options

Print Options are the attributes you set to define the way a print job is processed. For example, the private print and proof
print options determine how the copier manages your print job.
Tip

To find the printing instructions for your specific needs, see the procedures in the following section.
P.78 “Printing With Best Functions for Your Needs”

Hl How to set up

There are several ways to set print options. How the settings affect printing varies depending on the way you set the
options. The tabs displayed also vary depending on how you display the printer properties.

0 Setting initial values of print options

Setting the print options by displaying the printer properties from the Printers folder within the Windows Start menu will
establish the initial values of the options. For example, the paper size setting you most commonly use, optional device
settings, user information settings, etc., are settings you will not want to change every time you print. It is convenient to set
these options as initial values.

How to display: Windows 7

1 Click the [Start] menu and select [Devices and Printers].

2 Select the printer driver of your equipment, click the [File] menu and select [Printing
Preferences].
If the [File] menu is not displayed, press [Alt].

How to display: Windows Vista / Windows Server 2008

1 Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].

2 Select the printer driver for the equipment, click the [File] menu and select [Printing
Preferences].
If the [File] menu is not displayed, press [Alt].

How to display: Windows XP / Windows Server 2003

1 Click [Start] menu and select [Printers and Faxes].

2 Select the printer driver for the equipment, click the [File] menu and select [Printing
Preferences].
Tip

For operations on Windows 8 or Windows Server 2012, see the following section.
L3 P.16 “Accessing the printers folder on Windows 8 / Windows Server 2012”

L Setting print options for each print job

The print options that are set in properties dialog box, which can be accessed from the [Print] dialog box of the application,
are only applied to the current print job, so once you close the application, the options will be invalid.

How to display:

1 Click the [File] menu and select [Print] on application.

2 Select the printer driver of the equipment to be used and click [Preferences].
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0 Setting print options using profiles

Using profiles, you can save the print settings or apply the saved settings to a print job.
Tip
There are 5 factory default profiles.
- BW, Duplex, Staple & 2in1
- Color Booklet
- Duplex & Staple

- Duplex, Staple & 2in1
- Duplex, Staple & Punch

In order to print a document using profiles, you must first create the saved profile.
P.25 “Saving profile”

Once you save a profile, you can apply its settings to a print job.

P.26 “Loading profile”

You can also delete unnecessary profiles.

P.27 “Deleting profile”

Saving profile

You can register up to 20 profiles (including 5 default profiles) for each printer driver.

Tip

You can delete the default profile or overwrite it by changing its contents and saving it under the same name.

1 Configure the print options on each tab.

Setting the print options varies depending on how you want to print a document.
P.31 “Print options”

2 Click [Save Profile] in the Profile group.

-
= TOSHIBA Universal Printer 2 Printing Preferences &J
Basic |F|n|sh|ng| F‘aperHandImgI Image E!ualltyl Effect I Ellhersl Temp\ales‘
Print Job: Qriginal Paper Size:
= Normal Print >||.. [Letter (8 L/2s1L") ‘]
R
T Print Paper Size: [CIImage Scale:
g [Same as Qriginal Size x| [ 100 = %(25-400)
Paper Saurce:
=
Paper Type:
1002 Destination:
e E
JJ1 23 JJT 23
=l
Praofile:
Orentation:
Saye Profile Delete @ Partrait () Landscape
Restoefau\ts gop Lolar

The [Profile Name] dialog box appears.
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3 Enter the profile name and click [OK].

Profile Name @

Profile Mame: FileO1

[ [iT3 ,\{ [ Cancel |
|

N

The file name must be up to 63 characters long.

Tips
* If you enter an existing profile name, you are prompted to confirm whether you want to overwrite it. If you
want, click [OK].
* If you try to save more than 20 profiles, a dialog box notifying you that no more can be saved appears, then

the 21st profile is saved as a temporary profile. If you want to register this temporary profile, delete
unnecessary profiles first, and then select [Temporary Profile] to recall this profile and click [Save Profile] to
save it.

* You cannot specify [None] for the profile name.

4 The profile is saved.

Loading profile

1 Select a profile in the [Profile] box.

= TOSHIBA Universal Printer 2 Printing Preferences @

Basic |F|n|sh|ng| PaperHandlmgI Image Gualllyl Effect I Ellhersl Temp\ales‘

Print Job: Original Paper Sige:
D Mermal Print =|.. [Letter(S L/2x11") ']
R
%@%%;W Print Paper Size: [Tl Image Scale:
B [same 35 Original Size -] [0 ] %425-400)
Paper Source:
=
Paper Type:
100% Destination:
Vi 3
JJ1.2.3 JJT 23
g
Profile:
Onetaton
mﬂm Delete @ Portrait (7) Landscape
Color:
Restore Defaults 20

The setting options in the profile are reflected on each tab.

To restore the default settings after you select the profile, click [Restore Defaults] on each tab. Selecting [None]
on the [Profile] box will not restore them. To restore the default settings on any tab other than the [Device
Settings] tabs, click [Restore All Defaults] on the [Others] tab.
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2 PRINTING FROM WINDOWS

Deleting profile

1 Select the profile that you want to delete in the [Profile] box, and click [Delete].

é TOSHIBA Universal Printer 2 Printing Preferenc- .

Basic |F|n|sh|ng| F‘aperHandImgI Image E!ualltyl Effect I Ellhersl Temp\ales‘

Print Job:

[

Original Paper Size:

[Letter 8 12:c117)

™

l, Print Paper Size:

Image Scale:

=N [same a5 ariginal size

v] 65 %(25-400)

Paper Source:

ol

Paper Type:

Destination:

Praofile:

Settings...

Mumber of Copies:

[ (-00m)

[Fileal N

7

@ Portrait

() Landscape

s N2 2g o

|Brack and white

v][ Details... ]

[ 1] ][ Cancel H Apply

] [ Help

The [Confirm Delete] dialog box appears.
2 Click [Yes] to delete the selected profile.
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0 Setting up print options with Template Buttons

Once you save a profile to a Template Button, the [Templates] dialog box automatically appears upon printing, and you
can immediately apply the saved profile to a print job only by selecting this Template Button.

Tip
5 factory default profiles are registered in a Template Button.
- BW, Duplex, Staple & 2in1
- Color Booklet
- Duplex & Staple

- Duplex, Staple & 2in1
- Duplex, Staple & Punch

To use a Template Button, you must first save a profile to this button. Also you must set a dialog box for selecting Template
Buttons to appear automatically upon printing.

P.28 “Saving a profile to the Template Button”

You can apply the saved profile to a print job by selecting the Template Button upon printing.

P.29 “Printing with profiles in a Template Button”

You can delete a Template Button if it is no longer required.

P.30 “Deleting a profile saved in a Template Button”

Saving a profile to the Template Button

You can create up to 6 Template Buttons, including 5 default buttons.

You can delete any of the default Template Buttons.

1 Save the desired print options as a profile.
P.25 “Saving profile”

2 Select the [Templates] tab.
3 Select the [Templates Dialog Box] check box.

=4 Printing Preferences @

Basic Fimshingl Paper Handling | Image: Qua\ityl Effect | Dthers‘ Templates ‘

Mumber of Copies:| 1

BW, Duplex, Staple &2inl Colar Bool ‘TEE Duplex &tStaple

Duplex, Staple &:2inl Duplex, Staple &Punch

mp\ates Dialag Box Edit... l

[ Ok ]I Cancel H Help

The [Templates] dialog box appears automatically in printing.

Click [Edit].
The [Edit Templates] dialog box appears.
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5 Select a profile to be saved in the [Profile] box.

Edit Templates @
Profile: |File0L \ i

1\ want to edit
BW, Duplex, Staple 22inl Color BWHft23 Duplex &:Staple

m

Duplex, Staple &2inl

Select Profile and Template whic|

6 Select a Template Button to which the chosen profile is saved.
Tip

If you select a Template Button that is already registered, the profile saved in this button is replaced with a new
one.

Click [Save] and then [OK].

The chosen profile is saved in the selected Template Button.

Click [OK] on the [Template] tab.

The saved profile is registered.

Printing with profiles in a Template Button

1 The [Templates] dialog box appears automatically when printing is started.

Templates @

[C] Number of Copies: | L

W, Duplex, Staple 2inl | Color Bookigt, - Duplex &Staple

Duplex, Staple &2inl Duplex, Staple &Punch

Select a Template Button to be applied.
Printing is performed with the profile saved in the selected Template Button.
Tips

* To set the number of copies, select the [Number of Copies] check box.
* To print without applying profiles, click [Skip].
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2 PRINTING FROM WINDOWS

Deleting a profile saved in a Template Button

1 Select the [Templates] tab.
2 Click [Edit].

Basic | Flmshlngl Paper Handling | Image uuahtyl Effect | Uthers‘ Templates ‘
| | Mumber of Coples:Eﬂ'ggg)

BW. Duplex. Staple &2inl Colar E‘.onk\f’cza Duplex &Staple

Templates Dialag Box

I Ok I[ Cancel ][ Help

The [Edit Templates] dialog box appears.
3 Select a Template Button whose profile needs to be deleted.

Profile: |Calor Booklet -

Select Profile and Template which you want to edit |

BW, Duplex, Staple &2inl Color I!oul(l.F‘l2 3

BN ‘2
7“3

4 Click [Delete] and then [OK].

The profile in the selected Template Button is deleted. The Template Button is left blank.
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M Print options

This section describes print options in each tab of the printer driver. This section will help you to find the description of
specific print options, or understand their individual functions.

Tip g

The following tabs are the setting items which depend on the OS. For their setting procedures and details, refer to the
Operator's Manual or the Help of the OS to be used.

- [General] tab

- [Sharing] tab

- [Ports] tab

- [Advanced] tab

- [Color Management] tab

- [Security] tab

How to display:

1 Click [Start] menu and select [Devices and Printers].
The Printers folder appears.

Tips

* For Windows Vista or Windows Server 2008
Click [Start] menu, [Control Panel], [Hardware and Sound] and select [Printers].

¢ For Windows XP or Windows Server 2003
Click [Start] menu and select [Printers and Faxes].

* For Windows 8 or Windows Server 2012, see the procedures in the following section.
P.16 “Accessing the printers folder on Windows 8 / Windows Server 2012”

Select the printer driver of this equipment, and then click [File] menu and select
[Printing Preferences].

» If the [File] menu is not displayed, press [Alt].

* The printing preferences dialog box appears.

- ~
1 ™) TOSHIBA Universal Printer 2 Printing Preferences &J
I Basic |F|n|sh|ng| F‘aperHandImgI Image uuahtyl Effect | Uthersl Templat : 2
3 Print Joh: QOriginal Paper Size:
Bl Normal Print . [Letter (8 L2 117) -
[Cossaram T .
%‘%ﬁ?ﬁ Print Paper Size: [[JImage Scale:
2 [Same as Original Size | [ 100 22(25-400)
Paper Saurce:
=
4 Paper Type:
1002 Destination:

e a

JJ1 23 JJT 23

=l
5 = Seftings... ] Number of Copies: L =] (1-999)

Praofile:
6 Mane h Orientation:

Saye Profile Delete @ Portrait ) Landscape
Color:
7 Restore Defaults o8
T T ! T
1 1 1 1

1) Printer Name

Displays the name given to the printer driver when it was installed, or the name it displays on the icon in the Printer
folder.
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2) Menu Tabs

The menu items of the printer driver are displayed as tabs. Clicking on a tab will display the contents of the selected

tab. The tabs displayed vary depending on the way the print properties are displayed.

- [Basic] tab
The [Basic] tab contains basic print operation settings, such as original paper size, print paper size, paper source,
paper type, destination, number of copies, orientation, and so on.
P.35 “[Basic] tab”

- [Finishing] tab
The [Finishing] tab allows you to enable sort printing, 2-sided printing, N-up printing, and stapling.
[ P.38 “[Finishing] tab”

- [Paper Handling] tab
The [Paper Handling] tab contains Cover page printing.
P.43 “[Paper Handling] tab”

- [Image Quality] tab
The [Image Quality] tab allows you to select how images are printed. You can easily select appropriate image
quality depending on the type of job being printed.
P.47 “[Image Quality] tab”

- [Effect] tab
The [Effect] tab contains print options that add the effects to your print jobs such as Watermarks, Overlay Image
printing and so on.
P.55 “[Effect] tab”

- [Others] tab
The [Others] tab contains special features such as toner save, custom pager size, and so on.
P.61 “[Others] tab”

- [Templates] tab
The [Templates] tab allows you to register print options frequently used as a template, or recall the registered print
options.
LD P.76 “[Templates] tab”

- [Device Settings] tab
The [Device Settings] tab allows you to configure the options. When any optional unit is installed in this equipment,
set the configuration of the machine on this tab. This tab is only displayed when the printer properties are accessed
from the Printers folder.
LD P.67 “[Device Settings] tab”

The [Paper Handling] tab, [Image Quality] tab, [Effect] tab and [Templates] tab appear only when each setting is
enabled with the Plug-in feature.
P.72 “Customization: [Plug-in] tab”

3) Print Job

This sets the type of print job.

- Normal Print
Select this to print a job normally.

- Scheduled Print
Select this to print a job on a specified date and time.
When this is selected, click the [...] on the right of the [Print Job] box to set the date and time to print a job.

- Private Print
Select this option to print a private job. When you select this option, enter a password using the alphanumeric
characters and symbol characters (ASCII code characters between 0x21 to 0x7E) in the [Password] box that is
displayed after the print settings have been made and the print job is sent. The password must be between 1 and
63 characters.
The print job, sent as a private job, is saved in the private job queue on this equipment, and is not printed until you
activate printing from the touch panel display. This option is useful when you want to print a confidential document
that is secured by a password. The user has to enter the password to print the private job when activating printing
from the touch panel display.

- Hold Print
The print job, sent as a hold job, is saved in the hold job queue on this equipment. To perform printing, select the
desired job on the touch panel display and press [PRINT]. This option is useful to prevent you from forgetting to
remove printed sheets.

- Proof Print
Select this to print the first copy of a multicopy job and then wait for approval before printing the remaining copies.
If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are saved in the proof job
queue on this equipment, which are not printed until you activate printing from the touch panel display. This option
allows you to check a job’s output before printing the remaining copies and thereby reduce paper waste.
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When you want to print multiple copies, each of which is to be sent as an individual print job by your application, all
the copies, not just one copy, will be printed even if you set Proof Print. In such a case, print just one trial copy first,
and then specify the required number of copies on the touch panel display. n

- Print to Overlay File
Select this to save the print job as an overlay file that is imposed on other documents. When you select this, click
the button on the right and enter the file name.
For example, if you want to print a master page image on the background of a document, you can create an
overlay file of the master merge image using this option. Then you can print a document using this overlay by
specifying this file as an overlay image in the [Overlay Image] option of the [Effect] tab.

» If the print job has several pages in the document, only its first page will be saved as an overlay file.
* Both the overlay file and the documents on which you superimpose the overlay image must be created with the
same size and color mode.

- Store to e-Filing
Select this to save a job to e-Filing. When this is selected, select the box from the box after the print setting has
been finished. When the SNMP communication is enabled, it detects the available box numbers and Box name in
the box. If not, all box numbers are listed in the box.
If you select a user box, you may be required to enter the appropriate password for the selected box. The job saved
to a box can be printed from the touch panel display at a later time. It can also be composed with other documents
using the e-Filing web utility.
You can also print a job and save it to a box by checking on the [Print] option.

* Documents stored in e-Filing are retained with the best image quality for printing. If you want to download them
into your computer with a higher image quality, scan the original documents and store them in e-Filing.

* When you store a document in e-Filing using the printer driver, the printing image (not the original document in
your computer) will be stored in e-Filing.

- Multiple Job Type
The Multiple Job Type feature allows you to combine any of Scheduled Print, Private Print, Hold Print, Proof Print,
Proof Private Print and Proof Hold Print, with Store to e-Filing.
For example, you can store a job in the specified e-Filing of this equipment and print it at the specified time by
combining Scheduled Print with Store to e-Filing.
To use this feature, click [...] on the right of the [Print Job] box and select the job types to be combined.

Tips

* For more information about e-Filing operations, refer to the e-Filing Guide.
* For the detailed instructions on how to print with the [Print job] setting, see the following page:
L3 P.78 “Printing various print job types”

Preview window

In the Preview window, you can preview how a document will be printed under the current settings of the printer driver.
The image of a page to which the set print options are applied is displayed.

[Settings]

The set print options and their details are displayed in a list.

Profile

Print option settings can be saved on your hard disk. You can save print option settings by clicking [Save Profile] and
easily load a setting file by selecting a profile name in the box.

P.25 “Setting print options using profiles”

Tip
There are 5 factory default profiles.

[Restore Defaults]

Click this to restore the settings to the original factory defaults.

[OK]

Click this to enter the input settings and complete the print option settings.

Setting Up Print Options 33



2 PRINTING FROM WINDOWS

9) [Cancel]
Click this to cancel the input settings and exit the print option settings.

10) [Apply]
Click this to enter the input settings without closing the print option settings. This button is only displayed when the
printer properties are accessed from the Printers folder. This button remains grayed out until a setting is changed.

11) [Help]
Click this to browse Help for the printer driver.
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U [Basic] tab

The [Basic] tab contains basic print operation settings, such as the original paper size, print paper size, paper source,
paper type, destination, number of copies, orientation, and so on.

I'1..,-.\ TOSHIBA Universal Printer 2 Printing Preferences &J.‘
Basic |F|msh|ng| Paper Handling | Image uuahtyl Effect | Uthersl Templatesl
Print Job: Original Paper Size: 1
=l Hormal Print -l [Letter [5 /2% 117} ;l 2
é%%;g% Print Paper Size; s— [ Image Scale: 3
E [Same as Original Size '] 100 e(25-400)
b Paper Source: 4
I =
Paper Type: 5
100% Destination: 6
- 2
JJJT 0 | JJJT 20
5 i
Number of Copies: 1 = {1-999) 7
Profile:
Ornientation: E 8
Delete -é.-Po[tra\t ) Landscape
9
1) Original Paper Size
This selects the size of a document to be printed.
Available original paper sizes are listed below:
« A4 (210 x 297 mm) * 16K (195 x 270 mm)
* A5 (148 x 210 mm) « 135"LG (81/2x 13.5")
* B5 (182 x 257 mm) * IndexCard (3 x 5")
* Folio (210 x 330 mm) » Executive (7 1/4 x 10 1/2")
* AB (105 x 148mm) * Env-Com10 (4 1/8 x 9 1/2")
» Postcard (100 x 148mm) * Env-Com9 (37/8 x87/8")
« Letter (8 1/2 x 11") « Env-Monarch (3 7/8 x 7 1/2")
* Legal (8 1/2 x 14") * Envelope DL (110 x 220 mm)
» Statement (5 1/2 x 8 1/2") * Envelope Cho-3 (120 x 235 mm)
e 13"LG (8 1/2x13") * Envelope You-4 (105 x 235 mm)
* 8.5"SQ (81/2x8 1/2") * Envelope-C5 (162 x 229mm)

* There are also 40 custom paper sizes in the [Original Paper Size] box. You can set the custom paper sizes in
the [Others] tab.
P.61 “[Others] tab”

* The default paper size will be [Letter] or [A4] according to the regional setting in the Windows.

2) Print Paper Size
Select this to enlarge or reduce a page image to fit exactly in the selected paper size. If you do not wish to enable
enlarge or reduce printing, select [Same as Original Size].

When you use a custom paper size, you need to select the custom size of the paper loaded in the drawer.
Tip

There are also 40 custom paper sizes in the [Print Paper Size] box. You can set the custom paper sizes in the
[Others] tab.
P.61 “[Others] tab”
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3) Image Scale
Select this check box to enter the scale manually to enlarge or reduce an image. The ratio can be set at between 25
and 400%.

Tip
For detailed instructions on how to print with the [Image Scale] setting, see the following page:
P.90 “Fitting images within paper size”

4) Paper Source
This selects a paper source to print a job in the most suitable paper size. The figure on the right indicates the paper
size set for each paper source. When you select a paper source, the chosen one is indicated with a green square in
the figure.

Tip
You can select a paper source by directly clicking on the figure on the right.

- Auto — Automatically selects the paper set in this equipment according to the printed document size.

- Drawer 1 — Paper is fed from the 1st Drawer.

- Drawer 2 — Paper is fed from the 2nd Drawer.

- Drawer 3 — Paper is fed from the 3rd Drawer.

- Drawer 4 — Paper is fed from the 4th Drawer.

- LCF — Paper is fed from the Large Capacity Feeder. This cannot be selected if the Large Capacity Feeder is not
installed.

- Bypass Tray — Paper is fed from the Bypass Tray. When you select this and print a job, [JOB STATUS] on the
touch panel will blink. Press [JOB STATUS] and check the paper size of the job. Then set the paper and press the
[START] button to print a job.

* The selectable values vary depending on the optional devices installed in this equipment and their configuration
on the [Device Settings] tab.

* When a paper type such as special paper that needs to be fed from the bypass tray is set, [Bypass Tray] may
be automatically selected in the [Paper Source] box, and then a confirmation dialog box may appear.

* When the paper size settings on the [Device Settings] tab differ from those in the equipment, the paper source
setting is ignored and the equipment may prompt to set the paper in the bypass tray.

5) Paper Type
This sets the media type of the paper.
- Plain (Thin) — Select this when printing on plain thin paper.
- Plain — Select this when printing on plain paper.
- Thick1 — Select this when printing on thick 1 paper.
- Thick2 — Select this when printing on thick 2 paper.
- Thick3 — Select this when printing on thick 3 paper.
- Thick4 — Select this when printing on thick 4 paper.
- Thick5 — Select this when printing on thick 5 paper.
- Special 1 — Select this when printing on special 1 paper.
- Special 2 — Select this when printing on special 2 paper.
- Special 3 — Select this when printing on special 3 paper.
- Special 4 — Select this when printing on special 4 paper.
- Special 5 — Select this when printing on special 5 paper.
- Special 6 — Select this when printing on special 6 paper.
- Envelope 1 — Select this when printing on envelope 1.
- Envelope 2 — Select this when printing on envelope 2.
- Envelope 3 — Select this when printing on envelope 3.
- Envelope 4 — Select this when printing on envelope 4.
- USER TYPE 1 — Select this when printing on user type 1 paper.
- USER TYPE 2 — Select this when printing on user type 2 paper.
- USER TYPE 3 — Select this when printing on user type 3 paper.
- USER TYPE 4 — Select this when printing on user type 4 paper.
- USER TYPE 5 — Select this when printing on user type 5 paper.

When [Envelope] is selected at the [Print Paper Size] box, only [Envelope 1], [Envelope 2], [Envelope 3], and
[Envelope 4] will be displayed and you cannot select other paper types.
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Tip
For more information about the paper types that are available for this equipment, refer to the User’s Manual Setup
Guide.

6) Destination n

This selects the tray to which the print job is made to exit. The figure on the right indicates the destination currently set
with an arrow.

- Exit Tray — Select this to have paper exit to the exit tray.

- Tray 1 — Select this to route the output to the tray of the Finisher.

The selectable items differ depending on the paper size and the option configuration.

Tip
You can select the tray by directly clicking on the figure on the right.

7) Number of Copies
This sets the number of printed copies. This can be set at between 1 and 999.

8) Orientation
This sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape — The document is printed in the landscape direction.

9) Color
This sets whether a print job is printed in the color or black mode.

- Auto — Select this to determine the color mode automatically. When a print job is a black and white document, the
system automatically prints the document in the black mode. When a print job is a color document, it prints the
document in the color mode.

- Color — Select this to print a document in the color mode.

- Black and White — Select this to print a document in the black mode.

- Twin Color — Select this to print a document in the twin color mode. When this is selected, click [Details] to specify
the color that the non-black part of document will be printed in. You can select either [Red], [Green], [Blue], [Cyan],
[Magenta], [Yellow], or [White].

Tip
For instructions on how to print color images with the [Black and White] or [Twin Color] setting, see the following page:

P.91 “Printing color documents in gray scale”
P.92 “Printing color documents in twin colors”
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O [Finishing] tab
The [Finishing] tab allows you to enable sort printing, 2-sided printing, N-up printing, poster printing, and stapling.

r 5
= TOSHIBA Universal Printer 2 Printing Preferences &J
Firiishing ‘ F‘aperHandImgI Image E!ualltyl Effect I Ellhersl Templates
Print Jab: Copy Handling: 1
=l Mermal Print =|... .JJ JJJ
& rE 111
[7] 2-Sicled Printing: 2
ﬁ b 2 Details
[] Humber of pages per Sheet: 3
o @ E @@ E
100% Direction of Print:
Letter
JJ JJ -+ —
J1 23 JT 23
B Draw Barders Around Pages
Praofile:
3 5]
aQg
Save Profile Delete r - 5
[T] Use Custarn Margin: Details
Restore Defaults
[C] Paster Print: Details,
L 6

1) Copy Handling
This sets how to sort the printed sheets when numerous copies are made for printing.
- Sort Copies — Select this for sort-printing (1, 2, 3... 1, 2, 3...).
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- Group Copies — Select this for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...).
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[Group Copies] can be selected only when more than 1 copy is entered at the Number of Copies option.
Tip
For the detailed instructions on how to print with the [Copy Handling] setting, see the following page:

P.93 “Sort printing”

2) 2-Sided Printing
This sets printing on both sides of paper. Select this check box and then the position of the margin for 2-sided printing.
- Long Edge — Select this to print on both sides of the paper with a margin on the long edge.

Portrait Landscape

1
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Short Edge — Select this to print on both sides of the paper with a margin on the short edge.
Portrait Landscape

Booklet — Select this to print a properly paginated booklet or magazine-style publication. When this is selected,
click [Details] to specify the details of the Booklet printing.
[ P.41 “Booklet Details”

» 2-Sided printing cannot be set when the following paper size is selected at the [Print Paper Size] box in the
[Basic] tab.

- A6
- Custom Paper Size (Some custom paper sizes allow 2-sided printing.)
» 2-Sided printing cannot be set when the following paper type in selected at the [Paper Type] box in the [Basic]
tab. However, this may differ depending on whether the Finisher is installed.
- Special 1-6
- Envelope 1-4
- Thick5

Tips
» To staple on the 2-sided printed sheets, set each option separately.
P.98 “Stapling”

* For detailed instructions on how to print with the [2-Sided Printing] setting, see the following page:
P.94 “Printing on both sides of a sheet”

3) Number of pages per Sheet

This sets the printing of multiple pages on one sheet. The pages are reduced to fit the selected paper size
automatically and printed.

2 pages — Select this to print images from 2 pages arranged on one sheet.
4 pages — Select this to print images from 4 pages arranged on one sheet.
6 pages — Select this to print images from 6 pages arranged on one sheet.
8 pages — Select this to print images from 8 pages arranged on one sheet.
9 pages — Select this to print images from 9 pages arranged on one sheet.
16 pages — Select this to print images from 16 pages arranged on one sheet.

Direction of Print
This sets how the pages are arranged on one sheet.

Left to Right — Select this to arrange pages horizontally from the left and printed top to bottom on one sheet.
Right to Left — Select this to arrange pages horizontally from the right and printed top to bottom on one sheet.
Left to Right by column — Select this to arrange pages vertically from the top and printed left to right on one
sheet.

Right to Left by column — Select this to arrange pages vertically from the top and printed right to left on one
sheet.

Draw Borders Around Pages
Select this check box to print borders around each page.

Tips

* When you select [Booklet] in the [2-Sided Printing] box, only [2 pages] can be selected.

* For the detailed instructions on how to print with the [Number of pages per Sheet] setting, see the following
page:
P.97 “Printing several pages on one sheet”
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4) Staple
This sets whether a print job is printed with staples.
- Upper Left — Select this to staple the printed document in the upper left.
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The selectable options vary depending on the paper size and orientation.
The “Staple” option is available only when the Finisher is installed.

tab.

- Statement

- A5

- A6

- Postcard

- IndexCard 3x5"

- Custom Paper Size
- Envelope - Com9

- Envelope - Com10
- Envelope - Monarch
- Envelope - DL

- Envelope - CHO3

- Envelope - YOU4

- Envelope - C5

The “Staple” option is not available when the Group Copies / Magazine sort function is selected.
Stapling cannot be set when the following paper sizes are selected in the [Print Paper Size] box in the [Basic]

» Stapling cannot be set when the following paper types are selected at the [Paper Type] box in the [Basic] tab.

However, this may differ depending on whether the Finisher is installed.
- Thick 5

- Special 1

- Special 2

- Special 3

- Special 4

- Special 5

- Special 6

- Envelope 1
- Envelope 2
- Envelope 3
- Envelope 4

Tip

For detailed instructions on how to print with the [Staple] setting, see the following page:
[ P.98 “Stapling”

5) Use Custom Margin

Select this check box to set the margin on the printed pages. When this box is selected, click [Details] to set the
margins in the [Custom Margin] dialog box: 0.17 inch to 3.94 inches / 4.2 mm to 100 mm (The margin width cannot be

smaller than 0.17 inches / 4.2 mm.)

» If [Booklet] is selected on [2-Sided Printing], this option will be disabled.

* Enable this function to add the margins if the application does not support the margin function. When the

application has a margin function, use the application’s function rather than this option.
¢ This cannot specify the binding margin for Booklet printing.
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6) Poster Print
You can divide a print job onto more than one sheet of paper, so you can create one large image, such as a poster, by
connecting the divided images. If this option is enabled, click [Details] and set the Output number of Sheets.

| ==

| LN

I &
Al | 2R

1x2 2x2 3x3 4x4

* The Poster Print option is not available when any of the Custom Paper Size, Number of pages per sheet, 2-
Sided Printing, Watermark, Overlay Image and Sheet Insertion options is set.

* The Poster Print option is available only when any of the sizes below is selected for [Print Paper Size] box on
the [Basic] tab.
A4, LT

Tip
For detailed instructions on how to print with the Poster Print option, see the following page:
P.99 “Dividing one image into multiple sheets (Poster Print)”

Booklet Details

In the [Booklet Details] dialog box, you can specify how Booklet printing is performed.

1)

Booklet Details ==

Output Document Layout:

Letter - Half an Letter -

Page Order
123 321

& o
@ From Left to Right _) From Right to Left

Margin
Center:

EENX £ inches (0.00 - 0.67)
Outer:

EZl o =1 inches (0.17 - L17)
Units:
@ inch ~mm

[ Booklet without Center Margin

I Restore Defaults

Output Document Layout
Select the booklet size to be made.

A5 on A4 — Select this to print an A5 size booklet. Every 2 pages are printed on A4 paper to fit on half a sheet
(A5).

B6 on B5 — Select this to print a B6 size booklet. Every 2 pages are printed on B5 paper to fit on half a sheet (B6).

1/2 Folio on Folio — Select this to print a 1/2 Folio size booklet. Every 2 pages are printed on Folio paper to fit on
half a sheet.

A6 on A5 — Select this to print an A6 size booklet. Every 2 pages are printed on A5 paper to fit on half a sheet
(AB).

Letter-Half on Letter — Select this to print a 1/2 Letter size booklet. Every 2 pages are printed on Letter paper to
fit on half a sheet.

1/2 LG on LG — Select this to print a 1/2 Legal size booklet. Every 2 pages are printed on Legal paper to fit on half
a sheet.

1/2 Statement on Statement — Select this to print a 1/2 Statement size booklet. Every 2 pages are printed on
Statement paper to fit on half a sheet.

1/2 13LG on 13LG — Select this to print a 1/2 13 inch LG size booklet. Every 2 pages are printed on 13 inch LG
paper to fit on half a sheet.
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- 1/2 8.5SQ on 8.58SQ — Select this to print a 1/2 8.5 inch SQ size booklet. Every 2 pages are printed on 8.5 inch SQ
paper to fit on half a sheet.

- 32K on 16K — Select this to print a 32K size booklet. Every 2 pages are printed on 16K paper to fit on half a sheet.

- 1/213.5" LG on 13.5" LG — Select this to print a 1/2 13.5 inch LG size booklet. Every 2 pages are printed on 13.5
inch LG paper to fit on half a sheet.

- 1/2 Executive on Executive — Select this to print a 1/2 Executive size booklet. Every 2 pages are printed on
Executive paper to fit on half a sheet.

- 1/2 (Custom) on (Custom) — Select this to print a custom paper size booklet. Every 2 pages are printed on
custom paper size paper to fit on half a sheet.

2) Page Order
Select this to print the pages from left to right or right to left.

3) Margin - Center
This sets the gutter in the center of a two-sided page. You can enter the value between 0 and 0.67 inches (0 and 16.90
mm). The printed images will be reduced according to the margin setting.

4) Margin - Outer
This sets the gutter on the right side and left side on the paper. You can enter the value between 0.17 and 1.17 inches
(4.20 and 29.60 mm). The printed images will be reduced according to the margin setting.

5) Margin - Units
Select the unit for the Center Margin and Outer Margin option. The default unit varies depending on the regional
setting in the Windows.

6) Booklet without Center Margin
Select this to set the center margin of the paper to 0 inch (mm).
In this case the value set for [Margin - Center] becomes invalid.

7) [Restore Defaults]
Click this to restore the settings displayed in the [Booklet Details] dialog box to the original factory defaults.
Tip

For detailed instructions on how to print with the [Booklet] setting, see the following page:
D P.94 “Making a booklet”
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QO [Paper Handling] tab

The [Paper Handling] tab allows you to enable Front Cover printing, Back Cover printing, Inserting Pages, and Interleaving
Pages.

* When the size of covers or sheets to be inserted is the same as that of the copy paper, change the media type or
specify “Paper Source” on the [Basic] tab menu; otherwise all data will be printed from the insertion drawer.

* If you select [Store to e-Filing] in the [Print job] box, [Use Front Cover], [Use Back Cover], [Insert Pages] and
[Interleave Pages] are unselectable.

F 5
= TOSHIBA Universal Printer 2 Printing Preferences dhJ
Easiz | Finishing | Paper Handling |Image Qua\ityl Effect | Dthersl T emplates
Print Joh:
=l Mormal Print - ([ DJJ [ Use Front Cover: 1
B Aurta Do nat print on page
[_m [C] Use Back Cover: 2
Auta Do nat print an page
[ Insert Pages:
= 9
100% Edit
Letter Letter QJJ [Tl Interleave Pages: 4
JJJW 23 JJJW 23
=l Auto
Settings... Duplicate
Profile:
Mone -
Save Profile Delete

Restare Defaults

[ (1] ] ‘ Cancel | | Lpply | | Help

1) Use Front Cover

This sets front cover printing which allows you to insert or print a cover on a sheet fed from a different drawer or bypass
tray other than the Paper Source option selected on the [Basic] tab.

To enable cover printing, select the check box and select the location from where a cover sheet is to be fed and the
print style to be used.

Tip
For detailed instructions on how to print with the [Use Front Cover] setting, see the following page:
P.100 “Inserting different types of paper”

Source
Select the location from where a front cover sheet is to be fed. When [Auto] is selected, the paper is automatically
selected according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed in this equipment and
their configuration on the [Device Settings] tab.

Print Style

This selects how you want to print a front cover.

- Do not print on page — Select this to insert a blank cover.

- Print one side of the page — Select this to print the first page image on the front side of a cover.

- Print both sides of page — Select this to print the first two page images on both sides of a cover. This is available
only when the 2-Sided Printing option is enabled on the [Finishing] tab.

If [Print one side of the page] is selected while 2-Sided Printing is performed, the first page is printed on the front
side of the cover sheet and the back side of the cover will be blank.
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2) Use Back Cover

3)

4)

This sets back cover printing which allows you to insert or print a back cover on a sheet fed from a different drawer or
bypass tray other than the Paper Source option selected on the [Basic] tab.

To enable back cover printing, select the check box and select the location from where a back cover sheet is to be fed
and the print style to be used.

Tip

For detailed instructions on how to print with the [Use Back Cover] setting, see the following page:
P.100 “Inserting different types of paper”

Source
Select the location from where a back cover sheet is to be fed. When [Auto] is selected, the paper is automatically
selected according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed in this equipment and
their configuration on the [Device Settings] tab.

Print Style

This selects how you want to print a back cover.

- Do not print on page — Select this to insert a blank cover.

- Print one side of the page — Select this to print the last page image on the front side of a cover.

- Print both sides of page — Select this to print the last two page images on both sides of a cover. This is available
only when the 2-Sided Printing option is enabled on the [Finishing] tab.

» If [Print one side of the page] is selected while 2-Sided Printing is performed, the last page is printed on the
front side of the cover sheet and back side of the cover will be blank.

» If [Print both sides of page] is selected but there is only one page printed on the back cover, the last page is
printed on the front side of the cover sheet and back side of the cover will be blank.

Insert Pages

This sets sheet insertion printing which allows you to insert a sheet between pages, or print a specific page on a sheet
fed from a tray other than the Paper Source option selected on the [Basic] tab.

This option is useful when you want to insert a blank sheet between chapters, or when you want to print chapter cover
pages on the different paper.

To enable sheet insertion printing, select the check box and click [Edit] to set how the pages are inserted in the [Insert
Pages] dialog box.

D P.46 “Insert Pages”

* This option cannot be set when the [Interleave Pages] option is enabled.
* Up to 50 pages can be inserted.

Tip

For detailed instructions on how to print with the [Insert Pages] setting, see the following page:
3 P.100 “Inserting different types of paper”

Interleave Pages

This sets the interleaving page feature that is useful when you want to insert paper of a different type (or from another
source) between every page of your print job. For example, you can use this option to insert blank, colored sheets
between overhead transparencies.

To enable interleaving pages, select the check box and select the location from where sheets are to be fed.

* When this option is enabled as well as the [Use Front Cover] and [Use Back Cover] options enabled, no page is
inserted after the front cover and back cover.
* This option cannot be set when [Insert Pages] option is enabled.
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Tip

For detailed instructions on how to print with the [Interleave Pages] setting, see the following page:

P.102 “Interleaving pages”
Source g

Select the location from where the interleaving sheet is to be fed. When [Auto] is selected, the paper is automatically
selected according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed in this equipment and
their configuration on the [Device Settings] tab.

Duplicate
When you select this check box, you can print previous page images on the inserted sheet.
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Insert Pages

1 2 3 4
Inseri|Pages [ﬂh,l
Page: Print Style: Paper Source: Paper Type:
Blank Auto Flain -
Blank Auto Plain
Blank Auto Plain
Blank Auto Plain
Blank Auto Plain
Blank Auto Plain
Blank Auto Plain
Blank Auto Plain
QK ] | Cancel

1) Page
Enter the page number where the sheet is to be inserted.
When [Blank] is selected from the [Print Style] box, the blank sheet is inserted before the entered pages.
When [1 Side] is selected from the [Print Style] box, the entered page will be printed on the inserted sheet.

2) Print Style
This selects how you want to print on insertion sheets.
- Blank — Select this to insert blank sheets.
- 1 Side — Select this to print the specified page on the front side of the insertion sheets.
- 2 Sides — Select this to print the specified page and the next page on both sides of the insertion sheets.

3) Paper Source
Select the location from where the insertion sheets are to be fed. When [Auto] is selected, the paper is automatically
selected according to the printed document size.

The selectable values in the [Paper Source] box vary depending on the optional devices installed in this equipment
and their configuration on the [Device Settings] tab.

4) Paper Type
Select the paper type to be inserted.
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Q [Image Quality] tab

The [Image Quality] tab allows you to select how images are printed. You can easily select the appropriate image quality
depending on the type of document.

r .
fmh TOSHIBA Universal Printer 2 Printing Preferences S| n

Basic | Firishing | Paper Handing | Image Quali | Effect | Others | Templates

Print Joh:

Image Quality Type: 1
Praofile Name

— -
General ‘

Photagraph 3
Presentation
Line Art

Letter Letter | Setting 1

JJJ123JJJ123
B
.

Profile: | Setting 3

. = 2

[ Restore Defaults ] [ Setting Delete 3

I Setting 2

Ok ] [ Cancel ] [ Apply ] [ Help

1) Image Quality Type
This sets how colors are printed by selecting the job type. The printer driver automatically applies the proper image
quality for the selected job type. You can select a pre-defined image quality type, or you can select a custom image
quality type that you created. The custom image quality type can be created or modified by clicking [Setting].
- General — Select this to apply the proper image quality for printing a general color document.
- Photograph — Select this to apply the proper image quality for printing photos.
- Presentation — Select this to apply the proper image quality for printing a vivid document.
- Line Art — Select this to apply the proper image quality for printing a document contain a lot of characters or line
art.
- Advanced — Select this to apply a profile which can adjust color space. The [Advanced] option is available only for
the printer drivers below.
- Universal Printer 2 (PostScript)
- Universal PS3
- Universal XPS

The Image Quality type option is not available when [Black and White] or [Twin Color] is selected at the [Color] box
on the [Basic] tab.

2) [Setting]
Click this to customize an image quality setting. When this is clicked, the [Setting] dialog box appears. You can set up
to 20 custom image quality settings.
P.48 “Setting: [Basic] tab”
P.51 “Setting: [Color Balance] tab”
P.52 “Setting: [Image Attribute] tab”
P.53 “Setting: [Advanced] tab”

In order to create a new custom image quality setting, you must access the printer driver properties from the
[Devices and Printers] folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server
2003: [Printers and Faxes]), but not from the [Print] dialog box in the application.

3) [Delete]
Click this to delete the custom image quality setting. When you click this, the confirmation dialog box appears. Click
[Yes] to delete the setting.
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Setting: [Basic] tab
In the [Basic] tab of the [Setting] dialog box, you can specify the following functions.
[Basic] tab for Universal Printer 2 (PCL6) / Universal XPS

Setting -5 [
Basic | Color Balance | Image Attibute:

Custom Colar Settings ‘

[ Save Current Settings as 1
Setting L
General
2 — Halftone: Resol 3
aito - 00dpi +
4 [ Use Black for All Text
5 7] Distinguish Thin Lines
6 [#] Pure Black Apply to: 8
7 7] Pure Gray e ]

ok [ Cowcel |[ Hen

[Basic] tab for Universal Printer 2 (PostScript) / Universal PS3

Setting B ||
Basic | Color Balance | Image Attibute:
Custom Color Settings ‘
[T 5ave Current Settings as 1
Setting L
General
2 — Hafftane: Resol 3
Gl oo - 600dpi -
5 —H_ || Distinguish Thin Lines
6 —H—PweE-\a(h Apply to: 8
7 —H_ Pure Gray Auto hd
Q ———— WlBiack Owerprint R — 10
‘ ‘ Text & Graphic ~
11 _H_ []PostSeript Overprint
1 2 _H_ [Tl Auto Trapping
1 3 —‘— Restore Defaults
ok || cacel | [ Help

1) Save Current Settings as
Select this check box to save the settings as the different setting. When this box is cleared, the Image Quality Type that
you selected will be undefined. Up to 20 custom image quality types can be created.

This check box is available only when you display printer driver properties from the [Devices and Printers] folder
(Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and Faxes]).

Name
Enter the Image Quality type name to be created. This must be entered when [Save Current Settings as] is selected.

Tips

* When you edit an existing custom Image Quality Type, the settings of this Image Quality Type will be
overwritten regardless of whether or not this Image Quality Type is renamed.

* Even if you enter any of the default Image Quality Type names ([General], [Photograph], [Presentation], [Line
Art] or [Advanced]) registered as default settings, these default Image Quality types will not be overwritten. The
Image Quality Type is saved as a new custom Image Quality Type under the name you have specified.
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2)

3)

4)

5)

6)

7)

8)

9)

Original Image Quality Type
Select the image quality type to be applied as the based image quality.

Halftone

This sets how halftones are printed.

- Auto — Select this to print using proper halftone depending on the contents in the document automatically.
- Smooth — Select this to print halftone smoothly.

- Detail — Select this to print halftone in detail.

Resolution
This sets the resolution for printing.
- 600 dpi — Select this to print in 600 x 600 dpi.
- 600 x 1200 dpi"' — Select this to print in 600 x 1200 dpi.
*1 Images are reproduced more smoothly because jaggies on the outlines of small text or fine lines such as graphics are suppressed.

However, 600 dpi is recommended for photos because the tone reproduction level of the image is higher.
Note that if the resolution is 1200 dpi, it takes longer than 600 dpi to print out because the capacity of the data being handled is larger.

* When [Photograph] or [Presentation] is selected in [Image Quality Type] of the [Image Quality] tab, [600 x 1200
dpi] cannot be displayed.
* When [600 x 1200 dpi] is selected, the functions below are not available.
- Booklet printing
- Automatic change of paper source
- Auto Trapping

Use Black for All Text
Select this check box to print all text in 100% black except white texts.

This function is available only for the printer drivers below.
- Universal Printer 2
- Universal XPS

Distinguish Thin Lines
Select this check box to print thin lines clearly.

Pure Black
Select this check box to print the black contents using black toner. When this box is selected, please select how this
function applies in the [Apply to] box.

Pure Gray
Select this check box to print the gray scale contents using black toner. When this box is selected, please select how
this function applies in the [Apply to] box.

The Pure Gray option is not available when [Pure Black] is not enabled.

Apply to
Select how the Pure Black and Pure Gray functions apply.

- Auto — Select this to automatically select areas to be printed using black toner when you want to print the black
(or black and gray scale) contents using its toner. When this option is selected, appropriate areas are printed using
black toner according to the Image Quality Type option.

- Text — Select this to print only black text or black-and-gray text using black toner.

- Text & Graphic — Select this to print only black text and graphics, or black-and-gray text and graphics using black
toner.

- Text, Graphic & Image — Select this to print all black areas or all black-and-gray areas using black toner.

Black Overprint

Select this check box when printing background content that has black text overlaid on it. If this is enabled, the gap
between the text and the background is minimized and color deviation is prevented. If this is not enabled, the
background of the black content will not be printed.

This function is available only for the printer drivers below.
- Universal Printer 2 (PostScript)
- Universal PS3
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10) Apply to
Select how the Black Overprint functions apply.
- Text — Select this to print all the full-color background and then print black text on the color background.
- Text & Graphic — Select this to print all the full-color background and then print black text and graphics on the
color background.

This function is available only for the printer drivers below.
- Universal Printer 2 (PostScript)
- Universal PS3

11) PostScript Overprint
Select this to enable overprint an object that has been set so on an application.

This function is available only for the Universal PS3 printer driver.

12) Auto Trapping
Select this to enable the Auto Trapping option. This is a technique where the size of objects is modified so that two
colors printed next to each other overlap slightly to avoid white spaces between them. These white spaces can be
caused by factors such as misregistration.

* This function is available only for the printer drivers below.
- Universal Printer 2 (PostScript)
- Universal PS3

* This function is available when you print a document with [Auto] or [Color] selected for the [Color] option in the
[Basic] tab of printer driver.

* When this function is enabled, the printing speed may be slow.

13) [Restore Defaults]
Click this to restore all the image quality setting details displayed in the [Basic] tab menu to the original factory defaults.
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Setting: [Color Balance] tab

In the [Color Balance] tab of the [Setting] dialog box, you can specify the following functions. Adjust the density level by

moving the scroll bar, or pressing buttons on the right and left of the scroll bar.

Setting P>
Color Bakance |imege Allibuis
' 0 4
1 —L aicotos: —
2 —_Each Color
Cyan: 4 i
0 « v
Magenta: 4 O
! ] 3
Yellow: 4 Y
0 « B
Black: 4 o
L « »
3 [ Detail: Edit
4 Restare Defaults
ok | cCancel | [ Hel

1) All Colors

Adjust the density of all the colors.

2) Each Color

Adjusts the density of each color for printing. You can set from -4 to 4.

3) Detail

Select this check box to adjust the density of each color separately in details. When this box is selected, click [Edit] to

display the [Color Balance Detail] dialog box and specify the density of each color.

— Color Balance Detail

In the [Color Balance Detail] dialog box, you can specify the density of low, middle, and high colors for each color.

- Low — Change this density to adjust the density of light color.
- Middle — Change this density to adjust the density of half color.
- High — Change this density to adjust the density of deep color.

- Restore Defaults — Click this to restore all the image quality setting details displayed in the [Color Balance Detail]
dialog box to the original factory defaults.

Color Balance Detail =)
Low: Middle: High:
P I (R )
Hlcyan: 0 =1 [0 =1 [0 Hoa-g
WiMagenta: | 0 = = |0 = (4-4)
[Tvellow: 0 = |0 = |0 = (-4-4)
Weiack: 0 = |9 = |0 = (4-4)
[ ] e | J

4) [Restore Defaults]

Click this to restore all the image quality setting details displayed in the [Color Balance] tab menu to the original factory

defaults.
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Setting: [Image Attribute] tab

In the [Image Attribute] tab of the [Setting] dialog box, you can specify the following functions. Adjust the density level by
moving the scroll bar, or pressing buttons on the right and left of the scroll bar.

Setting [ 9 [t
Color Balance | Image Atiibule
1 Cantrast:
+
" 7 ] .
2 Bight
o - 4
0 ‘ D
3 Background Adjustment:
| —y
0 ‘ ,
4 a
a 3
ok | [ Cancel ][ Hep

1) Contrast
Adjust the contrast for printing. You can set from -4 (lowest) to 4 (highest).

2) Brightness
Adjust the brightness for printing. You can set from -4 (darkest) to 4 (lightest).

3) Background Adjustment
Adjust the background adjustment for printing. You can set from -4 (lightest) to 4 (darkest).

4) Saturation
Adjust the saturation for printing. You can set from -4 (low clear) to 4 (high clear).

5) Use Sharpness Filter
Select this check box when you use a sharpness filter. You can set from -4 (softest) to 4 (sharpest).

6) [Restore Defaults]
Click this to restore all the image quality setting details displayed in the [Image Attribute] tab menu to the original
factory defaults.
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Setting: [Advanced] tab

In the [Advanced] tab of the [Setting] dialog box, you can set the functions below.
The color profile data of this equipment may be updated. If the SNMP communication between this equipment and your
computer is available, open the [Advanced] tab menu and then click [Update Now] to obtain the updated color profile data.

1)

2)

3)

4)

5)

6)

7)

The [Advanced] tab menu is displayed when [Advanced] is selected in [Image Quality]. The [Advanced] option is
available only for the printer drivers below.

- Universal Printer 2 (PostScript)

- Universal PS3

- Universal XPS

Tip
Color profiles can also be set from the TopAccess menu. For the detailed instructions on how to set color profiles from
the TopAccess menu, refer to the TopAccess Guide.

Setting T ]

Basic | Cokor Balance | Image Atibute [{ Advanced

Source Profiles
RGB Source Prafile
Printer's Defauft v
& | CMYK Source Prafile
o .
@ | |Printer's Default +

7] Apply to Device Calor Only

AW N =

Profile

= Destination Profile
| |Printer's Defautt ~

Rendering Intent

o

@ Printer's Default
Perceptual
Relative Colorimetric
Saturatian

Absolute Colorimetric

6 Restore Defaults ) Update Now ] 7

ok | cancel | [ Help

RGB Source Profile
This selects the RGB source profile. When you obtained color profile data from this equipment, the RGB source profile
data of this equipment appear.

CMYK Source Profile
This selects the CMYK source profile. When you obtained color profile data from this equipment, the CMYK source
profile data of this equipment appear.

Apply to Device Color Only
Select this check box when you give priority to color profiles embedded in the image.

Destination Profile
This selects the destination profile. When you obtained color profile data from this equipment, the destination profile
data of this equipment appear.

Rendering Intent

This selects the method for color space conversion when you print images.

- Printer’s Default — Color space conversion is performed according to the default profile.

- Perceptual — This is recommended for photo images.

- Relative Colorimetric — More original colors can be retained than those when you select [Perceptual].

- Saturation — This is recommended when the vividness of colors is more important than their correct reproduction.
It is useful for graphic charts.

- Absolute Colorimetric — Original colors can be retained even on colored paper.

[Restore Defaults]
Click this to restore all the image quality setting details displayed in the [Advanced] tab menu to the original factory
defaults.

[Update Now]
Click this to obtain the latest color profile data set for this equipment and update the existing color profile data. This is
enabled only when SNMP communication with this equipment is enabled.

Setting Up Print Options 53




2 PRINTING FROM WINDOWS

[Printer’s Default] is a default setting for RGB Source Profile, CMYK Source Profile, Destination Profile and
Rendering Intent. When you select [Printer’s Default], color space conversion is performed according to the default

profile (that set as a default profile in the [ICC Profile] submenu of the [Setup] menu in the TopAccess administrator
mode).
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O [Effect] tab

The [Effect] tab contains print options that add effects to your print jobs such as Watermarks, Overlay Image printing,
Rotate printing, Mirror printing, and Negative/Positive printing.

[Effect] tab for Universal Printer 2 (PCL6) n
@ TOSHIBA UnTvErsaIﬂiErZ Printing Preferem:es-

Basic | Flmshlngl Faper Handiing | Image Uuahly‘ Effect |Ulhers| Tsmplalesl

Print Job: k 1
Mormal Prnt 'E‘ ann: ']

[LoAdde ][ Edit. ][ Delete |

[1Print an First Page Only

Overlay Image: 2

[Nnn: -

[“1Print Over the Document
[]Print an Each Page

Profile:

[ Megative/Positive 5

I Ok ] [ Cancel ] [ Apply ] [ Help

[Effect] tab for Universal Printer 2 (PostScript) / Universal XPS

& TOSHIBA e-STUDIO Series XPS Printing meemn_

‘ Basic I Finishing | Paper Handling | Image Qualityl Effect |Dthers | Templatesl

Print Job: wat " 1
atermark:

[ —— =
(

Add ] [ Edit. ] [ Delete |

[ Print an First Page: Oy

Overlay Image: 2

@[None hd

[ Print Cver the Document
[] Prirt an Each Page

BRotate 180 Degiees
Mirar 4

[] Megative/Pasitive

Settings.

Profile:

Restore Defaults

I akK ] l Cancel ] [ Apply l [ Help
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[Effect] tab for Universal PS3

r N
ey TOSHIBA Universal PS3 Printing Preferences &J

Basic | Fimshingl Paper Handling | Image Qua\ity‘ Effect |Dthers| Templatesl

Print Job: Watermark: 1
=l Nommal Print - EINME -]
%}%‘ﬁ“ Edit Delete

Print an First Page Only

Overlay Image: 2

@ INnne =

100 Details. Delete

e Print Over the Document
JJJTzB JJJTzE Print an Each Page
El
Profile:
[|Rotate 180 Degrees 3

Megative/Pgsitive 5

Save Profile Delete
Restore Defaults

Lol

1) Watermark
This selects the watermark to be used or edited. The following values except [None] are the default watermarks that
have been registered in the printer driver. Up to 15 new watermarks can be added in this box.
- None — Select this if no watermark is desired.
The following default watermarks are also displayed in the box:
- TOP SECRET
- CONFIDENTIAL
- DRAFT
- ORIGINAL
- COPY

Tip

For the detailed instructions on how to print with the [Watermark] setting, see the following page:
P.103 “Printing with watermarks”

[Add]
Click this to create a new watermark. The [Watermark] dialog box appears when you click on this.
P.58 “Add/Edit Watermark”

[Edit]

Select a watermark from the [Watermark] box and click it to edit the watermark. The [Watermark] dialog box appears
when you click on this.

P.58 “Add/Edit Watermark”

[Delete]
Select a watermark from the [Watermark] box and click it to delete a watermark.
P.105 “Deleting a watermark”

* The default watermarks can be deleted but, once deleted, they cannot be restored.
* [None] cannot be deleted.

Print on First Page Only
Select this check box to print a watermark on the first page only. This setting will become available when any
watermark is selected from the [Watermark] box.

2) Overlay Image
This selects an overlay image to be used. This feature allows you to print an image on the background of a print job,
although the watermark allows only text.
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3)

4)

5)

* When [Overlay Image] is selected together with the N-up printing, 1 overlay image will be printed on the entire
page, regardless of the number of images set in 1 page.

* Both the overlay file and the documents on which you superimpose the overlay image must be created in the
same size, color mode and orientation.

Tips

* If you want to use an overlay image in your job, you must first create an overlay file. To do this, create an
overlay image with most applications and print it as an overlay file. You can enable creating an overlay file on
the [Print Job] box.

P.83 “Printing a document as an overlay file”

* For the detailed instructions on how to print with the [Overlay Image] setting, see the following page:

P.106 “Printing with an overlay file”

[Details]

Click this to set which overlay image is applied to which page, such as changing the type of overlay image for odd
pages and that for even pages or applying an overlay image only to the specified pages.

If you click this when [Multiple Overlays] is selected in the [Overlay Image] box, the [Multiple Overlays] dialog box
appears.

L0 P.59 “Multiple Overlays”

[Delete]
Click this to delete the overlay image that you select in the box.
3 P.107 “Deleting an overlay image”

[None] and [Multiple Overlays] cannot be deleted.

Print Over the Document
Select this check box to print an overlay image over the document.

Print on Each Page

This selects whether overlay images are printed for each page or paper when multiple pages are printed on one sheet
with options such as Number of pages per sheet or Booklet. Select this check box when overlay images are printed for
each page.

Rotate 180 Degrees
Select this check box to perform rotation printing of an image.

Mirror
Select this check box to perform mirror printing of an image.

This function is available only for the printer drivers below.
- Universal Printer 2 (PostScript)
- Universal XPS

Negative/Positive
Select this check box to perform negative printing of an image.

* The Negative/Positive option is available only when [Black and White] is selected at the [Color] box on the
[Basic] tab.
* This function is available only for the printer drivers below.
- Universal Printer 2 (PostScript)
- Universal PS3
- Universal XPS
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Add/Edit Watermark

When you click [Add] or [Edit], the [Watermark] dialog box appears and you can create new watermark or edit selected

watermarks.
f Watermark [&r
Caption: 2
TOP SECRET 3
. Font Name:—v/ Style: 4
.(_:&. Arial v| |Regu|ar hd
Hn.:":v Fant Size: 5
< n =] pt (6-300)
Color: 6
|. Gray v| | Browse...
1 Pasition Angle: 7
K = A 52 "4 +
+ -90 0 a0
€ + 2l
Print Style
k¥ N & Salid 8
Draw as Outline 9
11 Restore Defaults qllIransparency: - i 10
| Ok | | Cancel
1) Position
Select this to adjust the position of the watermark. Click the arrow button or [+] located at the center to adjust it.
2) Caption
Enter the text of a watermark. You can enter up to 63 alphanumeric characters.
When you are editing a watermark, the selected watermark text is displayed in the box.
The entered text is displayed as the sample image on the left.
3) Font Name
Select the font to be used for the watermark text.
4) Style
Select the font style for the watermark text.
- Regular — Select this to set the regular style to the text.
- Bold — Select this to set the bold style to the text.
- Italic — Select this to set the italic style to the text.
- Bold Italic — Select this to set the bold and italic style to the text.
5) Font Size
Enter the font size for the watermark text. The font size can be set from 6 to 300 pt in units of 1 pt.
6) Color
Select the color of the watermark text. If the color that you require is not listed in the box, click [Browse] to add new
color.
When [Black and White] is selected at the [Color] box on the [Basic] tab, this option will be disabled.
7) Angle
Enter the degree of angle for rotating the watermark text. The angle can be set from -90 to 90 degrees in units of 1
degree. You can also set the degree of the angle by moving the scroll bar.
8) Solid
Select this to print a solid type of watermark.
9) Draw as Outline
Select this to print a outline type of watermark.
10) Transparency

Select this to print a transparent watermark. When you select this, set the brightness from 0 (darker) to 100% (lighter)
in units of 1%. You can also set the brightness using the scroll bar.

11) [Restore Defaults]

Click this to restore the settings displayed in the [Watermark] dialog box to the original factory defaults.
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Multiple Overlays

If you click [Details] when [Multiple Overlays] or the desired overlay is selected in the [Overlay Image] box, the [Multiple
Overlays] dialog box appears. Set which overlay image is applied to which page in this dialog box.

1)

2)

3)

4)

5)

Multiple Overlays |
1 Overlay Images
2 Y Y _ 3
[~ Master Setting 1 Setting 1 Setting 2
Page: Page:
All
Even
Odd
Setting 3 Setting 4
Page: Page:
4 Master Setting 2 5
Even Setting 5 Setting &
add Page: Page:
6 Select setting to clear
|Ma5ter Setting L v| | Clear ‘ 7
Restore Defaults 8
OK Cancel Help

Overlay Images
The registered overlay images are displayed in a thumbnail. Select the desired overlay image.

Tip

You can drag and drop an overlay image in the thumbnail to the desired overlay group (Master Setting 1/2 or
Setting 1/2/3/4/5/6) to set directly. If another overlay image is already set in the selected group, the overlay image
is overwritten.

[V ] (Master Setting)

This sets the overlay image selected in the [Overlay Images] box in the [Master Setting] field. Selection is switched in
the order of [Master Setting 1] to [Master Setting 2] every time you click this.

[V 1 (Setting)

This sets the overlay image selected in the [Overlay Images] box in the [Setting] field. Selection is switched in the order
of [Setting 1], [Setting 2], [Setting 3], [Setting 4], [Setting 5] and [Setting 6] every time you click this.

Master Setting 1/2

This sets if the selected overlay image is applied to all, even or odd pages.

- All — Select this to apply the chosen overlay image to all pages.

- Even — Select this to apply the chosen overlay image only to even pages.

- 0dd — Select this to apply the chosen overlay image only to odd pages.

* Ifthe specified pages are overlapped among multiple master settings, the setting of [Even] or [Odd] has priority
over that of [All].

* If the specified pages are overlapped in both settings of [Master Setting] and [Setting], the setting of [Setting]
has priority over that of [Master Setting].

Setting 1/2/3/4/5/6
This sets pages to which the selected overlay image is applied by page number. To specify more than one page,

delimit with commas such as “1, 3, 5”. To specify pages in a range, use a hyphen between the first and the last pages,
such as “6-10".

- Page — Select this to apply the selected overlay image only to the specified pages.

If the specified pages are overlapped among multiple settings, the newer setting has priority.
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6) Select setting to clear
This selects the overlay image setting to be cleared.

7) [Clear]
This clears the overlay image setting selected in the [Select setting to clear].

8) [Restore Defaults]
Click this to restore the settings displayed in the [Multiple Overlays] dialog box to the original factory defaults.
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U [Others] tab

The [Others] tab contains print options such as toner saving, custom paper size and so on.

= TOSHIBA Universal Printer 2 Printing Preferences @
Basic | Fimshingl Paper Handling | Image Qua\ityl Effect | Others ‘ Templatesl
Print Joh: D Default Menu Setting: 1
%@% [C] Toner Save 3
"] Do not Print Blank Pages 4
[ Letterhead Print Mode 5
6 [¥] SMMP Communication SNME Settings 7
8 { Output Devices l [ Acld Printer ] 9
100% [ LCustam Paper Size } 1 0
11 — User name {Alias): Userd0L
JJJW 23 JJJW 23
Department Cade:
12
[ Settings... ]
13 [7] Hide Department Code(Z)
Profile:
i 14
15 Saye Profile Delete Custom Settinas File: [ pot | | Export 1 16
1 7 [ Restore All Defaults ] [ Vegsion Infarmation 1 1 8
Ok J [ Cancel ] I Lpply I [ Help

1) Default Menu Setting
Select the default tab that is displayed when you open the printing preferences of the printer driver. Set frequently used
functions as a default menu setting for your convenience.

If you made settings on the [Others] tab menu from the print setting page of the application, they are restored to the
defaults when you close the printer driver.

If you want to resume the settings, set the printer driver from the [Devices and Printers] folder.

P.24 “Setting initial values of print options”

2) TopAccess (Link)
Click this to start a web browser and display the TopAccess menu.

3) Toner Save
Select this check box to print in the toner save mode.

When the toner save mode is enabled, printing may become lighter.

4) Do not Print Blank Pages
Select this check box to ignore blank pages for printing.
If the Watermark feature is enabled, all pages will be printed even when the content is blank.

The pages having a header or footer will be printed even if the content is blank.

5) Letterhead Print Mode
Select this check box to perform duplex printing on paper whose sides need to be distinguished, such as paper with
illustrations on one side.

6) SNMP Communication
This enables SNMP communication between this equipment and your computer to retrieve the option configuration
information.

If you disable SNMP Communication, TopAccessDocMon notification also will be disabled.
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7) [SNMP Settings]
Click this button when you need to verify or change the SNMP settings.
D P.64 “SNMP Settings”

In order to set [SNMP Settings], you must access the printer driver properties from the [Devices and Printers] folder
(Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and Faxes]), but
not from the [Print] dialog box in the application.

8) [Output Devices]
This switches the equipment to be used for printing or splits one print job between two pieces of equipment (Tandem
Printing).
P.110 “Switching equipment to print jobs”
1 P.111 “Splitting a print job across two pieces of equipment (Tandem Printing)”

9) [Add Printer]
This discovers the equipment over a network and adds it on [Printer Folder].
P.65 “Add Printer”

10) [Custom Paper Size]
Click this to specify the custom paper size. The [Custom Paper Size] dialog box appears when you click this.
P.65 “Custom Paper Size”

* In order to set [Custom Paper Size], you must access the printer driver properties from the [Devices and
Printers] folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003:
[Printers and Faxes]), but not from the [Print] dialog box in the application.

* The [Custom Paper Size] can be set only by an operation with the administrator privilege.

11) User name (Alias)
Enter a nickname as required, which is displayed on the Private Print job list and Hold Print job list. You can specify the
desired name so that you can easily find the target job from the job list when releasing it from the equipment’s touch
panel.

Tips

* Up to 31 characters can be entered for the [User name (Alias)] box.

* The user name that is entered to log in to your computer is initially used for [User name (Alias)]. If the user
name is not changed, the log-in user name is displayed on the Private Print job list and Hold Print job list.

* The nickname entered for the [User name (Alias)] box is applied only to the Private Print job list and Hold Print
job list. On other job list screens (Scheduled Print jobs / Invalid jobs) and the Print Log screen, the log-in user
name is always displayed.

12) Department Code
Enter the user’s department code if the system is managed with department codes. Please ask your administrator for
your department code.

* When the User Management setting is enabled, it is used to manage a print job instead of the Department
Code Management setting. In this case, a user name that has been entered to log in to your computer is used
for the authentication of the print job. Therefore, you do not need to set your department code to the printer
driver but you must register your user name in advance. If your user name is not registered, the print job is
processed as an invalid one according to the User Authentication Enforcement setting. Also if a print job is sent
in RAW format, it is processed according to the RAW Print Job setting. For more information about the User
Authentication Enforcement setting or the RAW Print Job setting, refer to the TopAccess Guide.

 If the No Limit Black function is enabled, you do not have to specify the department code when you print a
document with selecting [Black and White] in the [Color] option in the [Basic] tab of the printer driver.

» If the number of the printed sheets for a print job exceeds the output limitation for the entered department code,
the print job is stored in the invalid department code print job list without printing. When you want to print the
print job, perform printing from [JOB STATUS] on the touch panel by entering another department code for
which the output limitation is more than the number of printed sheets.

* In the [Department Code] box, you can enter a department code within 63 characters.
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Tip

How the equipment performs printing for an invalid department code print job, for which an invalid department code
is specified, varies depending on the Invalid Department Code Print Job setting that can be set in the TopAccess
Administrator mode and whether SNMP communication is enabled or not. n
- When SNMP communication is enabled and Invalid Department Code Print Job is set to [Store to invalid job

list], an error message will be displayed when an invalid department code is entered.
- When SNMP communication is disabled and Invalid Department Code Print Job is set to [Store to invalid job

list], the invalid department code print job will be stored in the invalid department code print job list without

printing.

- When the Invalid Department Code Print Job is set to [Print], the invalid department code print job will be
printed.

- When the Invalid Department Code Print Job is set to [Delete], the invalid department code print job will be
deleted.

13) Hide Department Code
Select this check box to display a department code in the blank symbols.

14) Server Name
Enter the desired LDAP server if needed.

Tip
Up to 64 characters (excluding# ; \ =) can be entered for the [Server Name] box.

15) [Import]
Click this to import custom settings (e.g. template, watermark, overlay, image quality type, custom paper size, profiles)
to the printer driver.

How to import custom settings

- Click [Import]. A dialog box to select a file appears. Select a file (*cfu for Universal Printer 2, *cfp for Universal PS3,
*cfv for Universal XPS) to be imported.

- Click [Open]. A dialog box to confirm if you overwrite the file appears. Then click [OK].

In order to set and perform [Import], you must access the printer driver properties from the [Devices and Printers]
folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and
Faxes]), but not from the [Print] dialog box in the application.

16) [Export]
Click this to export custom settings (e.g. template, watermark, overlay, image quality type, custom paper size, profiles)
from the printer driver.

How to export custom settings
- Click [Export].
- The [Save as] dialog box appears. Specify a file name and a directory. Then click [Save].

In order to set and perform [Export], you must access the printer driver properties from the [Devices and Printers]
folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and
Faxes]), but not from the [Print] dialog box in the application.

17) [Restore All Defaults]
Click this to return settings in all the tab menus other than the [Device Settings] tab menus to the default ones. A
confirmation dialog box appears as you click this, and if you click [OK], print settings in all the tab menus will return to
the default ones.

If you want to change the settings in the [Font] and [Device Settings] tab menus, you need to access with the
administrator privilege from the Printers folder. For the details, see the following page:
LD P.67 “[Device Settings] tab”

18) [Version Information]
Click this to display the [Version Information] dialog box.
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SNMP Settings

SNMP Settings [

2 SNIMP V1/V2
Community Name:
private

3 SHIMP V3

User ID File

User Mame/Passward

HMAC-MDS

MNone

4 Restore Defaults

Cancel

1) Version
Be sure to have the correct SNMP version set for your MFP and select from the following options:
- V1/V2 — Select this option to enable SNMP V1 and V2.
- V3 — Select this option to enable SNMP V3.
- V1/V2/V3 (for [Discovery Settings] dialog box only) — Select this option to enable SNMP V1, V2, and V3.

2) SNMP V1/V2
Community Name—If a community name other than “private” (default) is set for the SNMP community name for your
MFP, enter its community name.

¢ To find your MFP under the SNMP V1/V2 environment, the community names set for the target MFP must be
specified correctly. For help, consult your administrator.

* To change the community name, the administrator privilege is necessary. You must log in with the
“Administrator” privilege and open the printer driver properties.

* Up to 31 characters including the following symbols can be entered for the Community Name.
V"#8% &' ()*+,-/:;<=>2@[\]*_"{|}~

3) SNMP V3
If SNMP V3 is enabled, select one of the following items to set how users are authenticated.
User ID File — Select this option when you want to use a user ID file. Click [Browse] and specify the user ID file.
User Name/Password — Select this option when you want to use the user name and password. When this option is
selected, use the keyboard to select the following items:
- User Name
- Authentication Protocol
- Authentication Password
- Privacy Protocol
- Privacy Password

* If you select to enable SNMP V3, consult your network administrator for preliminary advice on how to
authenticate users.

* Up to 31 characters including the following symbols can be entered for each of the User Name, Authentication
Password and Privacy Password.

$%&' ()-.<>@I[1"_"{}~

4) [Restore Defaults]
Click this button when you want to reset all the settings back to the defaults.
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Add Printer

Discovered Printers @

Discovered Printers 1
Marne Location Madel Status

MFP0GIA53LL TOSHIBA e-5TU..  Idle

MFP0GI95405 TOSHIBA e-5TU..  Unknown

2 [ Add ][ Information... ] 3
vailahle Printer List 4
TOSHIBA Universal Printer 2 -
QK ] [ Cancel ] [ Help

1) Discovered Printers
This displays the equipment discovered over a network. You can check its name, installation site, model name and
status.

2) [Add]
This adds the printers selected in the [Discovered Printers] box to [Printer Folder].

3) [Information]
This indicates the basic information of the printer selected in the [Discovered Printers] box. You can check the
availability of color printing, 2-sided printing or stapling, its copying speed, resolution and the type of paper placed.

4) Available Printer List
This indicates the printers registered in [Printer Folder].

Custom Paper Size

In the [Custom Paper Size] dialog box, up to 40 custom paper sizes can be defined. The custom page size that you specify
can be selected in the [Original Paper Size] and [Print Paper Size] box on the [Basic] tab.

Tip
The defined custom paper size setting can be used in common for the Universal Printer 2 / Universal PS3 / Universal
XPS printer drivers.

The [Custom Paper Size - Paper Size List] dialog box

rC.ston" Paper Size @1
1 = Paper Size List:
Mame Size
Custam Paper 1 8.50 % 1L.00 inch
Custom Paper 2 850 1100 inch
Custam Paper 3 850 1L00 inch
Custom Paper 4 850 1L00 inch
Custom Paper 5 5.50% L1100 inch
Custom Paper 6 5.50% LL0D inch
Custam Paper 7 8.50 % 1100 inch
Custom Paper § 850 1100 inch
Custam Paper 9 850 1L00 inch
2 Il Add I[ Delete } 3
L
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The [Custom Paper Size - Name] dialog box

[ Custom Paper Size lﬁr
4 | Mame:
Custam Paper L
A{Length): n
8.50 = inches (3.94 - 1L69)
— 5
B{Width):
1L.00 £ inches (5.83 - L?.UU)_
@ inch mm | 6
| Ok | | Cancel |
1) Paper Size List
Select the custom paper size that you want to modify.
2) [Add]
Click this to display the [Custom Paper Size - Name] dialog box.
3) [Delete]

Click this to clear and restore the default settings of the selected custom paper size that you selected in the [Paper
Size List]. When you click this, the confirmation dialog box appears. Click [Yes] to delete the setting.

4) Name
Enter the custom paper size name. You can enter up to 63 characters. This name will be displayed in the [Original
Paper Size] and [Print Paper Size] box on the [Basic] tab.

5) Paper Size
Enter A (Length) and B (Width) to specify the paper size.

Select values within the range shown on the right of each.

6) Units
Select the unit for the paper size. The default unit varies depending on the regional setting in the Windows.

» To register a custom paper size, either A (Length) or B (Width) should differ by more than 0.3 inches (7 mm) from
the standard paper size. If not, the created custom paper size is considered as the standard paper size.

* You cannot create a custom paper size with A (Length) longer than B (Width). If you want to print such a document,
do so by selecting [landscape] for the [Orientation].

* There are some precautions when you use paper larger than the standard sizes. For details, see the following
page:
P.108 “Printing on paper larger than standard sizes”
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U [Device Settings] tab

The [Device Settings] tab allows you to configure options. When any optional unit is installed in this equipment, set the
configuration of the machine on this tab. The [Device Settings] tab can be displayed only from the Printers folder (and not
when displaying the properties from the application’s print dialog box).

1)

2)

3)

4)

In order to set the [Device Settings] tab, you must access the printer driver properties from the [Devices and Printers]
folder (Windows Vista / Windows Server 2008: [Printer], Windows XP / Windows Server 2003: [Printers and Faxes]).
For detailed instructions on how to set the [Device Settings] tab, see the following page:

P.13 “Configuring options manually”

5 TOSHIBA Universal Printer 2 Properties &J
General I Sharing | Ports | Advanced | Color Management I Secumlyl Device Settings

Model Selection: 1

|e-STUDIO4OTCS -
Option 2
Dirawers:
[Drawer L2 & Drawer 3,4 v]
Finisher: 3

[Inner Finisher {1 Tray} 'I

Nane

Nane

Inserter Unit

Automatic Duplexing Unit

|' De.vjie Settings Retr\“err“a.\“ Harddisk I 4

VI I

8 [¥]up sl [ Drawer Settings ] [ Agcount Settings ! 5

9 : Restare Defaults ] [ Wersian Informatian } 7
0K ] [ Cancel ] [ Apply ] [ Help

Model Selection
This sets the model type.

Selecting [Universal] restricts the printer driver functions to those common to all printers on the network, which is
convenient for using other printers with your printer driver.

Option
This option sets whether the following optional devices are installed.

Drawers

This sets the installation of drawers according to the configuration.

- Drawer 1 — Select this when only Drawer 1 is installed.

- Drawer 1 & LCF — Select this when Drawer 1 and the Large Capacity Feeder are installed.
- Drawer 1 & Drawer 2 — Select this when Drawers 1 and 2 are installed.

- Drawer 1, 2 & Drawer 3 — Select this when Drawers 1, 2 and 3 are installed.

- Drawer 1, 2 & Drawer 3, 4 — Select this when Drawers 1, 2, 3 and 4 are installed.

Finisher

This sets whether or not the Finisher is installed.

- None — Select this when a Finisher is not installed.

- Inner Finisher (1 Tray) — Select this when a Finisher is installed.

[Drawer Settings]

Click this to set the paper size and paper type of each drawer. The [Drawer Settings] dialog box appears by clicking
this.

P.69 “Drawer Settings”
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5) [Account Settings]
Click this button to set whether the user management setting is enabled or not. You can also set whether the Private
Print Restriction function and Hold Print Restriction function are enabled or not. The [Account Settings] dialog box
appears upon clicking this button.
3 P.70 “Account Settings”

6) [Customization]
This sets options specific to PCL6 or PostScript, or changes the Plug-in settings or the printer driver language. When
you click this, the [Customization] dialog box appears.
3 P.72 “Customization: [Plug-in] tab”
P.73 “Customization: [Language] tab”
P.74 “Customization: [PDL Settings] tab”

The Printer Language setting is available only for the printer drivers below.
- Universal Printer 2
- Universal PS3

7) [Version Information]
Click this to display the [Version Information] dialog box.

8) Device Settings Retrieval
This enables SNMP communication between this equipment and your computer to retrieve the option configuration
information.

Update Automatically
Select this check box to update the option configuration information automatically every time you open the [Device
Settings] tab.

[Update Now]
Click this to obtain the configuration information from this equipment immediately.

Tip
If the connection to the equipment has not been configured correctly, the message “The address of your printer
could not be located. Would you like to find it?” will be displayed when you click [Update Now]. If it is displayed,
click [Yes] and search for the equipment using the [Local Discovery] dialog box. After searching for the equipment,

SNMP communication will be enabled. For the instructions on how to search for the equipment, refer to the
instructions of TopAccessDocMon.

If you disable SNMP Communication, TopAccessDocMon notification also will be disabled.

9) [Restore Defaults]
Click this to restore the configuration of this equipment displayed in the [Device Settings] tab menu to the original
factory defaults.
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Drawer Settings

1)

2)

3)

4)

5)

<
Drawer Settings &J

I 2
1 Paper Size: Paper Type: Attribute: ‘ 3
Drawerl: S (g ~| [prain ~| [none -
DrawerZ  [a5 -] [piain =] [Mone -
Drawer 3: [BS v] [P\ain v] [None v]
Mg [Letter v] [P\ain v] [None V]
Ad Plain Mone
Ad Plain MNone
el [Automatic v] [P\ain v] [None V]
4 - | Qverride Application Paper Source Settings
5 Restare Defaults
Paper Size
Select the paper size set in each drawer.
Paper Type
Select the paper type set in each drawer.
Attribute

Select the attribute of the paper. When you set the attribute, the drawer will be selected preferentially according to the
print settings.

Override Application Paper Source Settings
Select this check box to use the paper source setting in the printer driver rather than the application setting.

[Restore Defaults]
Click this to restore the settings displayed in the [Drawer Settings] dialog box to the original factory defaults.

Tip

Drawers selectable differ depending on the option configuration.
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Account Settings

Accaunt Settings @

1 ——— User Authentication

IMFP Local Authentication -
2 —— [ Enter the user credentials manually
3 ——  User Mame:

Userdd L
4 ——  Domain Name:
5——— LDAP Server Settings
6 ——— [ | Private Print Restriction
7 —— || Hold Print Restriction
8] ] | Cancel

Tip
When SNMP communication is enabled, the following account information is automatically obtained from the
equipment.

1) User Authentication
Select the authentication method which is to be used. Set it to correspond to that of your MFP.
- Off — Select this not to perform user authentication.
- MFP Local Authentication — Select this to perform MFP Local Authentication.
- Windows Domain Authentication — Select this to perform Windows Domain Authentication.
- LDAP Authentication — Select this to perform LDAP Authentication.

2) Enter the user credentials manually
When this check box is selected, you are prompted to enter your user name and password every time you print a
document. This option is available when any of MFP Local Authentication, Windows Domain Authentication, or LDAP
Authentication is selected in the [User Authentication] box.

Tip
This option can be used together with any of the user authentication functions (MFP Local Authentication,
Windows Domain Authentication, LDAP Authentication).

3) User Name
The user name that is entered to log in to your computer is displayed.

4) Domain Name
The domain name on which the equipment belongs is displayed.

5) LDAP Server Settings
When you click this button, the [LDAP Server Settings] dialog box will appear. This option can be selected only when
[LDAP Authentication] is selected in the [User Authentication] box.
P.71 “Setting up LDAP servers”

6) Private Print Restriction
Select this check box to enable the Private Print Restriction function.

7) Hold Print Restriction
Select this check box to enable the Hold Print Restriction function.

Tips

* For details and setting of the Private Print Restriction function and Hold Print Restriction function, refer to the
TopAccess Guide.

» After you adjust settings in the [Account Settings] dialog box, make sure to confirm that the settings have been
changed as specified in the printing preferences dialog box, accessing from the [File] menu > [Printing
Preferences]. You can also confirm that the settings have been changed as specified on the properties page of the
printer driver when you print documents from applications.
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Setting up LDAP servers

The [LDAP Server Settings] dialog box allows you to register LDAP servers.

1)

2)

3)

4)

LDAP Server Settings ==

1 ———— Server Mame:

LDAPD3
2—L [ add
3——— Server Mame List:

Mame

LDAPOL

LDAPO2
4 —- Delete

[ Ok ] | Cancel

Server Name

Enter the desired LDAP server in this box if needed.

Tip

Up to 64 characters (excluding # ; \ =) can be entered for the [Server Name] box.

[Add]

Click this button to register the LDAP server in the [Server Name List], which has been entered in the [Server Name]

box.
Server Name List

The registered LDAP servers are displayed in this list. Up to 16 LDAP servers can be registered.

[Delete]

Click this button to delete an LDAP server in [Server Name List]. Select the LDAP server that you want to delete in the

list, and click this button.
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Customization: [Plug-in] tab

You can enable or disable the Plug-in setting.

1)

2)

3)

4)

5)

6)

7)

Customization l ? |5
Plugin | Language | PDL Settings

Paper Handling
[#]Image Quality
Effect
[¥] Templates
[¥] Add Printer
[¥] Tandem Print —

ONRWN=-

Restore Defaults ] 7

I ok ][ Cancel ][ Help ]

S

Paper Handling
Select this check box to enable the [Paper Handling] tab.
P.43 “[Paper Handling] tab”

Image Quality
Select this check box to enable the [Image Quality] tab.
P.47 “[Image Quality] tab”

Effect
Select this check box to enable the [Effect] tab.
P.55 “[Effect] tab”

Templates
Select this check box to enable the [Templates] tab.
P.76 “[Templates] tab”

Add Printer

Select this check box to enable [Add Printer] on the [Others] tab.
P.61 “[Others] tab”

P.65 “Add Printer”

Tandem Print

Select this check box to enable [Output Devices] on the [Others] tab.

P.61 “[Others] tab”

P.110 “Switching equipment to print jobs”

P.111 “Splitting a print job across two pieces of equipment (Tandem Printing)”

[Restore Defaults]
Click this to restore the factory defaults on the [Plug-in] tab.
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Customization: [Language] tab

You can switch printer driver language.

Customization @éjw
Plugin | Language | POL Settings
’Auto v} 1
[ Restore Defaults ] 2
I ak I [ Cancel ] [ Help ]
h

1) Language
This selects the language to be used.
- Auto / Chinese (Simplified) / Chinese (Traditional) / Danish / Dutch / English (UK) / English (US) / Finnish / French
/ German / ltalian / Japanese / Norwegian, Nynorsk / Polish / Russian / Spanish / Swedish / Turkish

Tip
[Auto] is selected by default. When [Auto] is selected, the most appropriate printer driver language is automatically
set according to the regional and language settings in Windows OS.

2) [Restore Defaults]
Click this to restore the factory defaults on the [Language] tab.
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Customization: [PDL Settings] tab

The Printer Language setting is available only for the printer drivers below.
- Universal Printer 2
- Universal PS3

.

Customization l 2 iz-l

PDL Setigs
Output PDL: PCLG - 1
ASCH 2
Ernint Error Information 3
Compress Bitmap 4
VIIPEG Compression 5
Bold level: 6
0.017 2[0.000 - L.000]
Restore Defaults | 7
[ ak. ] | Cancel | | Help |

1) Output PDL
This selects the printer driver language (PDL) to be printed. The setting can be changed only when the Universal
Printer 2 printer driver is used. The setting is fixed to [PostScript] when the Universal PS3 printer driver is used.
- PCL6 — Select this to print in PCL6.
- PostScript — Select this to print in PostScript.

If [PostScript] is selected in the Universal Printer 2 printer driver, printing from an application by PostScript pass
through output cannot be performed. Since PostScript is generated via GDI, it is limited to the RGB color space. To
perform pass-through printing from applications which can directly generate PostScript such as Adobe lllustrator,
use the Universal PS3 printer driver.

2) Output Format
This selects an output format for PostScript printing. This setting can be changed only when [PostScript] is selected in
the [Output PDL] box.
- ASCIl — Ajob is sent in ASCII format (enabling PostScript code editing with a text editor or a word processor).
- Encapsulated PostScript (EPS) — A job is printed as an image file in EPS format (for PostScript-compatible
printers).
- Using Adobe DSC — A job is sent in PostScript format that is optimized to reduce printing errors.

EPS format is usually used for creating images to be imported into a document. Therefore, only the first page of a
document can be printed when [Encapsulated PostScript (EPS)] is selected. Also the destination where the paper
should exit can be set only by the administrator. For the details, ask your administrator.

3) Print Error Information
This prints PostScript errors which occurred during printing. This setting can be changed only when [PostScript] is
selected in the [Output PDL] box.

4) Compress Bitmap
This sends the compressed bitmaps to this equipment. This setting is displayed only when the Universal Printer 2
printer driver is used. Also this setting can be changed only when [PostScript] is selected in the [Output PDL] box.

5) JPEG Compression
This sends compressed JPEG data to this equipment. This setting is displayed only when the Universal Printer 2
printer driver is used. Also this setting can be changed only when [PCL6] is selected in the [Output PDL] box.

6) Bold level
This adjusts the boldness level of characters. You can adjust the preferred level between 0.000 and 1.000. The default
value is “0.017”.
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2 PRINTING FROM WINDOWS

This option may have no effect on some fonts.

7) [Restore Defaults] n
Click this to restore the factory defaults on the [PDL Settings] tab.
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QO [Templates] tab

You can register print options that you frequently use as a profile. On the [Templates] tab you can save this profile in a
Template Button. Also you can display a dialog box for selecting Template Buttons automatically upon printing, enabling
easy printing with profiles.

P.28 “Setting up print options with Template Buttons”

Tip
To use a Template Button, you must first save a profile in this button. For instructions on how to save profiles, see the

following page:
P.25 “Setting print options using profiles”

= Printing Preferences @

‘ Basic I Finishing | Paper Handling | Image Quality | Effect | Dtharsl Ternplates
Copies| L 1

BW, Duplex, Staple &2inl

Mumber of Copi

Duplex &5taple

Duplex, Staple &2inL Duplex; Staple &Punch 2

Hw

Templates Dialag Box Edit...

aK ][ Cancel H Help

1) Number of Copies
This sets the number of copies. This can be set at between 1 and 999.

2) Template Button
Click this to apply the profile saved in a Template Button to each setting of the printer driver.
On the Template Button, the name of the profile saved and the print image of the job appear. 5 factory default profiles
below are saved in a Template Button. You can save up to 6 profiles, including 5 default ones.
- BW, Duplex, Staple & 2in1
- Color Booklet
- Duplex & Staple
- Duplex, Staple & 2in1
- Duplex, Staple & Punch

3) Templates Dialog Box
Select this check box to display the [Templates] dialog box automatically upon printing. You can select any of the
Template Buttons displayed on the [Templates] dialog box. This saves you the effort of opening the printer driver menu
and setting up profiles each time you print, in such cases as when you use profiles frequently.

4) [Edit]
This edits the Template Buttons. Click this to display the [Edit Templates] dialog box.
P.77 “Edit Templates”
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Edit Templates

You can edit the settings of the Template Buttons.

Edit Templates @
Profile: | Color Booklet - 1

Select Profile and Template which you want to edit
BW. Duplex, Staple 2:2inl Colar Bnant23 Duplex &:Staple

Save Delete m— 4

1) Profile
This selects the profile to be saved in a Template Button.

2) Template Button
This selects the Template Button to be edited.

3) [Save]
This saves the chosen profile in the selected Template Button.

4) [Delete]
This deletes the settings of the selected Template Button.

The print options registered in each profile are not deleted even if you click [Delete].
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Printing With Best Functions for Your Needs

In this section, procedures are given to print various types of print jobs, using the layout and finishing options. Read this
section before starting printing and select the procedure best suited for your needs.

3 P.78 “Printing various print job types”

P.90 “Layout and finishing options in [Basic] tab menu”

P.93 “Layout and finishing options in [Finishing] tab menu”

P.100 “Finishing options in [Paper Handling] tab menu”

P.103 “Finishing options in [Effect] tab menu”

P.108 “Using various types of paper”

P.110 “Switching equipment to print jobs”

P.111 “Splitting a print job across two pieces of equipment (Tandem Printing)”

H Printing various print job types

The printer drivers provide various ways to handle such jobs as Scheduled Print, Private Print, Hold Print, Proof Print,
Overlay Image file, Store to e-Filing, and Multiple Job Type.

P.78 “Printing scheduled print jobs”

P.80 “Printing private print jobs”

) P.81 “Printing hold print jobs”

P.82 “Printing proof print jobs”

P.83 “Creating an overlay file”

P.84 “Storing to e-Filing”

P.87 “Multiple Job Type”

Q Printing scheduled print jobs

The Print Scheduling feature allows you to specify the date and time to print your job. This is especially useful for delaying
your print job until the off-peak hours.

Time of the System and MFP should be the same.

Printing on a specified date and time

1 Display the [Basic] tab menu.
2 Select [Scheduled Print] in the [Print Job] box.

Print Job

Diiginal Faper Size

=3 [Leter (@ 1/211") -

1 Print Paper Sjze:

MNormal Print
Marmnal Print

’:“| ‘Same ag Driginal Size: - |
@& Private Print

Prroof Print Paper Source:

2 Hold Prirt % [a ]
+% Print to Overlay File Paper Type:
+38 Store o eFiing [Fen o)

*  Multiple Job Type Destingtion:

& [eiTiay B

3 Click [...] on the right of the [Print Job] box.
The [Scheduled Print] dialog box appears.

Click the arrow button at the [Date] box to display the Calendar window, and select the
desired date for your print job.

Scheduled Print [23al

Dats 510/2011 Time 19:18 ¥

4 ay, X b
May, 2011 I [

Cancel )

Sun Mon Tue Wed Thu Fri  Sat
12 3 4 5 6 71
g 9 112 13 14
15 16 17 19 20 21
2 13 M ]
2030 3 1 2 ER

[ Today: 5/10/2011
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oo ~NO

Select the [Time] box and click the spin button to change the time.

Scheduled Print @

Lse  [spzont ~| Ime  [H18 |

o) e

* To change the hour, select the hour number and click the spin button.
* To change the time, select the time number and click the spin button.

Click [OK].
Set any other print options you require and click [OK].
Click [OK] or [Print] to send the print job.

The document will be queued to be printed at the specified time and date.
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Q Printing private print jobs

When you want to print private documents, use this feature.

Printing confidential documents

1 Display the [Basic] tab menu.
2 Select [Private Print] in the [Print Job] box.

Print Job: Original Paper Size:

[Letter (2142511 |

1 Print Paper Size:

Marmal Print

Mormnal Print
Y _Schechied P Z) [smeasnighasie ]

Paper Source:

% ‘Auto - |
Paper Type:

|Piain |
estination:

a ‘ExitTlay Vl

Proof Print
2 Hold Print 2
% Print to Overlay File
+ Store to eFiing

- Muliple Job Type

Set any other print options you require and click [OK].

Click [OK] or [Print] to send the print job.
The print job is stored in the Private Print job list in the touch panel display.

5 Enter a password in the [Password] box and click [OK].

W

Private Print @

Please enter the password for private print. Acceptable number of characters are between 1 and B3,

Passuord  gessee [%

The print job is stored in the Private Print job list in the touch panel display.

* Enter a password using the alphanumeric characters and symbol characters (ASCII code characters
between 0x21 to Ox7E) in the [Password] box. The password must be between 1 and 63 characters.

* When you enter this password on the touch panel display, confidential documents will be printed. If you
forget it, you will not be able to print them.

Press the [PRINT] button on the control panel.
The print job list is displayed.

Select [PRIVATE] on the touch panel.
Tip
If the Private print job list is not displayed, select [PRIVATE] from the box of the job types.

8 Select the desired user name and press [OK].

Tip
When you enter the nickname for the [User name (Alias)] box on the [Others] tab, and send the job to the

equipment, its nickname will be displayed on the Private Print job list. If not, the user name that is entered to log
in to your computer will be displayed on the Private Print job list.
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10

Enter the password for the Private Print job, which has previously been set via the
computer, and then press [OK].
* When the user name that is entered to log in to your computer is used for [User name (Alias)]:
The displayed list contains the Private Print jobs for which the same password has been set.
* When the nickname is entered for [User name (Alias)]:
The displayed list contains the Private Print jobs for which the same nickname and the same password have
been set.

Select the desired job (desired document name) on the private print job list and press
[PRINT].

Q Printing hold print jobs

When you want to print Hold Print documents, use this feature.

Printing hold print documents

1
2

~N~Noor AW

Display the [Basic] tab menu.
Select [Hold Print] in the [Print Job] box.

Frint Jab:

Original Paper Size:

Noimal Frint Letter 8 1/2211") v
Marmal Print 1 Print Paper Size:
5 Scheduied Pint :“| |5ame as Driginal Sizs -
& Private Frint
Proaf Print Paper Source:
% ‘Auto v|

¥ Frint to Oy ol Paper Type:

|Piain |

A7 Storsta E-Fihngz
- Muliple Job Type Destination:

100% -
e e

Set any other print options as required and click [OK].

Click [OK] or [Print] to send the print job.
The print job is stored in the Hold Print job list in the touch panel display.

Press the [PRINT] button on the control panel.
Select [HOLD] on the touch panel.

Select the desired user name.

Tip
When you enter the nickname for the [User name (Alias)] box on the [Others] tab, and send the job to the

equipment, its nickname will be displayed on the Hold Print job list. If not, the user name that is entered to log in
to your computer will be displayed on the Hold Print job list.

Select the desired job on the Hold Print job list and press [PRINT].

Tips

* When the user name that is entered to log in to your computer is used for [User name (Alias)]:
The displayed list contains the Hold Print jobs which have been registered by the selected user.

* When the nickname is entered for [User name (Alias)]:
The displayed list contains all the Hold Print jobs which have been registered by users having the same
nickname.
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Q Printing proof print jobs

You can print out one proof copy as a trial first. This helps to prevent wasting paper. After you proof it, you are prompted to
specify whether you want to continue the print job or delete it.

When you want to print multiple copies, each of which is to be sent as an individual print job by your application, all the
copies, not just one copy, will be printed even if you set Proof Print. In such a case, print just one trial copy first, and
then specify the required number of copies on the touch panel display.

Printing a proof copy

1 Display the [Basic] tab menu.
2 Select [Proof Print] in the [Print Job] box.

Print Job:

Original Paper Size:

Ql [Letter [81/211") -

Marmal Print

Mormal Frint

Pt Paper Size
Y Scheduled Piint 1

=l ‘Same a3 Driginal Size vl
@ Frivate Frint

=M Hold Prirt !g
% Prit to Dverlay 2

Paper Source:

= [ -

Paper Type:

|F‘\a\n - |

@ Store to e-Filing
# Multiple Job Type Diestination:

o 15 [Esit Ty -

Set any other print options you require and click [OK].
Click [OK] or [Print] to send the print job.

One copy of the document is printed and remaining sets of job is stored in the Proof Job list in the touch panel
display.

W

Press the [PRINT] button on the control panel.
Select [PROOF] on the touch panel.
Select the desired job on the proof print job list and press [PRINT].

~NOoO O
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U Creating an overlay file

You can save up to 20 documents as overlay files using printer driver. You can print an overlay on the foreground or

background of a document. To do that, you must first create an overlay file.
P.106 “Printing with an overlay file” n

* If you save a multi-page document as an overlay file, only the first page of the document will be saved as an

overlay file.
* Both the overlay file and the documents on which you superimpose the overlay image must be created in the same

size, color mode, and orientation.

Printing a document as an overlay file

1 Display the [Basic] tab menu.
2 Select [Print to Overlay File] in the [Print Job] box.

Print Job: Original Paper Size:

[Letter (2142511 |

Print Paper Size:

Marmal Print

Marmal Print
L) Scheduled Print

& Private Frint

1 Y:“| ‘Sams as Driginal Size - |

Proaf Print Paper Source:

B Hold Print % At -
<57 Print to Overlay File Paper Tppe
+ Store to eFiing Blain -
% Multiple Job Type 2 Destinator:
100% -
+!
G J ‘EXItTla}l Vl

3 Click [...] on the right of the [Print Job] box.
The [Overlay Image Name] dialog box appears.

Enter an overlay image name and then click [OK].

Overlay Image Name ==

Dverlay Image Mame: W
[ 0K [[_Cancel ]

W2
You can enter up to 63 characters.

5 Set any other print options you require and click [OK].
6 Click [OK] or [Print] to send the print job.

The document is saved as an overlay file.

Tip
You can use a created overlay file when you want to print a document.
P.106 “Printing with an overlay file”
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0 Storing to e-Filing

The Store to e-Filing feature allows you to send print jobs to e-Filing on this equipment. The job stored to e-Filing can then
be printed from the touch panel display at a later time. It can be also composed with other documents using the e-Filing
web utility.

You can select either a [public] or [user] box to store print jobs. You can also specify a folder in which the print job is to be
stored in these boxes. The public box is shared by all users who can see the jobs stored in this box. User boxes are boxes
that users can create as desired. Access to user boxes can be restricted with a password.

* When the following paper sizes are selected for the originals or the print paper, [Store to e-Filing] is not available.
Additionally, when paper of those sizes is also included in a part of the documents, the printing job cannot be stored
in e-Filing either.

- Custom paper

- Non-standard size paper (bypass tray)
- IndexCard 3x5"

- Envelope - Com9

- Envelope - Com10

- Envelope - Monarch

- Envelope - DL

- Envelope - CHO3

- Envelope - YOU4

- Envelope - C5

* When you store a document in e-Filing using the printer driver, the printing image (not the original document in your
computer) will be stored in e-Filing.

* Documents stored in e-Filing are retained in the best image quality for printing. If you want to download them into
your computer in a higher image quality, scan the original documents and store them in e-Filing.

Tips

* You can manage the files within a box from the touch panel display. Refer to the e-Filing Guide to manage files in
a box.
* You can also manage the files within a box using the e-Filing web utility. Refer to the e-Filing Guide.

Saving a print job to a public box

1 Display the [Basic] tab menu.
2 Select [Store to e-Filing] in the [Print Job] box.

Print Job:

Qriginal Paper Sige:

[Letter (@ 14211 v

1 Print Paper Size:

Normal Print
Marmnal Print
L) Scheduled Print
&% Private Print
Praof Print

B Gamasligndsies -]

Paper Source:

= Hold Print % ‘Auto v|
+¥ Frint to Overlay File Paper Type:
|Piain |
#+  Multiple Job Typ 2 \estingtion
o0 4 e
+
G : ‘EXItTla}l Vl

3 Set any other print options you require and click [OK].
4 Select [Public Box].

Stare to e-Filing (230

Stare to: Pazsword:

000 Public Box
Box Folder

Frint

[ 0K, | | Cancel |
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5 When you specify a folder in which the print job is to be stored in a Public Box, enter
the folder name in the [Box Folder] box.

Store to e-Filing
Sitore to
000 Public Bo + |
Box Eolder:

Folder(
Erint

Password

[ ok

(.

==l

¢ |f the entered folder name is not found, a new folder is created under this box.
¢ Enter the folder name within 64 characters.
* If the number of folders has reached 100, you cannot create any more.

6 If you print the job as well as save it to the Public Box, select the [Print] check box.

7 Click [OK].

Click [OK] or [Print] to send the print job.
The print job is saved to the public box.

Saving a print job to a user box

1 Display the [Basic] tab menu.
2 Select [Store to e-Filing] in the [Print Job] box.

Print Job:

Qriginal Paper Sige:

Normal Print
Marmnal Print
4 Scheduled Print
& Private Print
Praof Print
= Hold Prirt

H Multiple Job Typ
100%

+%¢ Print to Dverlay File

[Letter (@ 14211 v

Print Paper Sjze:

N T

Paper Source:

% ‘Auto
Paper Type:

|Piain

-

Desfnaton:

a ‘ExitTlay

3 Set any other print options you require and click [OK].

Select a user box to save a print job and enter the password (maximum 20-digit) for the
user box in the [Password] box if required.

Stare to e-Filing

Stare to:
[muse x|
Box Folder:

Fiint

Pazsword:

5]
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5 When you specify a folder in which the print job is to be stored in a user box, enter the
folder name in the [Box Folder] box.

Stare to e-Filing =
Store to Password
[tussm  ~|  sewess
Box Eolder:

Folder(
Erint

T (.

¢ |f the entered folder name is not found, a new folder is created under this box.
¢ Enter the folder name within 64 characters.
* If the number of folders has reached 100, you cannot create any more.

6 If you print the job as well as saving to a box, select the [Print] check box.
7 Click [OK].
Click [OK] or [Print] to send the print job.

The print job is saved to the specified user box.
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QO Multiple Job Type

The Multiple Job Type feature allows you to combine any of Scheduled Print, Private Print, Hold Print, Proof Print, Proof
Private Print and Proof Hold Print, with Store to e-Filing.

For example, you can store a job in the specified e-Filing of this equipment and print it at the specified time by combining
Scheduled Print and Store to e-Filing.

To use the Multiple Job Type feature, click [...] on the right of the [Print Job] box and select the job types to be combined.

Before performing Scheduled Print, make sure the date and time of this equipment and your computer are the

same.

* When you print multiple copies, each of which is to be sent as an individual print job by your application, all of the

copies are printed even if you set Proof Print. In this a case, perform Proof Print of only one copy first, and then

change the number of copies on the touch panel to print the rest.

Documents stored in e-Filing are retained with the optimal image quality for printing. If you want to download them

into your computer with a higher image quality, scan the original documents and store them in e-Filing.

* When you store a document in e-Filing using the printer driver, it is stored as an image. This is not stored in e-Filing
in the same way as the original document is stored in your computer.

Tips

* You can manage files in e-Filing on the touch panel. For instructions on how to manage them, refer to the e-Filing
Guide.

* You can also manage files in e-Filing using the e-Filing web utility. For instructions on how to manage them with the
e-Filing web utility, refer to the e-Filing Guide.

Printing with the Multiple Job Type feature

1 Display the [Basic] tab menu.
2 Select [Multiple Job Type] in the [Print Job] box.

Prik Job: Original Paper Size:

Nermel Print - El [Letter g 122111 -
Hommel Fiint K il Paper Size:
Y Scheduled Pint
& Piivate Piint
Froof Frinl

Paper Source:

2| Hold Print % [euto -
W Frint to Dverlay File Paper Type:
+ Store to eFiing [Pan
B> Multiple Job Type Destingtion:
% 2 & (e -

3 Click [...] on the right of the [Print Job] box.
The [Multiple Job Type] dialog box appears.
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Select a job type in the [Print Job] box.
The setup screen is switched according to the selected job type.
* Set [Date] and [Time] if you select [Scheduled Print].

Multiple Jah Type

Print Job:

Stgre to e-Filing

000 Public Box

Scheduled Print =

Date Time

BT

[ snojeont -] [20:01

3

(

0K

)

[ Cancal | [

Help

* Enter a password if you select [Private Print] or [Proof Private Print].

Multiple Jah Type

Print Job:

Frivate Print e

Store to e-Filing

000 Public Box

Password

A

B

(

0K

)

Cancel | | Help

Enter a password using the alphanumeric characters and symbol characters (ASCII code characters

between 0x21 to Ox7E) in the [Password] box. The password must be between 1 and 63 characters.

* When you enter this password on the touch panel display, confidential documents will be printed. If you
forget it, you will not be able to print them.

5 If you want to store a print job in this equipment, select the [Store to e-Filing] check

box.

Multiple Jab Type

Print J ob:

Svate Pt T

WV N;tare to e-Filing
S

000 Public Box ~ |
Biow Falder.

Password

Password

oK

e |

Help

(==
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Select where the print job is stored at the [Store to] box.
» If you store the print job in a user box, enter a password if required.

Multiple Jab Type @

Frint J oby
Privvate Print e

Password

......
/| Stare ta e-Filing
Stare to: Password:
|0 Usert E ------ [%
Biow Falder: 1 2

[i[3 ] [ Cancal | | Hel |

When you specify a folder in which the print job is to be stored in the selected e-Filing,
enter its folder name in the [Box Folder] box.

Multiple Job Type [me3a]

Print Job

Frivvate Print b
Password

/| Stare o e-Filing
Store to: Password.

[oousemt =] eeeses
Box Folder

FolderD1 %

[ Hep |

Cancsl

* If the entered folder name is not found, a new folder is created in the selected e-Filing under this name.
¢ Enter a folder name within 64 characters.
» If the number of folders has reached 100, you cannot create any more.

8 Click [OK].
9 Cllck [OK] or [Print] to send the print job.

If you select [Scheduled Print], the job is printed at the specified date and time.

* If you select [Private Print] or [Proof Private Print], the job is stored in this equipment as a Private Print job. Print
this job on the touch panel.
P.80 “Printing private print jobs”

* If you select [Hold Print] or [Proof Hold Print], the job is stored in this equipment as a Hold Print job. Print this
job on the touch panel.
L3 P.81 “Printing hold print jobs”

* If you select [Proof Print], [Proof Private Print] or [Proof Hold Print], one sample copy is printed and the rest is
stored in this equipment as a Proof Print job. Print this job on the touch panel.
P.82 “Printing proof print jobs”

» If you select the [Store to e-Filing] check box, the print job is stored in the specified e-Filing.
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H Layout and finishing options in [Basic] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various printing
functions enabled with the [Basic] tab menu are explained.

P.90 “Fitting images within paper size”

1 P.91 “Printing color documents in gray scale”

3 P.92 “Printing color documents in twin colors”

Q Fitting images within paper size

You can automatically enlarge or reduce an image to fit into a specified paper size, or manually set the scale to enlarge or
reduce it. Also you can combine the desired paper size and reproduction ratio.

Printing enlarged or reduced image to fit the specified paper size

1 Display the [Basic] tab menu.

2 Select the document size on the [Original Paper Size] box. Then select the paper size
that you want to print at the [Print Paper Size] box.

Original Paper Size:

= [Letier B 12211 -

Piint Paper Size: 1 Image Scale:
it}

EL (Cegalmizzxiey vf :

The document image is automatically enlarged or reduced depending on the original paper size and print paper
size.

3 Set any other print options you require and click [OK].
4 Click [OK] or [Print] to send the print job.

The enlarged or reduced image is printed to fit the specified paper size.

Printing an enlarged or reduced image by specifying the scale manually

1 Display the [Basic] tab menu.
2 Check the [Image Scale] box. Then enter the scale.

Qriginal Paper Size:

=l [Leter@ 12211 -

Prirt Paper Sjze: 7| Image Scale:
= =[25-400)

Bl [same as niigna sies |§1 oo
2
The scale can be set from 25% to 400% in units of 1%.
3 Set any other print options you require and click [OK].
4 Click [OK] or [Print] to send the print job.

An enlarged or reduced image is printed in the specified scale.
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Combining a paper size and a reproduction ratio

You can combine the desired paper size and reproduction ratio, for example, printing an A5 original to A4 copy paper at a
reproduction ratio of 100%.

1 Display the [Basic] tab menu.
2 Select the document size on the [Original Paper Size] box. Then select the paper size
that you want to print at the [Print Paper Size] box.

Qriginal Paper Size:

=l [Leter@ 12211 -
Prirt Paper Size: 1 Image Scale
Bl (eggemsaza T o

The document image is automatically enlarged or reduced depending on the original paper size and print paper
size.

3 Check the [Image Scale] box. Then enter the scale.

Original Paper Size:

= |Letier (8142211 -

Piint Paper Size: 7| Image Scale:

EL [Cedgeartit a1z - 2| w400

The scale can be set from 25% to 400% in units of 1%.

Click [OK] or [Print] to send the print job.

4 Set any other print options you require and click [OK].
5 The image is printed on paper of the specified size at the specified reproduction ratio.

Q Printing color documents in gray scale

This equipment can print in color as well as black and white. The printer driver automatically detects whether the
document uses only color or only black and white, and it prints the document accordingly. Additionally, you can select the
black and white mode manually to print a color document in the gray scale to reduce the print cost and consumption of
color toners.

Printing a color document in gray scale

1 Display the [Basic] tab menu.
2 Select [Black and White] at the [Color] box.

_— Lalor:
[ Restore Defaults |
- W

Aulo k
Colar 1
T wir Color 2

3 Set any other print options you require and click [OK].

4 Click [OK] or [Print] to send the print job.
The print job is printed in the gray scale.
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Q Printing color documents in twin colors

This equipment can print in the twin color mode.
When the document is printed in the twin color mode, the black parts of the document are printed in black and the colored
parts of the document are printed in a specified color.

Printing a color document in twin color mode

1 Display the [Basic] tab menu.
2 Select [Twin Color] at the [Color] box.

LColor:

3
Auto k
Colar 1

Elack and ‘white

| Fisstore Defaults |

2
3 Click [Details].
The [Twin Color] dialog box appears.

Select a color in which the color parts of the document are to be printed at the [Color]
box and click [OK].

Twin Calar (=3

Select the calor you want to convert the non-black part of the docurnent.

LColor

WA,

LY

[ EIK[ ] | Cancel |

Set any other print options you require and click [OK].

Click [OK] or [Print] to send the print job.
The print job is printed in the twin color mode.

o O
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H Layout and finishing options in [Finishing] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various printing
functions enabled with the [Finishing] tab menu are explained.

P.93 “Sort printing”
L1 P.94 “Printing on both sides of a sheet”

3 P.94 “Making a booklet”

[ P.97 “Printing several pages on one sheet”

P.98 “Stapling”

P.99 “Dividing one image into multiple sheets (Poster Print)”

Q Sort printing

You can select how multiple copies of a document to be output, such as separately for each copy, and grouping each
page.

Sorting printed documents according to the copies

1 Display the [Basic] tab menu.
2 Enter the number of copies to be printed at the [Number of Copies] box.

Number of Copies 5 = (1999 |

3 Display the [Finishing] tab menu.
4 Select [Sort Copies] icon at [Copy Handling].

LN Ui

141

A

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are sorted according to the copies.

LCopy Handling: ‘

Sorting printed documents according to the pages

For example, assume that you have a three-page job (A, B, C) and you want three copies of each page in this order (AAA,
BBB, CCC).

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

Mumber of Copies: 5 = (1-333) |

3 Display the [Finishing] tab menu.
4 Select [Group Copies] icon at [Copy Handling].

9

123

A

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are sorted according to the pages.

Lopy Handling: ‘
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U Printing on both sides of a sheet

You can print on both sides of the paper.

Printing on both sides of paper

1 Display the [Finishing] tab menu.
2 Select the [2-Sided Printing] check box and select the direction to be printed.

/) 2-5ided Printing

[:ku;ﬂ%,
2

Long Edge — Select this to print on both sides of the paper with a margin on the long edge.
Short Edge — Select this to print on both sides of the paper with a margin on the short edge.

Tip
You can also set booklet printing at the [2-Sided Printing] option by selecting the [Booklet] icon. For instructions

on how to perform booklet printing, see the following section.
P.94 “Making a booklet”

3 Set any other print options you require and click [OK].
4 Click [OK] or [Print] to send the print job.

The print job is printed on both sides of paper in the specified direction.

0 Making a booklet

You can create a document in a book- or magazine-style publication by selecting the Booklet option.

For example, if you create a document on Letter-size paper (8% x 11 inches) and then print in booklet mode, the yield is a
5%-x-8Y2- inch booklet. Each page has been scaled to fit on half a sheet and reordered so that the booklet is properly
paginated when folded.
To retain your original document size when printing booklets, select the booklet size to be the same as your original
document size. Then your 5%2-inch document is printed on Letter-size paper (82 x 11 inches) and reordered so that, when
folded, the yield is a 5%2-x-8-inch booklet. You can select from the following page-size options when printing a booklet:

* A5 Booklet on A4

Creating a booklet

1 Display the [Finishing] tab menu.
2 Select the [2-Sided Printing] check box and select the [Booklet] icon.

/| 2-5ided Printing:

@mllm
N2

3 Click [Details].
The [Booklet Details] dialog box appears.
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4 Select the booklet size at the [Output Document Layout] box.

Booklet Details L&J
Output Document Layout:
Letter - Half an Letter -
Page Order
123, 321
O G
@ From Left ta Right Fram Right to Left
Margin
Center:
EENY =] inches (0.00 - 0.67)
Quter:
E3 o =] inches (0.17 - L17)
Units:
@ inch mm
Booklet without Center Margin
Restore Defaults

A5 on A4 — Select this to print an A5 size booklet. Every 2 pages are printed on A4 paper to fit on half a sheet
(A5).

B6 on B5 — Select this to print a B6 size booklet. Every 2 pages are printed on B5 paper to fit on half a sheet (B6).
1/2 Folio on Folio — Select this to print a 1/2 Folio size booklet. Every 2 pages are printed on Folio paper to fit on
half a sheet.

A6 on A5 — Select this to print an A6 size booklet. Every 2 pages are printed on A5 paper to fit on half a sheet
(AB).

Letter-Half on Letter — Select this to print a 1/2 Letter size booklet. Every 2 pages are printed on Letter paper to
fit on half a sheet.

1/2 LG on LG — Select this to print a 1/2 Legal size booklet. Every 2 pages are printed on Legal paper to fit on half
a sheet.

1/2 Statement on Statement — Select this to print a 1/2 Statement size booklet. Every 2 pages are printed on
Statement paper to fit on half a sheet.

1/2 13LG on 13LG — Select this to print a 1/2 13 inch LG size booklet. Every 2 pages are printed on 13 inch LG
paper to fit on half a sheet.

1/213.5" LG on 13.5" LG — Select this to print a 1/2 13.5 inch LG size booklet. Every 2 pages are printed on 13.5
inch LG paper to fit on half a sheet.

1/2 8.55Q on 8.5SQ — Select this to print a 1/2 8.5 inch SQ size booklet. Every 2 pages are printed on 8.5 inch SQ
paper to fit on half a sheet.

32K on 16K — Select this to print a 32K size booklet. Every 2 pages are printed on 16K paper to fit on half a sheet.
1/2 Executive on Executive — Select this to print a 1/2 Executive size booklet. Every 2 pages are printed on
Executive paper to fit on half a sheet.

1/2 (Custom) on (Custom) — Select this to print a custom paper size booklet. Every 2 pages are printed on
custom paper size paper to fit on half a sheet.

5 Select the page order for booklet in the [Page Order] option.

From Left to Right — Select this to print the pages from left to right.
From Right to Left — Select this to print the pages from right to left.

6 If you want to add a margin space between facing pages, enter a width in the [Center]
box, and if you want to add a margin on the outside edge, enter a width in the [Outer]
box.

* You can change the unit of the margin at the [Units].

¢ The center margin can be set from 0.00 inch to 0.67 inches in units of 0.01 inch when the unit is inches, and
from 0.00 mm to 16.90 mm in units of 0.10 mm when the unit is mm.
The printed images will be reduced according to the margin setting.

* The outer margin can be set from 0.17 inch to 1.17 inches in units of 0.01 inch when the unit is inches, and from
4.20 mm to 29.60 mm in units of 0.10 mm when the unit is mm.
The printed images will be reduced according to the margin setting.

Tip

If you select the [Booklet without Center Margin] check box, the value in [Center] becomes invalid and the
center margin becomes 0 mm (inches).

7 Click [OK] to close the [Booklet Details] dialog box.
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2 PRINTING FROM WINDOWS

8 Set any other print options you require and click [OK].
9 Click [OK] or [Print] to send the print job.

The print job is printed as a booklet.

Fold the printed document manually.
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U Printing several pages on one sheet

The N-up feature allows you to print several pages of a document on one sheet of paper. This feature is very useful for

browsing a large number of pages for appearance or page order.

For example, to check the navigation path of a number of web pages or review the narrative of a slide presentation, using n
N-up is not only convenient but conserves paper as well.

Tip

When [Overlay Image] is selected together with the N-up feature, the overlay images are printed per sheet, not per
page. If you want to print them on each page, select the [Print on Each Page] check box in [Overlay Image] on the
[Effect] tab.

[ P.55 “[Effect] tab”

Printing multiple pages per sheet

1 Display the [Finishing] tab menu.

2 Select how many pages you want to print on a single sheet at the [Number of pages per
Sheet] box.

Ol mm e 8 W
R2

2 pages — Select this to print images from 2 pages arranged on one sheet.
4 pages — Select this to print images from 4 pages arranged on one sheet.
6 pages — Select this to print images from 6 pages arranged on one sheet.
8 pages — Select this to print images from 8 pages arranged on one sheet.
9 pages — Select this to print images from 9 pages arranged on one sheet.
16 pages — Select this to print images from 16 pages arranged on one sheet.

3 Select how the pages are arranged on one sheet in the [Direction of print] option.

Es vy

Diraw Borders Around Pages

Left to Right — Select this to arrange pages horizontally from the left and printed top to bottom on one sheet.
Right to Left — Select this to arranged pages horizontally from the right and printed top to bottom on one sheet.
Left to Right by column — Select this to arrange pages vertically from the top and printed left to right on one
sheet.

Right to Left by column — Select this to arrange pages vertically from the top and printed right to left on one
sheet.

Tip
Items that can be selected in [Direction of print] may vary depending on the number of pages selected at the
[Number of pages per Sheet] box.

4 If you want to draw a line around each page, select the [Draw Borders Around Pages]
check box.

5 Set any other print options you require and click [OK].
Click [OK] or [Print] to send the print job.

Multiple pages are printed per sheet.
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Q Stapling

You can staple sets of paper to exit from the equipment.

Stapling is not available if a Finisher is not installed.

Stapling the paper

1 Display the [Finishing] tab menu.
2 Select the [Staple] check box. Select a stapling option.

V| Stapled

R ‘
2

Upper Left — Select this to staple the printed document at the upper left.

The selectable options vary depending on the paper size and orientation.

3 Set any other print options you require and click [OK].
4 Click [OK] or [Print] to send the print job.

The output is stapled for each copy.
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U Dividing one image into multiple sheets (Poster Print)

You can print one large image into more than one sheet of paper by dividing it. The divided images on the multiple sheets
of paper are then reconnected, so that you can create a large publication such as a poster.

* The Poster Print option is not available when any of the Custom Paper Size, Number of pages per sheet, 2-Sided
Printing, Watermark, Overlay Image and Sheet Insertion options is set.

* The Poster Print option is available only when any of the sizes below is selected for [Print Paper Size] on the
[Basic] tab.
A4, LT

Performing Poster Print

1 Display the [Finishing] tab menu.
2 Select the [Poster Print] check box and then click [Details].

| Poster Print Details... [
[%1 2

I 0k || Cancel || Help

The [Poster Print] dialog box appears.
3 Select the number of sheets on which the image is printed, and then click [OK].

Paster Print @

Output Humber of Sheets

1x2 @ 2n 33 A4

(]S [ Cancel |
-
4

1x2 — Select this to divide the image into 2 sheets.
2x2 — Select this to divide the image into 4 sheets.
3x3 — Select this to divide the image into 9 sheets.
4x4 — Select this to divide the image into 16 sheets.

* [1x2] is selectable only when A4 is selected for [Print Paper Size].

* When you use the Poster Print option, disable the [Do not Print Blank Pages] option on the [Others] tab. If
you use the Poster Print option while [Do not Print Blank Pages] is left ON, blank pages in the divided image
are not printed.

4 Set any other print options you require and click [OK].
Click [OK] or [Print] to send the print job.

The image is divided and printed into the specified number of sheets of paper.
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M Finishing options in [Paper Handling] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various printing
functions enabled with the [Paper Handling] tab menu are explained.

P.100 “Inserting different types of paper”

3 P.102 “Interleaving pages”

U Inserting different types of paper

You can insert a different type of sheet into a specified location in the printed documents. This is useful when you want to
add front and back covers, or sheets between chapters. Both printed and blank sheets can be inserted.

Printing or inserting a front cover and back cover

1 Display the [Paper Handling] tab menu.

To print or insert a front cover, select the [Use Front Cover] check box and select the
drawer where the cover paper is loaded at the [Source] box. Then select whether you
are inserting a blank cover or printed front cover at the [Print Style] box.

JJ /| Use Fropt Caver. %

aouce; Frint Sigle;

N

2 W3

Do not print on page — Select this to insert a blank front cover.
Print one side of the page — Select this to print the first page of the document on a front side of a cover.
Print both sides of page — Select this to print the first two pages of the document on both sides of a cover.

* When [Auto] is selected in the [Source] box, the paper is automatically selected according to the printed
document size.

* To insert thick paper, select Bypass Tray and set Thick for [Paper Type] for [Bypass Tray] in the [Drawer
Settings] dialog box of the [Device Settings] tab in the printer driver.

» [Print both sides of page] is available only when 2-Sided printing is enabled at the [Finishing] tab.

[auta = [t print on page

3 To print or insert a back cover, select the [Use Back Cover] check box and set the
[Source] and [Print Style] options that you require.

Source; 1 Pririt Shyle;

JJ /| Use Back Cover: % ‘

|Auto -k' ‘ |Do not print on pags 2 ‘

2 N3
How to set the Source and Print Style options is the same as for the [Use Front Cover] option.

4 To print or insert sheets between the pages, select the [Insert Pages] check box and
click [Edit].

JJ 7| Ingent Pages:
- e

1 [
é2

The [Insert Pages] dialog box appears.

Up to 50 pages can be inserted.
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5 Enter the page numbers to which you want to insert the sheet in each [Page] box and
select the [Print Style], [Paper Source], and [Paper Type] options as you require.

Insert Pages [_Ji:h
Page: Print Style: Paper Source: Paper Type:
Blank Auto Plain -
Blank Auto Plain
Blank Auto Plain
Blank Auto Plain
Elank Auto Plain
Blank Auto Plain
Blank Auto Plain
Blank Auta Plain
AT

6 Set any other print options you require and click [OK].

Click [OK] or [Print] to send the print job.

A front cover and back cover are inserted into the printed document.
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QO Interleaving pages

This feature is useful when you want to insert a different type of paper, or from another source, between every page of
your print job. For example, you could use this option to insert blank or color sheets between overhead transparencies.

Inserting sheets between every page of a print job

1 Display the [Paper Handling] tab menu.

To insert sheets between every page, select the [Interleave Pages] check box and
select the drawer where the desired paper is loaded at the [Source] box.
JfJJ 4| Interleave Pages: %

2OUCE; 1
[aua -

l§2

* When [Auto] is selected in the [Source] box, the paper is automatically selected according to the printed
document size.

* To insert thick paper, select Bypass Tray and set Thick for [Paper Type] for [Bypass Tray] in the [Drawer
Settings] dialog box of the [Device Settings] tab in the printer driver.

3 To print the previous page on interleaved sheets, select the [Duplicate] check box.
This equipment prints every previous page on interleaved sheets which are inserted after the page so that you can
duplicate a document.

4 Set any other print options you require and click [OK].

Click [OK] or [Print] to send the print job.
The sheets are interleaved between every page.
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H Finishing options in [Effect] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various printing
functions enabled with the [Effect] tab menu are explained.

P.103 “Printing with watermarks”
P.106 “Printing with an overlay file”

Q Printing with watermarks

Watermarks overprint your document with useful information, such as [TOP SECRET,] [CONFIDENTIAL,] [DRAFT,]
[ORIGINAL,] or [COPY.]. You can choose from several predefined watermarks or you can create and save your own
custom watermarks.

Watermarks are text only. To add graphics or other document elements, use image overlays instead.

Printing a watermark

1 Display the [Effect] tab menu.
2 Select the watermark to be printed at the [Watermark] box.

W atermark:

ﬂ Maone -
Hone 1

TOF SECRET

DR&FT
CORIGINAL 2

ﬂIIEDF'Y

You can create a new watermark if there is none you want to apply on the box.
P.104 “Creating or editing a watermark”

3 If you want to print the watermark on only the first page, select the [Print on First Page
Only] check box.

W atermark:
7| [conFIDENTIAL ~|

[ &dd. | [ Edt. | [ Delete |

J%F'lint on First Page Only

4 Set any other print options you require and click [OK].
Click [OK] or [Print] to send the print job.

The print job is printed with the watermark.
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Creating or editing a watermark

1 Click [Add] to create a new watermark, or select one that you want to edit and click
[Edit] to edit a watermark.

i atermark:

ﬂlNone -

[ add.

Frint on First Fage Only

The [Watermark] dialog box appears.
Watermark @

LCaptior:
ABCDEF

Font Hame, Sityle:

Aial +|  |Reguar =

Font Size:
72 21 pt(6-300)

Calor:

Gray - ‘ [ Browse...

Pasition Agle

1} - < r

3 Print Style

b @ Solid
Diraw az Outlineg
Transparency.

50 X 4 L
Restore Defaults | 1} 50 100

w
Kk + 2

o
=

Cancel

2 Enter the watermark text in the [Caption] box.

You can enter up to 63 characters for the [Caption] box. However, if too many characters are entered, the
watermark may not be printed correctly.

Select the position of the watermark in [Position].
Select the desired icon for the position.

Select a font for the watermark at the [Font Name] box.
Select a font style for the watermark at the [Style] box.

Enter the font size in the [Font Size] box.
You can enter any integer between 6 and 300pt in units of 1pt.

Select a color for the watermark at the [Color] box.
If your preferred color is not listed in the box, click [Browse] to display the color palette and add your color.

When [Black and White] is selected at the [Color] box on the [Basic] tab, the [Color] box is not available.

N ok~ W

8 To rotate the watermark, enter the number of degrees in the [Angle] box.

* You can enter from -90 degrees to 90 degrees in units of 1 degree in the [Angle] box.
* You can also set the angle using the scroll bar.

9 Select how the watermark text is printed from [Solid], [Draw as Outline], and
[Transparency].

Solid — Select this to print a solid type of watermark.

Draw as Outline — Select this to print an outline type of watermark.

Transparency — Select this for a transparent watermark. Set the transparent ratio from 0 to 100% in units of 1%.
You can also set the transparent ratio using the scroll bar.

1 0 Click [OK] to save the watermark settings.

The watermark is added or edited.
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Deleting a watermark

2
You can delete the default watermarks. However, they cannot be restored by clicking [Restore Defaults].

1 Select the watermark that you want to delete at the [Watermark] box.

W atermark:
ﬂ " atermark 0 v%
|
| aAdd.. | | Edit... | | Delgte 1
Print on First Page Only 2

Click [Delete].

The [Confirm Delete] dialog box appears.

3 Click [Yes].
Canfirm Delete @

Are you sure you want to delete it?

[ Tes % | Mo |

The watermark is deleted.
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Q Printing with an overlay file

Using image overlays ensures that widely-used images are readily available and consistently reproduced. Image overlays
are independent documents that are merged into other documents during printing and thereby increase the time required
to print a job. To superimpose text on your document, it may be faster to use watermarks.

To print with an overlay file, you must first create an overlay file.

P.83 “Creating an overlay file”

* When [Overlay Image] is selected together with the N-up feature, the overlay images are printed per sheet, not per
page. If you want to print them on each page, select the [Print on Each Page] check box in [Overlay Image] on the
[Effect] tab.

P.55 “[Effect] tab”

* Both the overlay file and the documents on which you superimpose the overlay image must be created in the same

size, color mode, and orientation.

Printing an overlay image as a print job

1 Display the [Effect] tab menu.

2 Select the overlay image name to be used in the [Overlay Image] box.

Overlay Image:

ﬂ ’None %v]
Hone 1

Multiple Owerlays:

Drverlapl2 2

If you use different overlay images for odd/even pages or use overlay images only for the specified pages,
select [Multiple Overlays] and set them in its dialog box.
P.59 “Multiple Overlays”

3 If you want to print the overlay image over the document, select the [Print Over the
Document] check box.
Overlay Image:
. |E|ver|ayD1

)
| Detais. | | Dglete%'

o | Print Ower the Document:

'z‘on Each Page

4 Set any other print options you require and click [OK].
5 Click [OK] or [Print] to send the print job.

* The print job is printed with the overlay image.
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Deleting an overlay image

1 Select an overlay image that you want to delete at the [Overlay Image] box.
Overlay Image:
ﬂ |Dver|a_l,ID'| N | n
| Detalz. | | Delete L§|1
Frint Ower ag =sprcument;

Frint on Each Hage

Click [Delete].

The [Confirm Delete] dialog box appears.

3 Click [Yes].
Canfirm Delete @

Are you sure you want to delete it?

[ Tes L\,% | Mo |

The overlay image is deleted.
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H Using various types of paper

This equipment allows you to print on various types of paper. The procedure below is for print jobs which require
precautions before you place the paper.
P.108 “Printing on paper larger than standard sizes”

0 Printing on paper larger than standard sizes

The procedure below is for printing on paper larger than standard sizes defined in the custom paper size setting.
(Example: Largest size: 8.50 x 52.00 inches (215.9 x 1320.8 mm))

Custom paper sizes can be defined in the [Other] tab menu.

[ P.65 “Custom Paper Size”

Printing on paper larger than standard sizes

1 Display the properties of the printer driver and select the custom paper size in [Print
Paper Size] of the [Basic] tab menu before starting printing.

Original Paper Sige:
H |Letter (8142 11" -|

Frint Paper Size: Image

='|] [Same a3 Driginal Size :] 100

13" LGB 12213 L%1 A
E85"5081/2:81/2"
% _I 16K (195 & 270mm)
= L 8K [270 = 390mm|]
| 320 % 450mm
| 320 % 460mm =
[0 Cuistom Paper 1
a |'| Eustnm Paper 2 [(3.50 % 'I'I.IZIIZI. 2
= Cusgtom Paper 2 [8.50 17,00 incds
Cuztom Paper 4 [8.50 « 11.00 inch)
Customn Paper 5 (850 % 11.000inch)  ~

Set any other print options you require and click [OK].
Click [OK] or [Print] to send the print job.

Place paper larger than the standard sizes on the bypass tray.

* Do not mix it with other sizes.
* Print one sheet by one from the bypass tray even if you have set the number of copies as more than one.

5 Press [JOB STATUS] on the touch panel.
The paper type selection screen on the [SUPPLY] tab appears.

LOON

Select the paper type corresponding to that of the placed paper.

Press the [START] button on the control panel.
* The print job is printed on paper larger than the standard sizes.
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Inserting from the bypass tray
When the paper is being fed into the equipment

* Do not mix paper of different sizes.
* Place one sheet at a time on the bypass tray even if you wish to print multiple copies.
» Slightly curl the paper. Hold it gently as it is being fed into the equipment.

* Be careful not to cut your fingers on the edge of paper when you hold it.
* Make sure that the trailing edge of the paper will not be fed into the equipment while you are holding it.

* The paper will be printed with a resolution of 300 dpi.

When the paper is coming out of the equipment

* Hold the paper gently as it is coming out of the equipment.

* Be careful not to cut your fingers on the edge of paper when you hold it.
* Do not pull out the paper forcibly as it is exiting from the equipment.
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H Switching equipment to print jobs

When more than one piece of equipment exists over a network, you can switch it to another one on the printer driver
menu.

If the equipment that you intended to use is busy with a large number of print jobs, for example, you can send your job to
another piece of equipment that is currently holding no print jobs and have it printed.

Switching equipment to print jobs

1 Display the [Others] tab menu.
2 Click [Output Devices].

| SMMF Communication

| Output Devices l':% | Add Printer

The [Output Devices] dialog box appears.
3 Select [Print Job to Selected Devices].

Output Devices @
Output Tatal Copies:
@ Print Job to Selected Devices 1
lit Jab across Selected Devices Auta

Selertedd Nevices:

TOSHIBA Universal Printer 2 v | - (1-999)
|None .| 1 - (1-999)
Abways Use This Setting [%
2
[ok [ cancel |[ Help |

4 Select the desired equipment in the [Selected Devices] boxes.

* You can select more than one piece of equipment in the [Selected Devices] boxes. In this case, the same
number of copies is printed from all of the pieces of equipment you selected.

* When you select the equipment in the [Selected Devices] boxes, make sure to select that which supports
features enabling all the print options of the job.
- Select equipment which enables stapling if the job needs that.

Tips

* If you select the [Always Use This Setting] check box, you can omit the setting of the [Output Devices]
dialog box from the next time.

* Equipment selected in the [Selected Devices] boxes must be registered in [Printer Folder]. If you want to
use equipment not registered in [Printer Folder], add it in [Add Printer] on the [Others] tab of printer driver.
P.65 “Add Printer”

5 Click [OK] to close the [Output Devices] dialog box.
6 Set any other print options you require and click [OK].
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Click [OK] or [Print] to send the print job.

A job is printed on the selected equipment.

 If the selected equipment does not support features enabling the print options of the job, printing may not be

performed properly.

* Department code confirmation for the selected equipment is not performed when the job is printed from the
selected one. If a department code specified in the [Department Code] box on the [Others] tab is not
recognized on it, Department Management for this print job is not performed.

H Splitting a print job across two pieces of equipment (Tandem Printing)

This feature splits one print job across two pieces of equipment to print it by means of copies.
If you have to print documents with a large number of pages in a large number of copies, for example, you can have two
pieces of equipment on a network share this job to print by copies simultaneously, so that it can be done in a shorter time.

Splitting a print job across two pieces of equipment (Tandem Printing)

1 Display the [Others] tab menu.
2 Click [Output Devices].

V| SMMP Communication

| Output Devices * | Add Printer

The [Output Devices] dialog box appears.
3 Select [Split Job across Selected Devices].

Output Devices @
Output Total Caopies:
Print Jab to Selected Devices 30
@ Split Job across Selected Devices Auta

SeleAy g Devices:

TOSHIBA Universal Printer 2 v| 10 = (1-999)

|TOSHIE.A Universal P53 v| 20 Iilu-ﬂﬂg)

Always Use This Setting %

[ QK ” Cancel || Help |

Select two pieces of equipment in the [Selected Devices] boxes and then specify the
number of copies for each one.

* If you select the [Auto] check box, the number of copies set in the [Total Copies] box is automatically and

equally allocated to two pieces of equipment.
* When you select the equipment in the [Selected Devices] boxes, make sure to select that which supports

features enabling all the print options of the job.
- Select equipment which enables stapling if the job needs that.

Tips
* If you select the [Always Use This Setting] check box, you can omit the setting of the [Output Devices]
dialog box from the next time.
* Equipment selected in the [Selected Devices] boxes must be registered in [Printer Folder]. If you want to
use equipment not registered in [Printer Folder], add it in [Add Printer] on the [Others] tab of printer driver.

P.65 “Add Printer”
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5 Click [OK] to close the [Output Devices] dialog box.
6 Set any other print options you require and click [OK].

Click [OK] or [Print] to send the print job.
A job is printed on the selected equipment.

» If the selected equipment does not support features enabling the print options of the job, printing may not be

performed properly.

* Department code confirmation for the selected equipment is not performed when the job is printed from the
selected one. If a department code specified in the [Department Code] box on the [Others] tab is not
recognized on it, Department Management for this print job is not performed.
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PRINTING FROM Macintosh

This chapter provides the instructions on how to print from a client computer.
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Printing From Application on Mac OS X 10.4.x to Mac OS X 10.8.x

Once you have installed the PPD file as described in “Installing the Printer on Mac OS X 10.4.x to Mac OS X 10.8.x” of the
Software Installation Guide, you can print directly from most of the Mac OS X applications.

B Considerations and limitations

If any double-byte character is included in the user name or document name when printing is performed, the printing
job is displayed with [OSX User] or [OSX Document] on the touch panel display of the equipment. The user name and
document name are displayed as they are only for one-byte characters.

The Cover Pages option of the Printer Features menu and the booklet printing cannot be used at the same time.

The Cover Pages option of the Printer Features menu and the N-up printing (multiple pages per sheet) cannot be used
at the same time.

The Cover Pages option of the Printer Features menu and the Cover Page option for sending a print job with a banner
page cannot be used at the same time.

The e-Filing function cannot be used together with Custom Paper Size, Magazine Sort, Twin Color, Printing in 600 x
1200 dpi, Hold Print, Proof Print, or Private Print.

To perform proof printing, private printing, hold printing, scheduled printing or e-Filing on Mac OS X 10.5, use LPR,
AppleTalk or Bonjour.

To perform proof printing, private printing, hold printing, scheduled printing or e-Filing on Mac OS X 10.6.x to Mac OS
X 10.8.x, use LPR or Bonjour.

To use the user authentication function on Mac OS X 10.4.x, perform the domain settings on [Applications] > [Utilities]
> [Directory Access] > [Services] > [BSD Flat and NIS].

To use the user authentication function on Mac OS X 10.5.x, perform the domain settings on [Applications] > [Utilities]
> [Directory Utilities] > [Services] > [BSD Flat and NIS].

To use the user authentication function on Mac OS X 10.6.x to Mac OS X 10.8.x, perform the domain settings on
[Accounts] > [Login Option] > [Network Account Server] > [Open the Directory Utility] > [Services] > [BSD Flat and
NIS].
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l How to print from Mac OS X 10.4.x to Mac OS X 10.8.x

You do not need to switch printers before starting printing because they are all managed under the setting of [Print & Fax]
of [System Preferences]. Once a printer is added to the Printer List, you can select any printer directly from the [Page
Setup] dialog box or the [Print] dialog box.

U Setting options and printing from Macintosh Computers
In Mac OS X applications, print options are set from both the [Page Setup] dialog box and the [Print] dialog box. n

Printing from Macintosh applications

1 Open a file and select [Page Setup] from the [File] menu of the application.

Select the name of the equipment in the [Format For] box and specify the Page Setup
settings for your print job.

Settings: | Page Attributes ?
Format For: | 157.69.73.250
TOSHIBA ColorMFP-X4

Paper Size: | A4 ?
20.99 by 29.70 cm

Orientation. ]L I:

Scale: 100 %
@ (Cancel ) (0K
Setting the Page Setup varies depending on how you want to print a document.
P.116 “Page Attributes”
3 Click [OK] to save the Page Setup settings.
4 Select [Print] from the [File] menu of the application.

In the dialog box that appears, make sure the name of the equipment is selected at the
[Printer] box and specify the Print settings for your print job.

Printer: [ 157.69.73.250 =)

Presets: | Standard ?l%

Copies: | 1 ECellated || Two-Sided

Pages @ Al
:;me 1 to: 1

Paper Size: | A4 ﬁ 20.99 by 29.70 cm
Orientation: 1 [} Tla

_ TextEdit ?

__| Print header and footer

(" cancel ) pe=Primi=—

Setting the Print Setup varies depending on how you want to print a document.
3 P.118 “Print dialog on Mac OS X 10.4.x to Mac OS X 10.8.x”

The [Print] dialog boxes vary depending on applications.
6 Click [Print] to print a document.

The content set in the [Print] dialog box can be saved as [Presets]. Select [Save as] in the [Presets] box and save it
under the desired name. If you use this preset content as a default setting, select it in the [Presets] box.

Printing From Application on Mac OS X 10.4.x to Mac OS X 10.8.x 115



l Page Setup dialog on Mac OS X 10.4.x to Mac OS X 10.8.x

The [Page Setup] dialog boxes can be displayed by selecting the [Page Setup] command from the [File] menu of the
application.

In the [Page Setup] dialog boxes, you can specify the Page Attributes settings and manage the Custom Page Size
settings.

The [Page Setup] dialog boxes vary depending on applications. In some applications, it is not included in the [File]
menu, but in the [Print] dialog boxes.

U Page Attributes
Settings: | Page Attributes ?
1 ————— Format For: [ 157.69.73.250 ]
TOSHIBA ColorMFP-X4
2 ——— PaperSize: | A4 ?
20.99 by 28.70 cm
3 ————— Orientation: Il li_
4 ——————— Scale: 100 %
./q\. (" Cancel ) (0Kk)

[

1) Format For
This selects the printer to be used for printing.
2) Paper Size
This selects the size of a document to be printed.
Available original paper sizes are listed below:

* A4 (210 x 297 mm) * 16K (195 x 270 mm)

e A5(148 x 210 mm) * 13.5"LG (8 1/2 x 13.5")

* B5 (182 x 257mm) * IndexCard (3 x 5")

* Folio (210 x 330 mm) » Executive (7 1/4 x 10 1/2")

* A6 (105 x 148mm) * Env-Com10 (4 1/8 x 9 1/2")

* Postcard * Env-Com9 (37/8 x87/8")

* Letter (8 1/2 x 11") * Env-Monarch (37/8 x7 1/2")

* Legal (8 1/2 x 14") * Envelope DL (110 x 220 mm)

» Statement (5 1/2 x 8 1/2") * Envelope Cho-3 (120 x 235 mm)

* 13"LG (8 1/2x 13") * Envelope You-4 (105 x 235 mm)

* 8.5"SQ (81/2x81/2") * Envelope-C5 (162 x 229mm)
Tip

Setup items differ depending on the model.

3) Orientation
This sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape (90 degree) — The document is printed in the landscape direction from left.
- Landscape (270 degree) — The document is printed in the landscape direction from right. This is selectable only
for Mac OS X 10.4.x.

4) Scale
This changes the size of the printed image on the page. Enter the zoom ratio to enlarge or reduce an image. You can
set any integer from 1 to 10000(%) for the zoom ratio. For Mac OS X 10.4.x, the acceptable range for zoom ratio is
from 25% to 400%.
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0 Custom Page Sizes
The PPD file for this equipment supports the Custom Page Sizes.

* When you print on paper larger than standard sizes, print one sheet at a time.
P.108 “Printing on paper larger than standard sizes”
* The paper sizes that can be set for the Custom Paper Size differ depending on the model to be used.

Creating Custom Page Size on Mac OS X 10.4.x to Mac OS X 10.8.x

1 Select [Manage Custom Sizes] in the [Paper Size] box.

12 x 18"
TG 13" LG (8 1/2 x 139
16K (195 x 270mm)
305 x 457mm
Settings 350 x 450mm b
320 x 460mm
Format For  8:5"5Q(81/2x81/2) '}
8K (270 x 390mm) |1
A3
Paper Size v A4
A5
Ag
B5 JIS
Computer (10 1/8 x 14")
Folio

-

Orientation

Scale

| Ledger
Statement (5 1/2 x 8 1/2")
)] US Legal F ok 3

US Letter

Manage Custom Sizes... k

The [Custom Page Sizes] dialog box appears. If Mac OS X 10.6.x to 10.8.x is used, the [Custom Paper Size] dialog
box appears.

9 Click [+].

Custom Paper Sizes

Paper Size:
Width Height

Non-Printable Area:

Left Right
Bottom
+ Duplicate
&) ( Cancel ) oK )

A new custom page size name is added to the list.

Tip
If you want to create a new custom page size by duplicating an existing custom page size, select the custom
page size name on the list and click [Duplicate].
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3 Double-click the added custom page size name on the list and rename the custom page
size.

Custom Paper Sizes

Custom0l Paper Size: 20.99 cm 29.7 cm
Width Height
Non-Printable Area

_ User Defined ?

0.63 cm
0.63 cm SR 0.63 cm
Left 145 cm Right
Bottom

+ | — | Duplicate

@ (" cancel ) oK

Enter the width and height in the [Paper Size] boxes, and select the printer name of this
equipment in the [Printer Margins] box.

Custom Paper Sizes

Custom01 Paper Size: 21.5cm 30 cm

Width % Height %
Non-Printable Area: 1 2
o

157.69.73.250

[042em %3

042cm|  TeP 0.42 cm
= 0.42 cm Righ

Bottom

+ | = | Duplicate
@ ( Cancel ) (0K
Tips

e If Mac OS X 10.6.x to 10.7.x is used, enter the width and height in the [Paper Sizes] box, and then select
your printer name in the [Non-Printable Area] box.

* Please use the margin settings that are automatically entered by selecting the printer name in the [Printer
Margins] box.

* You can delete the created custom page size by clicking [-].

5 Click [OK].

The Custom Page Size is saved and it can be selected in the [Paper Size] box in the Page Attributes menu.

M Print dialog on Mac OS X 10.4.x to Mac OS X 10.8.x

The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the application.

* The [Page Setup] dialog boxes varies depending on applications. In some applications, [Page Setup] may not be
included in the [File] menu, but in the [Print] dialog boxes.
* The layout of the setting items may vary depending on the type of your Mac OS.
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QO Copies & Pages

In the Copies & Pages menu, you can set general print options such as the number of copies, and sort printing.

Mac OS X 10.6.x

Printer: | 157.69.73.250 B0
Presets: | Standard ?
I 2
1 ———— Copies: 1 @Collated || Two-Sided
L
3 —— Pages: @ All ) ) ] ] 4
u From: |1 to: |1
Paper Size: | A4 ? 20.99 by 25.70 cm
Orientation: Il li_
TextEdit -+
|_|Print header and footer
( Cancel ) ( Print )
Mac OS X 10.8.x
Printer: | 10.151.130.181 K3
Presets: | Default Settings -_¢|
Copies: |1 Two-Sided 4
3 — Pages: (= All
(_JFrom: |1 to: |1
Paper Size: | A4 5| 210 by 297 mm
e [
Orientation: I’_i Iio
TextEdit =

Print header and footer

Rewrap contents to fit page

1) Copies

Cancel | | .Prim_'l

This sets the number of printed copies.

2) Collated

Select this check box for sort-printing (1, 2, 3... 1, 2, 3...)

3) Pages

This sets the range of pages to be printed.
- All — Select this to print all pages.
- Froml/to — Select this to specify the pages to be printed. Enter the page range in the From and to box.

4) Two-Sided

This sets two-sided printing. When you select this check box, [Long-Edge binding] is automatically selected in the

[Two-Sided] box in the

Layout menu. This is selectable only for Mac OS X 10.5.x to Mac OS X 10.8.x.
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O Layout

In the Layout menu, you can set N-up printing (multiple pages per sheet).

Printer: [ 157.69.73.250 i+ (4]
Presets: | Standard ?
Copies: |1 @Collated || Two-Sided
Pages: () All ) ) )
u From: |1 to: |1
Paper Size: | A4 ? 20.99 by 259.70 cm

Orientation: Il li_

| Layout ?
1 —— Pages per Sheet: | 1 ?
2 < dialtliin
3 Border: | None ?
4 Two-Sided: | Off -+
|_| Reverse page orientation ————on §

|_| Flip horizontally

(" Cancel ) (- Print—)

1) Pages per Sheet
This sets the number of multiple pages printed on one sheet. The pages are reduced to fit the selected paper size
automatically and are printed.
- 1 — Select this if you do not wish to enable N-up printing.
- 2 — Select this to print images from 2 pages arranged on one sheet.
- 4 — Select this to print images from 4 pages arranged on one sheet.
- 6 — Select this to print images from 6 pages arranged on one sheet.
- 9 — Select this to print images from 9 pages arranged on one sheet.
- 16 — Select this to print images from 16 pages arranged on one sheet.

2) Layout Direction

This sets how pages are arranged on one sheet. This is available only when N-up printing (printing multiple pages on

one sheet) is set.

- Across Left to Right Before Down — Pages arranged horizontally from left to right and then top to bottom on one
sheet.

- Across Right to Left Before Down — Pages arranged horizontally from right to left and then top to bottom on one
sheet.

- Down Before Across Left to Right — Pages arranged vertically from top to down and then left to right on one
sheet.

- Down Before Across Right to Left — Pages arranged vertically from top to down and then right to left on one
sheet.

3) Border
Select if a border line is to be drawn on each page.
- None — Select this if no border line is to be drawn.
- Single Hairline — Select this to draw a single hairline for the border.
- Single Thin Line — Select this to draw a single thin line for the border.
- Double Hairline — Select this to draw a double hairline for the border.
- Double Thin Line — Select this to draw a double thin line for the border.
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4) Two-Sided
This sets whether or not you want to print on both sides of the paper.
- Off — Select this when you do not want to print on both sides of the paper.
- Long-Edge binding — Select this to bind along the long edge side of the paper. The direction to be printed on the
back side of the paper differs depending on the orientation.

Portrait Landscape

- Short-Edge binding — Select this to bind along the short edge side of the paper. The direction to be printed on the
back side of the paper differs depending on the orientation.

Portrait Landscape

5) Reverse page orientation
This sets the paper exit orientation. When the orientation of the paper is reversed with this setting, the top of the paper
comes to the control panel side. This is selectable only for Mac OS X 10.5.x to Mac OS X 10.8.x.

6) Flip horizontally
Select this check box to perform mirror printing of a page.
This check box is displayed only for the Mac OS X 10.6.x to 10.8.x.

Q Scheduler

In the Scheduler menu, you can set when a print job will be sent to the equipment.

Printer: | 157.69.73.250 Bin
Presets: | Standard ?
Copies: |1 @Collated || Two-Sided
Pages: () All ) ) )
u From: |1 to: |1
Paper Size: | A4 ? 20.99 by 25.70 cm
Orientation: Il li_
| Scheduler ?
{4 ————————— Print Document: &) Now
O At
) on hold
2 Priority: | Medium ?

( cancel )  Print )

1) Print Document

This sets when a print job will be sent to the equipment.

- Now — Select this to send a print job now.

- At — Select this to specify the time to send a print job. Set the time to send the print job. The print job will be held
in the queue on Mac OS X until the specified time or until you resume the print job to be sent from the queue on
Mac OS X.

- On hold — Select this to hold a print job in the queue on Mac OS X. When you select this, the print job will be held
in the queue on Mac OS X until you resume the print job to be sent from the queue on Mac OS X.

2) Priority
Select the priority of a print job. If there are many print jobs, printing is performed from the job with the highest priority.
Four levels of priority are available: [Urgent], [High], [Medium] and [Low].
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O Paper Handling

In the Paper Handling menu, you can set Reverse page order printing and Odd or Even numbered page printing.

Mac OS X 10.4.x

Printer: | MFP_04998820 =
Presets: | Standard I
Paper Handling e
1 —— Page Order: @ Automatic Print: ) All Pages
) Normal ) 0dd numbered pages
2 ) Reverse ") Even numbered pages
3 ————— Destination Paper Size:

@ Use documents paper size: US Letter

ar

() Scale to fit paper size:

(O] PDF v . .__\' Preview ",I Cancel ",I ~ Print

1) Page Order
Select the page order for printing.
2) Print
Select whether to print all pages or only odd/even-numbered pages.
3) Destination Paper Size
Select the output paper size.
- Use documents paper size — Select this to print on the same-sized paper as the document size.
- Scale to fit paper size — Select this to perform enlarge/reduce printing. Selected, select the output paper size in
the box. If you do not want to enlarge the document images when a larger paper size is selected, select the [Scale
down only] check box.

Mac OS X 10.5.x

Printer: [ MFP_04998820 B!
Presets: | Standard |
| Paper Handling o {
Pages To Print: | All pages |
2
["1Scale to fit paper size
3 Page Order: | Automatic |

'/i'\ .___' PDF v '___. "_Pre\riew_\ Cancel f Print 3

1) Pages to Print
Select whether all pages will be printed or only odd/even-numbered pages will be printed.

2) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears as a default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. When this is selected, select
the output paper size in the box. If you do not want to enlarge the document images when a larger paper size is
selected, select the [Scale down only] check box.

3) Page Order
Select the page order for printing.
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Mac OS X 10.6.x

Printer: [ 157.69.73.250 I+ [«
Presets: | Standard m
Copies: .1 . @Collated | Two-5Sided
Pages: (= All . .
v From: |1 to: |1
Paper Size: | A4 m 20.99 by 29.70 cm

Orientation: Il I

Paper Handling 3
1 —————— Pages to Print: | All pages m
2 —————————— Page Order: | Automatic 5

|_|Scale to fit paper size

(" cancel ) Print—)

1) Pages to Print
Select whether all pages will be printed or only odd or even pages will be printed.

2) Page Order
Select the page order for printing.

3) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears as a default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. When this is selected, select
the output paper size in the box. If you do not want to enlarge the document images when a larger paper size is
selected, select the [Scale down only] check box.

Mac OS X 10.8.x

Printer: | 10.151.130.181

4>-| 4>-|

Presets: | Default Settings

Copies: |1 || Two-Sided
Pages: (&) All
( JFrom: |1 to: |1
Paper Size: | A4 +| 210 by 297 mm

Qrientation: 1@' Tlas

<>|

| Paper Handling

1 @Collate pages
2 ———  Pages to Print: | All pages s
3 Page Order: | Automatic 3

|| Secale to fit paper size
4 ———— Destination Paper Size: | Suggested Paper: A4

Scale down only

Cancel |

1) Collate pages
Select this check box for sort-printing (1, 2, 3... 1, 2, 3...)

2) Pages to Print
Select whether all pages will be printed or only odd or even pages will be printed.
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3) Page Order
Select the page order for printing.

4) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears as a default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. When this is selected, select
the output paper size in the box. If you do not want to enlarge the document images when a larger paper size is
selected, select the [Scale down only] check box.

O ColorSync

In the ColorSync menu you can adjust colors on the printouts.

This menu is displayed only for Mac OS X 10.4.x.

Printer: | MFP_04998820

Presets: ‘Standard

J::J:EJ;"_JE&J

ColorSync
1 ———— Color Conversion: | Standard
2 — Quartz Filter: = None =5
.\‘._-'. PDF w . -." Preview '_,. .__' Cancel '_,- { Print }

1) Color Conversion
Select the method for color management.
- Standard — Select this if you want the application you are using to control the color management of the printouts.
- In Printer — Select this if you want the printer you are using to control the color management of the printouts.

2) Quartz Filter
Select the presence of the Quartz Filter.
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QO Color Matching

In the Color Matching menu you can adjust the colors on the printouts.

This menu is displayed only for Mac OS X 10.5.x to Mac OS X 10.8.x.

Printer: | 157.69.73.250 i+ (4]
Presets: | Standard ?
Copies: | 1 @ Collated || Two-Sided
Pages: (&) All i i
v From: |1 to: |1
Paper Size: | A4 ? 20.99 by 29.70 cm

Orientation: Il I

Color Matching ?
(O] ColorSync Oin printer 2
3 Profile: | Automatic ?

Profile Unknown

(Cancel ) (- Print )
s T

1) ColorSync
Select this if you want the application you are using to control the color management of the printouts.

2) In Printer
Select this if you want the printer you are using to control the color management of the printouts.

3) Profile
Select a color profile to be applied if you selected [ColorSync].

0 Cover Page

In the Cover Page menu, you can set whether to send a print job with a banner page. The banner page includes
information about the job owner, job name, application name, date and time, and printer name.

Printer: [ 157.69.73.250 B
Presets: | Standard T]
Copies: |1 @ Collated || Two-Sided
Pages: @Al _
v From: |1 to: |1
Paper Size: | A4 ? 20.99 by 29.70 cm

Orientation: Il I

Cover Page B3

1 ——————— Print Cover Page: @ MNone
() Before document
() After document

2 -_ Lov ‘age 1y tandard

3 Billing Info: [

(" cancel ) Print—)
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1) Print Cover Page
You can set how to insert a banner page.
- None — Select this to print without a banner page.
- Before document — Select this to print a banner page before the document.
- After document — Select this to print a banner page after the document.

2) Cover Page Type
Select the type of the cover page.

3) Billing Info
Enter the billing information to have it appear on the banner page.

Due to Mac OS limitations, text input into the [Billing Info] box will only be displayed up to the length of the field.

Q Error Handling

This menu is displayed only for Mac OS X 10.4.x.

In the Error Handling menu, you can set how to report a PostScript error.

Printer: | MFP_04998820 o
Presets:  Standard a
Error Handling m
1 — POstSCript EFrors

® No special reporting
) Print detailed report

2 —ee Tray Switching

@ ( PDFw ) ( Preview ) (" cancel ) %

1) PostScript Errors
This sets whether to print a PostScript error report.
- No special reporting — Select this if you do not want to print PostScript error information.
- Print detailed report — Select this to print PostScript error information.

2) Tray Switching
This is not supported by this equipment.
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O Paper Feed

In the Paper Feed menu, you can set the paper source.

1)

2)

3)

Printer: [ 157.69.73.250 BID
Presets: | Standard ?
Copies: .1 . @Collated || Two-Sided
Pages: () All ) )
u From: 1 to: |1
Paper Size: | A4 ? 20.99 by 259.70 cm

Orientation: Il li_

Paper Feed ?

1 — @ Al pages From: Auto Select ?

u First Page From:

Remaining From:

S -
( Cancel ) ( Print )

All pages from
Select this when you want to use the same paper source for all pages. When this is selected, select the paper source
or paper type to be used at the box.

First Page From
Select this when you want to specify different paper sources for the first page and remaining pages. When this is
selected, specify the paper source or paper type to be used for the first page at the box.

Remaining From
Select the paper source or paper type to be used for remaining pages in the box. This can be selected only when you
choose the [First Page From] option button.
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0 Color Settings

In the Color Settings 1 and Color Settings 2 menus, you can adjust the color settings for printing.

This option is available only when your equipment is a multifunctional digital color system (color MFP).

Color Settings 1

Printer: | 10.151.130.181

<r| <r|

Presets: | Default Settings

Copies: |1 || Two-Sided
Pages: | g I Al
(_JFrom: |1 to: |1
Paper Size: | A4 +| 210 by 297 mm

Orientation: IE' LIPS

<>—|

| Color Settings 1

1 Color Type: | Color 3
2 Halftone: | Auto Ll
3 |_| Toner Save
4 Image Type: | General Ll
5 Black Overprint: | Text and Graphics Ll
6 || PostScript Overprint
7 Auto Trapping
8 Pure Black and Gray: | Black and Gray - Auto 3
9 Resolution: | 600 dpi =
10 Red Seal Color Mode

| Cancel | | Print |
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Color Settings 2

Printer: | 157.69.73.250 Bl8)
Presets: | Standard o ]
Copies: | 1 ™ Collated [ Two-Sided
Pages: @ Al
O From: 1 to: 1
Paper Size: | A4 (& ] 20.99 by 29.70 cm
Orientation: Il ll
Color Settings 2 o ]
11 ———— Color Balance
Cyan: 0 Magenta: 0
g g
Yellow: 0 Black: 0
g g
12 —————— Image Attribute
" |Use Sharpness Filter
Sharpness: (] Brightness: (]
0 v
Contrast: 0 Saturation: 0
g g

Background Adjustment: 0

A

£ =
S

1) Color Type
This sets whether to print a job in the color mode or the black mode.

- Auto — Select this to determine the color mode automatically. When a print job is a black and white document, the
system automatically prints the document in the black mode. When a print job is a color document, it prints the
document in the color mode.

- Color — Select this to print a document in the color mode.

- Mono — Select this to print a document in the black mode.

- Black and Red — Select this to print a document in the twin color mode with red. When this is selected, the black
parts of the document are printed in black and the color parts of the document are printed in red.

- Black and Green — Select this to print a document in the twin color mode with green. When this is selected, the
black parts of the document are printed in black and the color parts of the document are printed in green.

- Black and Blue — Select this to print a document in the twin color mode with blue. When this is selected, the black
parts of the document are printed in black and the color parts of the document are printed in blue.

- Black and Cyan — Select this to print a document in the twin color mode with cyan. When this is selected, the
black parts of the document are printed in black and the color parts of the document are printed in cyan.

- Black and Magenta — Select this to print a document in the twin color mode with magenta. When this is selected,
the black parts of the document are printed in black and the color parts of the document are printed in magenta.

- Black and Yellow — Select this to print a document in the twin color mode with yellow. When this is selected, the
black parts of the document are printed in black and the color parts of the document are printed in yellow.

- Black and White — Select this to print a document in the twin color mode with white. When this is selected, the
black parts of the document are printed in black and the color parts of the document are not printed.

2) Halftone
This sets how halftones are printed.
- Auto — Select this to print with proper halftone automatically depending on the contents in the document.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

3) Toner Save
Select this check box to print in the save mode.
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4) Image Type

This sets how colors are printed by selecting the job type. The printer driver automatically applies the proper image

quality to the selected job type.

- General — Select this when printing a general color document.

- Photo — Select this when printing photos.

- Presentation — Select this when printing a vivid document.

- Line Art — Select this when printing a document that contains a lot of characters or line art.

- Advanced Color Settings — Select this to apply a profile which can adjust the color space. For details, see the
following page:
3 P.132 “Advanced Color Settings”

5) Black Overprint
This set when to print background content that has black text overlaid on it. If this is enabled, the gap between the text
and the background is minimized and color deviation is prevented.
- Off — Select this so as not to print the background of the black content.
- Text — Select this to print all the full-color background and then the black text on a color background.
- Text and Graphics — Select this to print all the full-color background and then the black text and graphics on a
color background.

6) PostScript Overprint
Select this to overprint an object that has been set so on an application.

This option is selectable only when [Auto] or [Color] is selected in the [Color Type] box in the Color Settings 1
menu.

7) Auto Trapping
Select this to enable the Auto Trapping option. This is a technique where the size of objects is modified so that two
colors printed next to each other overlap slightly to avoid white spaces between them. These white spaces can be
caused by factors such as misregistration.

When this function is enabled, the printing speed may be slow.

8) Pure Black and Gray
Select whether to print the black and gray scale contents in a document using black toner.

- Off — Select this to print the document in the color mode.

- Black - Auto — Select this to automatically select areas to be printed using black toner when you want to print the
black contents using its toner. When this option is selected, the appropriate areas are printed using black toner
according to the Image Type option.

- Black - Text — Select this to print the black text using black toner.

- Black - Text and Graphic — Select this to print the black text and graphics using black toner.

- Black - Text, Graphic and Image — Select this to print the black text, graphics and images using black toner.

- Black and Gray - Auto — Select this to automatically select areas to be printed using black toner when you want
to print the black and gray scale contents using its toner. When this option is selected, appropriate areas are
printed using black toner according to the Image Type option.

- Black and Gray - Text — Select this to print the black and gray scale text using black toner.

- Black and Gray - Text and Graphic — Select this to print the black and gray scale text and graphics using black
toner.

- Black and Gray - Text, Graphic and Image — Select this to print the black and gray scale text, graphics, and
images using black toner.
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9) Resolution
This sets the resolution for printing.

600 dpi — Select this to print in 600 x 600 dpi.
600 x 1200 dpi — Select this to print in 600 x 1200 dpi.

When [600 x 1200 dpi] is selected, the functions below are not available.
- Booklet printing

- Automatic change of paper source

- Auto Trapping

10) Red Seal Color Mode
Select this check box to enhance color reproducibility of red seal (orient signature) printing.

11) Color Balance
Adjusts the density of each color for printing. You can set from -4 to 4.

This option is selectable only when [Auto], [Color], or [Black and Red / Green / Blue / Cyan / Magenta / Yellow /
White] is selected in the [Color Type] box in the Color Settings 1 menu.

12) Image Attribute
This sets the sharpness, brightness, contrast, saturation and background adjustment for printing.

Sharpness

Adjusts the sharpness for printing. You can set from -4 (softest) to 4 (sharpest) by moving the scroll bar when the
[Use Sharpness Filter] check box is selected.

Brightness

Adjusts the brightness for printing. You can set from -4 (darkest) to 4 (lightest) by moving the scroll bar.
Contrast

Adjusts the contrast for printing. You can set from -4 (lowest) to 4 (highest) by moving the scroll bar.

Saturation

Adjusts the saturation for printing. You can set from -4 (low clear) to 4 (high clear) by moving the scroll bar.
Background Adjustment

Adjusts the density level of the background. You can set from -4 (lightest) to 4 (darkest) by moving the scroll bar.
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Advanced Color Settings

The Advanced Color Settings menu is displayed when [Advanced Color Settings] is selected for the [Image Type] option in
the Color Settings 1 menu.

This option is available only when your equipment is a multifunctional digital color system (color MFP).

Tip
Advanced Color Settings can be set from the TopAccess menu. For detailed instructions on how to set Advanced Color
Settings from the TopAccess menu, refer to the TopAccess Guide.

Printer: [ 157.69.73.250 i+ (4]
Presets: | Standard ?
Copies: .1 . @Collated || Two-Sided
Pages: @ Al )
u From: |1 to: |1
Paper Size: | A4 ? 20.99 by 259.70 cm

Orientation: Il li_

Color Settings 1 ?

Source profiles
RGE:  SourceRGE_v10 ?
CMYK: | SourceCMYK_v10 R

3 M Apply to Device Color only

Destination profiles

4 ———— CMYK: | OutputCMYK_v10 ?

Rendering Intent

5 — O Perceptual @ Relative Colorimetric
(U saturation (U Absolute Colorimetric
;- - s

6 ——— [ Revert to defaults |

7

AT
. Use these settings |

( Cancel ) ( Print )

1) RGB Source profiles
This selects RGB source profile. When you obtained color profile data from this equipment, its RGB source profile data
appear.

2) CMYK Source profiles
This selects CMYK source profile. When you obtained color profile data from this equipment, its CMYK source profile
data appear.

3) Apply to Device Color only
Select this check box when you give priority to color profiles embedded in the image.

4) Destination profiles
This selects destination profile. When you obtained color profile data from this equipment, its destination profile data
appear.
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5) Rendering Intent
This selects an image processing method for color space conversion when you print.
- Perceptual — This is recommended for photo images.
- Relative colorimetric — More original colors can be retained than those when you select [Perceptual].
- Saturation — This is recommended when the vividness of colors is more important than their correct reproduction.
It is useful for graphic charts.
- Absolute colorimetric — Original colors can be retained even on colored paper.

6) [Revert to defaults] n
Click this to return the Advanced Color Settings to the defaults.

7) [Use these settings]
Click this to save the color profile data set for this equipment and return to the Color Settings 1 menu.

U Print Mode

In the Print Mode menu, you can set the way this equipment handles the print job. This menu allows you to enable various
job types such as Private Print, Proof Print and Hold Print.

Printer: | 157.69.73.250 i+ (4]
Presets: | Standard ?
Copies: | 1 @ Collated || Two-Sided
Pages: =) All ) ) )
u From: |1 to: |1
Paper Size: | A4 ? 20.99 by 29.70 cm

Orientation Ii li_

Print Mode ?
1 —————— [ |Department Code
2 —— | Normal ?
3 —————— [ Distinguish Thin Lines - Disabled | 3]
4 ———————— | Do not Print Blank Pages - Disabled ?

( Cancel ) ( Print )

1) Department Code
Select whether the entry of a department code is required or not for printing. Select this check box to enable this option
if this equipment is managed under department codes. When you do this, enter a department code in the box on the
right. For your department code, ask the administrator.

Tips

* Enter the department code using up to 63 characters.
* A department code must consist of one-byte characters such as numbers from 0 to 9, letters of the alphabet
from A to Z (in both capital and small ones), a hyphen (-), an underscore (_), and a period (.).
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2) Print Mode
This sets the type of print job.

Normal — Select this to print a job normally.

Proof — Select this to print the first copy of a multicopy job and then wait for approval before printing the remaining
copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are saved in the
proof job queue on this equipment, which are not printed until you activate printing from the touch panel display.
This option allows you to check the job’s output before printing the remaining copies and thereby reduce paper
waste.

Private — Select this to print a private job. When this is selected, specify the 5-digit password in the field next to
the box. The print job is saved in the private job queue on this equipment, and not printed until you activate printing
from the touch panel display of this equipment. This option is useful when you want to print a confidential document
secured with a password. The user has to enter the password to print the private job when activating printing from
the touch panel display.

Hold — Select this option to print a hold job. The print job, sent as a hold job, is saved in the hold job queue on this
equipment. To perform printing, select the desired job on the touch panel display and press [PRINT]. This option is
useful to prevent you from forgetting to remove printed sheets.

3) Distinguish Thin Lines
Select this check box to print thin lines clearly.

4) Do not Print Blank Pages
Select whether you require blank pages to be printed.

* When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the blank pages will be
printed.
* Pages with a header or footer will be printed even if the content is blank.

U Printer Features

In the Printer Features menu, you can set special printing features.

Finishing

In the Finishing menu, you can set the destination and stapling.

Printer: [ 157.69.73.250 BIE
Presets: | Standard I ]
Copies: 1 # Collated [ | Two-Sided
Pages: @ Al
O Erom: |1 to: 1
Paper Size: E 20.99 by 29.70 cm

Orientation: Ii‘ ES

ar

| Printer Features

Feature Sets: | Finishing ¥

————————— Destination: | Printer's Default |5 ]

Stapling: | Off

ar

£ - 2%
—
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1) Destination
This selects the destination tray.
- Printer’s Default — Select this to set the output to the default tray (that is set as such for raw jobs in the Printer
setting page of TopAccess Administrator’s page).
- Exit Tray — Select this to set the output to the exit tray of this equipment.
- Tray 1 — Select this to set the output to the tray of the Finisher.

S

Destinations selectable differ depending on the model and the option configuration.

* Depending on the equipment settings, the paper may be delivered to a tray that cannot carry out stapling when
[Printer’s Default] is selected as the [Destination] option.
* [Tray1] can be selected only when the Finisher is installed.

2) Stapling
This sets whether a print job is stapled.
- Off — Select this to print without stapling.

- Upper Left (Portrait) / Upper Right (Landscape) — Select this to staple on the upper left for a portrait document,
or on the upper right for a landscape document.

<TTT -

This option cannot be selected if a Finisher is not installed.

=\

:

TTTTTTTT

Booklet

In the Booklet menu, you can set booklet printing.

Printer: [ 157.69.73.250 i+ (4]
Presets: | Standard ?
Copies: .1 . @Collated || Two-Sided
Pages: () All ) ) )
u From: |1 to: |1
Paper Size: | A4 ? 20.99 by 259.70 cm

Orientation: Il li_

 Printer Features o 1

Feature Sets: | Booklet ?

a

Eooklet Paper Size: None (Off) ¥

@ Left to Right Page Layout

Booklet Centre Margin: 0 points ?

A OODN =

BEooklet Quter Margin: 0 points ?

( Cancel ) ( Print )

1) Booklet Paper Size
Select a paper size for the booklet. Both sides of a sheet are printed as two pages. The booklet size will be half the
size of the paper size that you specify.

2) Left to Right Page Layout
Select this check box to create a booklet that can be read from left to right.
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3) Booklet Center Margin
Select the width of the margin added to the center.

4) Booklet Outer Margin
Select the width of the margin added to the short edge side of a sheet.

Cover Pages

In the Cover Pages menu, you can set Front Cover printing and Back Cover printing.

This option menu cannot be set when the Cover Page option for sending a print job with a banner page is enabled.

Printer: [ 157.69.73.250 i+ (4]
Presets: | Standard ?
Copies: .1 . @Collated || Two-Sided
Pages: @ Al )
CFrom: 1 to: 1
Paper Size: | A4 ? 20.99 by 259.70 cm

Orientation: Ii li_

Printer Features )

Feature Sets: | Cover Pages ?

1 ————— || UseFront Cover
Source: | Auto (Default) ?

Print Style: | Do not print on page ?

2 —— | |Use Back Cover
Source: | Auto (Default) ?

Print Style: | Do not print on page ?

(cancel) (SRR
[ Cancel Print

1) Use Front Cover
This sets front cover printing which allows you to insert or print a cover on a sheet fed from a different drawer or the
bypass tray.
To enable cover printing, select this check box and select the location from where a cover sheet is to be fed and the
print style to be used.

Source
Select from where the cover sheet is to be fed. When [Auto (Default)] is selected, the paper is automatically selected
according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed in this equipment and
their configuration on the Paper Feed menu.

Print Style

This selects how to print the cover.

- Do not print on page — Select this to insert a blank cover.

- Print on page — Select this to print the first page image on the front side of a cover. When the Two-Sided Printing
option is enabled in the Layout menu, the first two page images are printed on both sides of a cover.

- Print on 1 side of the page — Select this to print the first page image on the front side of a cover. This is available
only when the Two-Sided Printing option is enabled in the Layout menu.

2) Use Back Cover
This sets back cover printing which allows you to insert or print a back cover on a sheet fed from a different drawer or
the bypass tray.
To enable back cover printing, select this check box and select the location from where a back cover sheet is to be fed
and the print style to be used.
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Source
Select from where the cover sheet is to be fed. When [Auto (Default)] is selected, the paper is automatically selected
according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed in this equipment and

their configuration on the Paper Feed menu. n
Print Style —

This selects how you want to print a back cover.

- Do not print on page — Select this to insert a blank back cover.

- Print on page — Select this to print the last page image on the front side of a back cover. When the Two-Sided
Printing option is enabled in the Layout menu, the last two page images are printed on both sides of a back cover.

- Print on 1 side of the page — Select this to print the last page image on the front side of a back cover. This is
available only when the Two-Sided Printing option is enabled in the Layout menu.

Quality

In the Quality menu, you can specify various image quality features.

This option is available only when your equipment is a multifunctional digital system (Black and White MFP).

Printer: | 157.69.73.250 B8]
Presets: | Standard ?
Copies: .1 . @Collated | Two-Sided
Pages: () All ) ) )
() Erom: |1 to: |1
Paper Size: = A4 ? 20.99 by 29.70 cm

Orientation: Il li_

| Printer Features ?
Feature Sets: | Quality ?
1 ——— Halftone: M
2 —— @Smoothing
3 ———— [ |Toner Save

( Cancel ) ( Print )

1) Halftone
This sets how to print halftones.
- Auto — Select this to print with proper halftone depending on the contents in the document automatically.
- Detail — Select this to print halftone in detail.
- Smooth — Select this to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the toner save mode.

When the toner save mode is enabled, printing may become light.
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Q e-Filing

In the e-Filing menu, you can send and store print jobs from your application to e-Filing on this equipment (hard disk). The
jobs stored to e-Filing can then be printed using the touch panel. You can select either a public or user box in which to
store print jobs. You can also specify a folder in which the print jobs are to be stored in these boxes. The public box is
shared by all users who can view the jobs stored in this box. User boxes are ones that users can create as desired.
Access to user boxes can be restricted with a password.

* This function is available only when the hard disk is installed in the equipment.
* For instructions on how to install the Plug-in file, refer to the Software Installation Guide.

Printer: [ 157.69.73.250 i+ (4]
Presets: | Standard ?
Copies: |1 @ Collated |_| Two-Sided
Pages: () All ) ) )
u From: 1 to: 1
Paper Size: | A4 ? 20.99 by 259.70 cm

Orientation: I L] ES

e-Filing ?

@ Store this document to e-Filing

N =

|_| Print the document

3 —————— Destination
Q

{# Public Box

& 001 - User01
& 002 - User02
& 003 - User03
& 004 - User04
& 005 - User05
& 006 - User06

5-digit password: .

Destination folder:

(Cancel) G
[ Cancel Print

1) Store this document to e-Filing
To store a print job in e-Filing, select this check box.

2) Print the document
If you want to print the job as well as saving it to a box, select this check box.

3) Destination
Select either the public box or a user box in which to store print jobs.

5-digit password
If a password is set in the user box, enter the 5-digit password.

Destination folder
When you specify a folder in which the print job is to be stored in a public or a user box, enter the folder name.

* Enter the folder name within 64 characters.
» If the number of folders has reached 100, you cannot create any more.
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O Watermark

In the watermark menu, you can overprint the document with useful information, such as [Confidential], [Draft], [Proof] and
[Top Secret]. You can choose from several predefined watermarks or you can create and save your own custom
watermarks. Watermarks consist of text only.

The watermark menu is displayed when the Plug-in file is installed in your Macintosh computer. For instructions on
how to install the Plug-in file, refer to the Software Installation Guide.

Printer: | 157.69.73.250 i+ (4]
Presets: | Standard ?
Copies: |1 @ Collated || Two-Sided
Pages: @ Al
u From: |1 to: |1
Paper Size: | A4 ? 20.99 by 29.70 cm

Orientation: Ii li_

Watermark ?
1 Text: 3
2 Font: | Helvetica ?
3 Size: |50 pt 3 8
4 Angle: [0 5
5 Color: | [} Black ?

—O—
6 ) print over the document (298 pt, 421 pt)
7 ———— (@ Print under the document
( Cancel ) ( Print
1) Text

Select the watermark. You can create a new watermark if there is none you want to apply on the box.

You can enter up to 63 alphanumeric characters. If too many characters are entered, the watermark may not be printed
correctly.

2) Font
Select the font to be used for the watermark text.
3) Size
Enter the font size for the watermark text.
The font size can be set from 6 to 300 pt in units of 1 pt. You can also set the font size by moving the scroll bar.
4) Angle
Enter the degree of the angle for rotating the watermark text. The angle can be set from 0 to 360 degrees in units of 1
degree. You can also set the degree of the angle by moving the scroll bar.

5) Color
Select the color of the watermark text.

When [Mono] is selected at the [Color Type] box in the Color Settings 1, the documents are printed with a shading of
gray instead of the selected color.

6) Print over the document
Select this to print the watermark text placed above everything.
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3 PRINTING FROM Macintosh

7) Print under the document
Select this to print the watermark text placed below everything.

8) Position
Adjust the position of the watermark by moving the scroll bars.

O Supply Levels

In the Supply Levels menu, the remaining toner and paper can be checked.

Printer: [ 157.69.73.250 BB
Presets: [Standard H
Copies: |1 ™ Collated [ Two-Sided
Pages: #) All

) From: |1 | to: |1 |

Orientation: M LES)

{ Supply Levels H

Black () [
cvan (© (I
Magenta ()
Yellow (v) [ —]

Waste Toner Ok
Drawer 1 (A4 Plain) E
Drawer 2 (B4-R Plain) O]
Drawer 3 (A3-R Plain) O]
Drawer 4 (BS Plain) E

Supply levels shown are approximate.

Caansl) )

O Summary

In the Summary menu, you can confirm the current settings for printing.

Printer: [ 157.69.73.250 B8
Presets: [Standard ”
Copies: |1 # Collated [ Two-Sided
Pages: @ All

O From: |1 to: |1
Paper Size: 20.99 by 29.70 em

Orientation: @

[ Summary H

Setting | Value |
b Copies & Pages
¥ TextEdit
P Layout
¥ Color Matching
P Paper Handling
b Paper Fead
b Cover Page
b Scheduler
P Print Mode
b Color Settings 1
b Color Settings 2
» e-Filing
b wartermark
I Printer Features

(Ganeel) Come)
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PRINTING FROM UNIX/Linux

This chapter provides the instructions on how to print from a UNIX/Linux workstation.
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Printing From Application

This section describes how to print from a UNIX/Linux workstation.

* When the User Management setting is enabled, a print job sent from UNIX/Linux workstations is processed as an
invalid job according to the User Authentication Enforcement setting. For more information about the User
Authentication Enforcement setting, refer to the TopAccess Guide.

» Before attempting to print from a UNIX/Linux workstation, make sure all the UNIX/Linux Filters are installed in your

workstation.

Tip

For instructions on how to install or set CUPS, refer to the Software Installation Guide.

B Considerations and limitations

* This equipment acts only as a filter and not as a complete driver. The size and order of the printed pages cannot be
modified.
* The UNIX/Linux filters do not support the following engine-supplied features:
- Enlarge/Reduce printing
- N-up printing
- Watermarks
- Cover Sheets
- Sheet Insertion
- Scheduled Print
- Print to Overlay File
- Store to e-Filing
- Use Overlay Image
* Linux uses the Iptap command to send a file to this equipment.
Since Ip is not supported in all versions of Linux, the Iptap command should be used instead.
* AIX supports printing using the gdaemon. This can be invoked by the user with the commands Ip, Ipr or gprt. In order
to use the filter, either Ip or gprt should be used.

M Printing using Ip command

Use the Ip command (Iptap in Linux) to send a file to this equipment for printing. This command specifies various printer-
specific options using the -o option parameter on the command line. The Ip command also sets other print options using
various other parameters. Use the “man net_estcolor” command to display the online document that describes the various
options and parameters that can be set to configure printed output.

All the options are sent to this equipment at the start of a print job so, if the print file contains its own commands, they may
override the Ip options.
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H Generic “Ip” and “Iptap” options

U How to print files

Enter the following “Ip” command to print files with the specified printer:
Ip -d <queuename> <filename>

U Copies

The number of copies of a print job is specified using the “-n <value>" parameter with the “Ip” command. The default value
is determined by the “Ip” command and it is always 1. The copies are always collated.

Q Title

The title that is printed on the banner page can be specified using the “-t <title>" parameter with the “Ip” command. The
default value is determined by the “Ip” command and it is often the name of the print file. If multiple files are printed using
the same “Ip” command the default title is set to the name of the first file by the “Ip” command.

H General options

The options below are applied to all print jobs that this equipment handles.

* Option commands are case sensitive and must be entered exactly as shown.
* Some printing functions may be disabled depending on the combinations of option commands because priority is
given to the specifications of this equipment over option commands.

QO Print Language

The “net_estcolor” program needs to know what printer language is used in each of the files that it is printing so that it can
issue the correct commands to select various options. The following options are valid for the print languages.

Option Value | Alternate Value Description

auto Each file to be printed is examined to see if it starts with
the “%!” sequence. If it does, then it is assumed that it is
a PostScript file, otherwise it assumes that it is a plain
text or a PCL6 file.

pcl The print file is always treated as a plain text or a PCL6
file.

postscript ps The file is always treated as a PostScript file.

raw The file is treated as a fully formatted file that already

contains all the necessary commands. The file is sent to
the printer without any modifications. In this mode no
other options are valid and a banner page is not printed.

All PCL5e jobs automatically send the “<esc>&k2G” command to convert the line-feed character into a carriage-return -
line-feed sequence. If the PCL5e job contains some of its own escape sequences it may override this setting.

The default print language is “auto”.

Example: The command to specify that a file is PostScript is “Ip -0 ps <filename>".
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Q Stapling

This sets whether a print job is printed with staples. When the optional Finisher is installed it can be activated using the
following option.

Option Value | Alternate Value Description
staple=0 Stapling is turned off.
staple=1 Staple in the top left corner of a portrait page and the
upper right corner of a landscape page.

If this option is not specified, the printer’s default value will be used.

Example: The command to staple in the upper left corner of a long edge feed portrait page is “Ip -o staple=1 <filename>".
The value for the stapling position depends on the paper size, the paper feed direction, and the print direction. This
function is not available for all paper sizes and the users should refer to the User’s Manual Basic Guide for a list of
compatible paper sizes. In particular, A5, A6 and statement paper sizes will not work with this function.

QO Output Bin

The output bin can be specified using the following options.

Option Value | Alternate Value Description
inner Select the inner tray.
bin1 Select the upper output tray of the Finisher.

If the Finisher is not installed in the equipment, the default output tray will be used (inner). If the Finisher is installed in the
equipment, the default output tray will be used (bin2).
Example: The command to specify output bin 1 is “Ip -0 bin1 <filename>".

O Media Type
The paper source can also be selected using the media type using the following option.
Option Value | Alternate Value Description
mtype=Plain A paper source that contains Plain paper is requested.
mtype= A paper source that contains transparency slides is
Transparency requested.
mtype=Thick1 A paper source that contains Thick1 paper is
requested.
mtype=Thick2 A paper source that contains Thick2 paper is
requested.
mtype=Thick3 A paper source that contains Thick3 paper is
requested.

In PostScript Deferred Media Selection is always turned on so the paper size has priority over the media type and the
paper source.

In PCL5e the paper size always has priority over the media type and the paper source.

If this option is not specified, the default value will be used.

Example: The command to specify Thick1 media type is “Ip -0 mtype=Thick1 <filename>".
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O Paper Source

The paper source can be selected using the following options.

Option Value

Alternate Value

Description

auto-source

Select auto paper tray selection.

manual Select Bypass Tray.
drawer1 upper Select the 1st drawer.
cas1
drawer2 lower Select the 2nd drawer.
cas2
drawer3 pedupper Select the 3rd drawer.
cas3
drawer4 pedlower Select the 4th drawer.
cas4
LCF Icf Select the Large Capacity Feeder. The Large Capacity

Feeder is not available for some countries or regions.

In PostScript Deferred Media Selection is always turned on so the paper size has priority over the paper source. In PCL5e
the paper size always has priority over the paper source.
If this option is not specified the command will not be sent so the printer’s default value will be used.

Example: The command to specify the Large Capacity Feeder paper source is “Ip - o Icf <filename>".

This function is available only when the paper source selectable in this equipment is specified.

U Duplexing
The current duplex mode can be specified using the following options.
Option Value | Alternate Value Description
simplex Turn duplexing off.
duplex Iduplex Turn duplexing on with long edge binding.
duplex_long
duplex=long
hduplex
sduplex duplex_short Turn duplexing on with short edge binding.
duplex=short
vduplex

If this option is not specified, the default value “simplex” will be used.
It is not necessary to specify duplexing for Booklet Mode (sduplex). Setting duplexing separately can override the booklet
mode setting for duplexing.
Example: The command to specify long edge duplexing is “Ip -o duplex <filename>".
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U Paper Size

The current paper size can be specified using the following options.

Option Value | Alternate Value Description

letter It Select Letter size paper.
LT

A4 a4 Select A4 size paper.

legal lg Select Legal size paper.
LG

statement st Select Statement size paper.
ST

folio folio-japan Select Folio size paper.

A5 a5 Select A5 size paper.

A6 a6 Select A6 size paper.

B5 b5 Select JIS B5 size paper.
b5-jis
B5-JIS

legal13 Ig13 Select LG13inch size paper.
LG13

sq85 letter-square Select SQ8.5inch size paper.

postcard Select Postcard size paper.

16K 16k Select 16K size paper.

13.5” Legal 1g13.5 Select LG13.5inch size paper.
19135
LG135

Executive exec Select Executive size paper.
EXEC
executive
EXECUTIVE

IndexCard Select IndexCard size paper.

If this option is not specified, the printer’s default value will be used.
Example: The command to specify the A4 paper size is “Ip -0 a4 <filename>".

U Printing Modes

The printing mode can be selected using the following options.

Option Value | Alternate Value Description
normal Process as a normal print job.
hold Process as a hold print job.
proof Process as a proof print job.
private=din Process as a private print job. The din is up to a 63-digit
(between 1 to 63) password.

If this option is not specified, the printer’s default value will be used.

A private printing job requires the user to enter a maximum number of 63 character long string.
Character lengths longer than 63 will be clipped to 63.

The following characters are invalid, but no type checking is carried out.
()< ~@# %!
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U Department Code

The department code can be set using the following option.

Option Value

Alternate Value

Description

dept=code

Set the department code. A department code within 63
characters comes in [code].

A department code is specified within 63 characters.
If the entered department code is longer than 63 characters, it is clipped to 63 characters when a job is sent.
The following characters are invalid for department codes:

"&r(); <>

Tips

@#%*!

* How the equipment performs printing for an invalid department code print job, for which an invalid department code
is specified, varies depending on the Invalid Department Code Print Job setting that can be set in the TopAccess
Administrator mode and whether SNMP communication is enabled or not.
- When SNMP communication is enabled and Invalid Department Code Print Job is set to [Store to invalid job

list], an error message will be displayed when an invalid department code is entered.
- When SNMP communication is disabled and Invalid Department Code Print Job is set to [Store to invalid job

list], the invalid department code print job will be stored in the invalid department code print job list without

printing.

- When the Invalid Department Code Print Job is set to [Print], the invalid department code print job will be

printed.

- When the Invalid Department Code Print Job is set to [Delete], the invalid department code print job will be

deleted.

* For the appropriate department code, ask your system administrator.

U Distinguish Thin Lines

This sets whether to distinguish thin lines or not. This mode can be set using the following option.

Option Value | Alternate Value Description
thinlinelimit=on ON Set the thin line limit mode.
thinlinelimit=off OFF Cancel the thin line limit mode.

Example: The command to set the thin line limit mode is “Ip -o thinlinelimit=on <filename>".

U Do Not Print Blank Pages

This sets whether or not a blank page is printed. This mode can be selected using the following option.

Option Value | Alternate Value Description
blankpage=0 Set the blank page mode (disable Do not Print Blank
Pages).
blankpage=1 Cancel the blank page mode (enable Do not Print Blank
Pages).

Example: The command to set the blank page mode is “Ip -0 blankpage=0 <filename>".

0 Toner Save

The toner save mode can be set using the following option.

Option Value | Alternate Value Description
tonersave=on ON Set the toner save mode.
tonersave=off OFF Cancel the toner save mode.

Example: The command to set the toner save mode is “Ip -0 tonersave=on <filename>".
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U Booklet Modes

The booklet mode can be selected using the following options.

The booklet mode applies only for the PostScript data. Performing the booklet printing using the PCL data is invalid.

Option Value | Alternate Value Description

booklet=letter It Select Letter size paper for the booklet printing mode.
LT

booklet=A4 a4 Select A4 size paper for the booklet printing mode.

booklet=legal lg Select Legal size paper for the booklet printing mode.
LG

booklet= st Select Statement size paper for the booklet printing

statement ST mode.

booklet=folio folio-japan Select Folio size paper for the booklet printing mode.

booklet=A5 a5 Select A5 size paper for the booklet printing mode.

booklet=B5 b5 Select JIS B5 size paper for the booklet printing mode.
B5-JIS
b5-jis

booklet=legal13 1913 Select Legal-13 size paper for the booklet printing
LG13 mode.

booklet=SQ85 sq85 Select 8.5 inch square size paper for the booklet
letter-square printing mode.

booklet=16K 16k Select 16K size paper for the booklet printing mode.

In a job, if this value is LT, and in PDL too the data are for LT paper size, this will result in a scaled booklet on Letter paper.
In a job, if this value is A4, and in PDL the data are for A5 paper size, this will result in a tiled booklet on A4 paper.

When the Booklet Mode options is selected, the paper size is automatically set to the same size as for Booklet Mode. This
function is only available for A4 and Letter paper sizes.

If the booklet mode is selected, then duplexing is also selected automatically (sduplex). Setting duplexing separately can
override the booklet mode setting for duplexing.

Example: The command to select Letter size paper for the booklet printing mode is “Ip —o booklet=letter <filename>".
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0 Page Layout

The booklet mode page layout can be selected using the following options.

Option Value | Alternate Value Description

left2right=off OFF Select right to left page layout for the booklet printing
mode.
This value decides the layout of the pages in the
booklet.
If this value is OFF then the layout of pages is Right to
Left as shown in the figure below.

left2right=on ON Select left to right page layout for the booklet printing

mode.

This is the default setting.

If the value is ON then the layout of the pages is from
Left to Right as shown in the figure below.

If left2right=off then long edge binding is selected, otherwise if left2right=on then short edge binding is used.
Example: The command to select left to right page layout for the booklet printing mode is “Ip -o left2right=on <filename>".

O Center Margin

The booklet mode center margin can be selected using the following options.

Option Value

Alternate Value

Description

centermargin
=value

Select the center margin value for the booklet printing
mode.

This value specifies in pixels the Center Margin or the
“Gutter”. This is in addition to the center margin already
specified by the application. The valid range for value is
0 - 300. Default is 0.

Example: The command to select the center margin value for the booklet printing mode is “Ip -o centermargin=value

<filename>".

O Outer Margin

The booklet mode outer margin can be selected using the following options.

Option Value

Alternate Value

Description

outermargin
=value

Select the outer margin value for the booklet printing
mode.

This value specifies in pixels the Outer Margin or the
“Creep” per page, which should take place while
printing a booklet. The valid range for value is 0 - 600.
Default is 0.

Example: The command to select the outer margin value for the booklet printing mode is “Ip -0 outermargin=value

<filename>".
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Q Collate

The collate option can be selected using the following options.

Option Value | Alternate Value Description
collate=off OFF Cancel the collate printing mode.
collate=on ON Set the collate printing mode.

f this option is not specified, the default value of “collate=on” will be used.
Example: The command to select collate off is “Ip -o collate=off <filename>".

QU Orientation

The following orientation options are available.

Option Value | Alternate Value Description
portrait Print the document in portrait orientation.
landscape Print the document in landscape orientation.

If this option is not specified the command will not be sent so the printer’s default value will be used.
Example: The command to specify landscape orientation is “Ip -o landscape <filename>".

U Font Pitch

If the pitch is specified the net_estcolor program will always select the Courier font; otherwise the default font is used. The
following options are used to select the font pitch.

Option Value | Alternate Value Description
c pitch=16.67 Set the character pitch to 16.67 characters per inch.
10 pitch=10 Set the character pitch to 10 characters per inch.
12 pitch=12 Set the character pitch to 12 characters per inch.
pitch=value Set the character pitch to value characters per inch.

In all the cases shown above the Courier font will also be selected. When the pitch is changed, the font size will
automatically be scaled to the appropriate size.

If this option is not specified, the default pitch and font will be used.

Example: The command to specify 8 characters per inch is “Ip -o pitch=8 <filename>".

U Page Length

The number of lines to print on a page can be specified with the following option.

Option Value | Alternate Value Description

pl=value Set the lines per page to value.

As this equipment is a page printer we cannot change the physical length of a piece of paper so the actual effect of this
command is to after the value for lines per inch so that the requested number of lines is printed on the page. The actual
page length may differ from this value if the top margin or the text length option is used.

If this option is not specified the PJL command will not be sent so the printer’s default value will be used. The minimum
page length allowable is 5. If value is less than 5, the page length is set to 5.

The command to specify 66 lines per page is “Ip -o pl=66 <filename>".
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Q Color Mode

This sets whether a print job is printed in color, mono, or twin color. The color mode for printing mode can be selected

using the following options.

Option Value | Alternate Value Description
colormode= color Set color mode printing for the print mode.
COLOR
colormode= grayscale Set grayscale mode printing for the print mode.
GRAYSCALE
colormode= auto Set auto color mode printing for the print mode.
AUTO
colormode= 2kr Set twin color mode (Black and Red) printing for the
2KR print mode.
colormode= 2kg Set twin color mode (Black and Green) printing for the
2KG print mode.
colormode= 2kb Set twin color mode (Black and Blue) printing for the
2KB print mode.
colormode= 2kc Set twin color mode (Black and Cyan) printing for the
2KC print mode.
colormode= 2km Set twin color mode (Black and Magenta) printing for
2KM the print mode.
colormode= 2ky Set twin color mode (Black and Yellow) printing for the
2KY print mode.
colormode= 2kw Set twin color mode (Black and White) printing for the
2KW print mode.

Example: The command to set the color mode for the print job is “Ip -0 colormode=COLOR <filename>"

This function is enabled only when your equipment is a multifunctional digital color system (color MFP).

QO Pure Black and Pure Gray

This sets whether printing the black and gray scale contents in a document using the black toner. This mode can be
selected using the following options.

Option Value

Alternate Value

Description

pureblackgray=0

Disable the black toner printing of the black and gray
scale contents.

pureblackgray=1

Enable the black toner printing of the black contents.

pureblackgray=2

Enable the black toner printing of the black and gray
scale contents.

Example: The command to set the pure black and pure gray mode for the print job is “Ip -o pureblackgray=1 <filename>"

This function is enabled only when your equipment is a multifunctional digital color system (color MFP).
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O Image Quality Type

The Image Quality Type can be selected using the following options.

Option Value | Alternate Value Description

ignormal Set the proper image quality for printing a general color
document.

igphoto Set the proper image quality for printing photos.

igpresen Set the proper image quality for printing a vivid
document.

iglineart Set the proper image quality for printing a document
containing a lot of characters or line art.

Example: The command to set the normal quality type for the print job is “Ip -0 ignormal <filename>"

This function is enabled only when your equipment is a multifunctional digital color system (color MFP).

O Halftone
This sets the appropriate processing on halftone images. The halftone can be selected using the following options.
Option Value | Alternate Value Description
halftone=AUTO Set the proper halftone depending on the contents in
the document automatically.
halftone=DETAIL Set the halftone in detail.
halftone= Set the halftone smoothly.
SMOOTH

Example: The command to set the auto halftone for the print job is “Ip -o halftone=AUTO <filename>"

U Black Overprint

This sets whether to print background content that has black text overlaid on it. If this is enabled, the gap between the text
and the background is minimized and color deviation is prevented. This mode can be selected using the following options.

Option Value | Alternate Value Description
blackoverprint=0 Disable the black over print mode.
blackoverprint=1 Enable the black over print mode.

Example: The command to set the black overprint mode for the print job is “Ip -o blackoverprint=1 <filename>"

This function is enabled only when your equipment is a multifunctional digital color system (color MFP).
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QU Color Balance

The Color Balance can be selected using the following options.

Option Value | Alternate Value Description

CBC=value Specify the color density of cyan toner. You can specify
the following values:
-4,-3,-2,-1,0,1,2,3,4

CBM-=value Specify the color density of magenta toner. You can
specify the following values:
-4,-3,-2,-1,0,1,2,3,4

CBY=value Specify the color density of yellow toner. You can
specify the following values:
-4,-3,-2,-1,0,1,2,3,4

CBK=value Specify the color density of black toner. You can specify

the following values:
-4,-3,-2,-1,0,1,2,3,4

Example: The command to set “1” to the color balance for black toner for the print job is “Ip -0 CBK=1 <filename>"

This function is enabled only when your equipment is a multifunctional digital color system (color MFP).

O Image Attributes

The Image Attributes can be selected using the following options.

Option Value

Alternate Value

Description

brightness=value

Specify the brightness. You can specify the following
values:
-4,-3,-2,-1,0,1,2,3,4

contrast=value

Specify the contrast. You can specify the following
values:
-4,-3,-2,-1,0,1,2,3,4

saturation=value

Specify the saturation. You can specify the following
values:
-4,-3,-2,-1,0,1,2,3,4

sharpness=value

Specify the sharpness. You can specify the following
values:
-4,-3,-2,-1,0,1,2,3,4

backgroundadjus
tment=value

Specify the background adjustment. You can specify
the following values:
-4,-3,-2,-1,0,1,2,3,4

Example: The command to set “1” to the brightness for the print job is “Ip -0 brightness=1 <filename>"

This function is enabled only when your equipment is a multifunctional digital color system (color MFP).
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l PCL5e specific options

Some of the options only apply to plain text or PCL5e files.

0 Text Wrapping

The following options control text wrapping when it reaches the right margin.

Option Value | Alternate Value

Description

wrap

Enable automatic text wrapping.

nowrap

Disable automatic text wrapping.

If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to specify wrapping is “Ip -o wrap <filename>".

U Left Margin

The left margin position can be specified with the following option.

Option Value | Alternate Value Description

Im=value

Set the left margin to value columns.

If the left margin is set to the right of the right margin it will be ignored.
If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to set the left margin to five columns is “Ip -0 Im=5 <filename>".

QO Right Margin

The right margin position can be specified with the following option.

Option Value | Alternate Value Description

rm=value

Set the right margin to value columns.

If the right margin is set to the left of the left margin, or if it is set to a position wider than the logical page, it will be ignored.
The right margin is specified in columns from the left margin. A negative value will be ignored.

If this option is not specified, the command will not be sent so the printer’s default value will be used.

Example: The command to set the right margin to fifty columns is “Ip -0 rm=50 <filename>".

O Top Margin

The top margin position can be specified with the following option.

Option Value | Alternate Value Description

tm=value Set the top margin to value lines.

If the top margin is set too high or too low, part of the text may not appear due to the printer’s unprintable region. The top
margin will be ignored if it is set to a value greater than the printer’s logical page length. Setting this value may affect the
number of lines specified using the page length option.

If this option is not specified, the command will not be sent so the printer’s default value will be used.

Example: The command to set the top margin to ten lines is “Ip -o tm=10 <filename>".

U Text Length

The text length can be specified using the following options.

Option Value | Alternate Value Description

tl=value Set the length to value lines.

If the text length is set too high, part of the text may not appear due to the printer’s unprintable area. The text length will be
ignored if it is set to a value greater than the printer’s logical page length minus the top margin. The text length is specified
in rows from the top margin. Setting this value may affect the number of lines specified using the page length option.

If this option is not specified, the command will not be sent so the printer’s default value will be used.

Example: The command to set the text length to 40 lines is “Ip -o t1=40 <filename>".
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U Banner Page

A banner page is automatically generated for each file in each job. The banner page is always sent as a PCL5e job,
including the following items.

* Name of the user who performed printing

¢ Job ID number and workstation name from which the job was sent

* Job title (This can be specified using the “-t” option. The same title controlled by the “Ip” command is normally applied

to each job.)
» Option specified when printing was performed
¢ Number of printed sheets

* Name of the printer and its IP address
¢ Date and time n

Only one copy of the banner page is printed for each file, even if a number of copies of the job are requested. The banner

page is sent to the equipment as a separate sub-job so that it is never stapled to the document.

The banner page is printed with the following settings.

e Copies =1.

» Stapling off.

* Orientation = portrait.

* Duplex off.

* Paper size as requested by the “-0” parameter or the printer’s default value.

* The paper source and the media type for the banner page can be set to different values than the job’s paper source
and media type.

* Auto paper source selection or the requested banner page source or media type.

* Output bin as requested by the “-0” parameter or the printer default value.

* 6 lines perinch

* Auto-wrap on.

* Automatic carriage-return when a line-feed is sent.

* The banner page is designed to fit the paper bigger than Statement / A5.

The banner page uses the default paper size if paper is set to:
- Statement

- A5

- A6

- B5

- Postcard

* The default is that the banner page is printed before the job so that it is in the correct stacking order.

* When the language is set to “raw” the banner is always disabled.

* The paper source and the media type for the banner page can be set to values different than the job’s paper source
and media type. If a banner paper source is not specified then the auto source command is sent. If a banner media
type is not specified, then no banner media type command is sent, so the printer’s default value will be used.

« If the file being printed specifies the paper destination or the paper size internally, the banner page may printed to
the wrong output or on an incorrect paper size.

* Hole punching cannot be applied to banner pages.
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Banner Options

The banner page can be printed using the following options.

Option Value | Alternate Value Description

banner=last Print the banner page after the job so that it will be
physically on top of the job in the output tray.

banner=first banner Print the banner page before the job so that it will be
physically under the job in the output tray.

nobanner nb Do not print a banner. The ability to specify the
“nobanner” option can be disabled by the system
administrator to force all jobs to print with a banner.

The default value for this option is that the banner page is printed first.
Example: The command to printing the banner page after the job is “Ip -o banner=last <filename>".

Banner Paper Source

The banner paper source can be specified using the following option.

Option Value | Alternate Value Description
bauto-source Select the auto paper tray selection.
bdrawer1 bupper Select the 1st drawer.
bcas1
bdrawer2 blower Select the 2nd drawer.
bcas2
bdrawer3 bpedupper Select the 3rd drawer.
bcas3
bdrawer4 bpedlower Select the 4th drawer.
bcas4
blcf BLCF Select the Large Capacity Feeder. The Large Capacity
Feeder is not available for some countries or regions.

If the banner paper source is not specified the PCL5e auto paper source command “<esc>&I7H” will be sent. The banner
page source cannot be set to manual feed. The paper size always has priority over the paper source.
Example: The command to specify that the banner page paper source is the Large Capacity Feeder is “Ip -o blcf

<filename>".
Banner Media Type
The banner page paper source can also be selected using the media type using the following option.
Option Value | Alternate Value Description
bmtype=Plain A paper source that contains Plain paper is requested.
bmtype= A paper source that contains transparency slides is
Transparency requested.
bmtype=Thick1 A paper source that contains Thick1 paper is
requested.
bmtype=Thick2 A paper source that contains Thick2 paper is
requested.
bmtype=Thick3 A paper source that contains Thick3 paper is
requested.

The paper size always has priority over the media type and the paper source.

If this option is not specified, the command will not be sent so the printer’s default value will be used to print the banner
page.

The command to specify that the banner page should be printed on a media type is “Ip -o bmtype=Plain1 <filename>".
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MANAGING PRINT JOBS FROM THE
CONTROL PANEL

This chapter describes how to use the control panel to control the print jobs and monitor the equipment.
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Monitoring the Print Job Status

Your print jobs can be monitored on the equipment’s touch panel. The types of print jobs you can monitor include Normal
Print, Scheduled Print, Private Print, Hold Print and Proof Print. If the Department Management feature is enabled, the
equipment can also display the Invalid jobs, which are held without being printed. You can view the status, as well as
release, delete, pause/resume, and change the order of these jobs. Connecting a USB storage device to the equipment
allows you to print PDF, encrypted PDF, XPS, JPEG, PRN and PS files contained in the media directly from the touch
panel without using a client computer (USB Direct Printing).

* If the equipment is managed by the User Management feature, you need to enter the user information, such as the
user name and password.
* These functions below are available only when the hard disk is installed in the equipment.
- Scheduled Print jobs
- Proof Print jobs
- Private Print jobs
- Hold Print jobs
- Invalid jobs
- Skipping jobs

1 P.159 “Normal Print / Scheduled Print jobs”

3 P.164 “Proof Print jobs”

3 P.167 “Private Print jobs”

Ed P.171 “Hold Print jobs”

Ed P.175 “Invalid jobs”

3 P.178 “Printing files from USB media (USB Direct Printing)”

Tip

Only when the Fax received print function is enabled, will the following be possible. Hold Print jobs for faxes stored in
the equipment after they have been received can be displayed in the list, which appears when you press the [PRINT]
button on the control panel and then [HOLD (FAX)]. For details of the Fax received print function, contact your service
technician.
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l Normal Print / Scheduled Print jobs

When you press [JOB STATUS] on the touch panel, the [JOBS] tab of the JOB STATUS screen appears. On the [JOBS]
tab, Normal Print and Scheduled Print jobs are listed together with copy jobs. You can check the user name, date and time
of registration, paper size, number of pages, number of copies, and current status of each job. You can also delete, pause
or resume each job, and change the order of the jobs on the list.

When the Job Skip function is enabled, a job fails due to lack of paper or such is automatically skipped and the next job is
processed. For instructions on how to set the Job Skip function, refer to the User’s Manual Advanced Guide.

JOB STATUS ?
PRINTING
Press [JOB STATUS] to return
[ Fax [ scan
User Name ‘ Date,Time ‘ Paper ‘Pages ‘ Sets ‘ Status
% User01 10,1316 A4 30 1 Printing
é User02 10,1316 A4 30 1 Ready 7
% User03 10,14:03 A4 10 1 Ready {
% User04 10,14:03 A4 20 1 Ready
é User05 10,1402 A4 3 1 | Scheduled
JOBS LOG SUPPLY

PRINTING 2l H:‘ JOBSTATUS

For the Scheduled Print jobs, “Scheduled” is indicated in the “Status” column.
Up to 1000 jobs can be listed. For equipment with no hard disk installed, up to 500 jobs are displayed.

To display the previous or next page, press or . The number of jobs displayed on a page may vary depending on
the equipment used.

To exit from the JOB STATUS screen, press [CLOSE].

Tips

* On the [JOBS] tab, you can select the desired mode for monitoring the status by pressing [PRINT], [FAX], or
[SCAN]. For details on the scan or Internet fax job status, refer to the User's Manual Basic Guide.

* Besides the Job Skip function, this equipment prevents the process of a print job from being paused with some
setting changes. When paper has run out during printing, for example, you can continue printing with Automatic
Change of Paper Source (a function that feeds paper in the same size from another drawer when paper in the
specified drawer has run out). Also when staples have run out or when the hole punch dust bin has become full,
you can continue printing without stapling or hole punching. For the details, refer to the User’'s Manual Advanced
Guide.
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U Deleting jobs
Follow the procedure below when you want to delete unnecessary Normal Print / Scheduled Print jobs.

On the [JOBS] tab listing the print jobs (L1 P.159), select the job that you want to delete,
and then press [DELETE]. You can select more than one job.

JOB STATUS ?

PRINTING
Press [JOB STATUS] to return

R

User Name ‘ Date,Time ‘ Paper ‘Pages ‘ Sets | Status
ﬁ User01 10,13.06 A4 30 1 | Printing
A= | User02 10,1306 A4 30 1_| Readv 7
é‘-‘ User03 10,1307 1 | Ready {
| = 10, 1007 A ou I noady ‘ S
| = | useros 10,1307 A4 30 1 | Ready ‘ v

DELETE

SUPPLY

JOB STATUS
PRINTING

PRINT

L hius

»& User01 g
5 = Delete OK?

ser
= 1
& oo | I
=) Usoros ‘ DELETE l CANCEL ] 5
% User05 i

| DELETE CLOSE I

JOBS LOG SUPPLY TONER

PRINTING & JOBSTATUS

The selected job is deleted.
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0 Pausing/Resuming jobs

Jobs whose status is “Wait” can be held in the queue (Pausing).

Pausing jobs
On the [JOBS] tab listing the print jobs (EJ P.159), select the job that you want to pause and then press [PAUSE].

JOB STATUS ?

PRINTING
Press [JOB STATUS] to return

e R

User Name ‘ Date, Time ‘ Paper ‘Pages ‘ Sets Status -
=) | User01 101314 Ad 30 1 | Wait |A
= User02 10,1315 Ad 30 1 Wait .
= | User03 10,1315 ?

‘ ] Yseius 14,1010 Ae ouU wait ‘ S
‘% User05 101316 | A4 30 1 Wait ‘|‘\:J

‘ DELETE % ‘

PRINTING

SUPPLY

JOBSTATUS

The selected job is paused. When a job is paused, the subsequent jobs on the list will be released earlier.

Resuming paused jobs
Select the job that you want to resume and then press [RESUME].

?

JOB STATUS

PRINTING
Press [JOB STATUS] to return

e R

User Name ‘ Date, Time ‘ Paper ‘Pages ‘ Sets Status
= | User01 101314 A4 30 1 Wait |
= User02 101315 Ad 30 1 Wait

10,1315

A U

U, 10,10

(] ~-[>

10,13:16 A4 30 1

SUPPLY

PRINTING
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0 Changing the job order

You can change the order of the jobs by moving them within the list.

You can only move jobs from and to those whose status is “Wait”.

On the [JOBS] tab listing the print jobs (L1 P.159), select the job that you want to move
in the list, and then press [MOVE].

JOB STATUS ?
PRINTING
Press [JOB STATUS] to return
e
| User Name ‘ Date,Time ‘ Paper ‘Pages ‘ Sels | Status ‘
[ = [ Usero1 104316 A4 30 1L wait A
ey | User02 10,1316 .
Ty ses 6TSSs e ) e ?
= Usero4 10,1335 A4 15 1| Wait
=) User0s 10,1336 Ad 10 1| Wait
| DELETE ‘ PAUSE ‘ MOVE
JoBS LoG SUPPLY TONER

PRINTING

If the target job is not displayed on the page, use and to change between pages.
2 Specify the new position of the job. (The job will be moved under the job selected here.)

JOB STATUS ?

Select the destination you want to move

R

User Name ‘ Date,Time ‘ Paper ‘Pages ‘ Sets | Status
= | Userot 10,1316 A4 30 1 | wait ‘A
& | usero2 10,1316 ‘ 1 | =
A= | Usero3 10,1335 Ad 15 1| wait —~
5
|-§ User0d 10135 o Ad 15 1| Wait ‘

T T % wan
= J\/ my !
| DELETE ‘ PAUSE

JOBS LoG SUPPLY TONER

PRINTING 3 JOBSTATUS

¥

JOB STATUS ?

PRINTING

Press [JOB STATUS] to re
) _sewn )

User Name ‘ Date,Time: ‘ Paper ‘Pages ‘ Sets | Status -
-:% User01 10,13:16 Ad 30 1 | Wait ‘ A
-& User03 10,13:35 A4 15 1 | Wait 5
A= | User04 10,13:35 Ad 15 1_| Wait ~
[ = User02 104316 A4 30 1| Wwai | °
(=) seiv RREY R v R |
JOBS LOoG SUPPLY TONER

PRINTING E‘:‘W“:‘;‘;g JOBSTATUS
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Q0 Confirming the information of a skipped job
You can confirm the information of a job skipped by the Job Skip function.

On the [JOBS] tab listing the print jobs (L1 P.159), confirm the information of the
skipped job.

1) Select the skipped job.

2) Press [RECOVERY INFORMATION].

JOB STATUS 2

PRINTING
Press [JOB STATUS] to return

-

| User Name ‘ Date,Time: | Paper ‘Paes ‘ Sets | Status ‘

| A2 [ userod 10,1209 Ad 2 1_| Scheduled

& | usero2 ‘ 10,1244 | A5 ‘ 5‘ 1|Sklpped

m\ml_)j

RECOVERY
[ oeere l [ ey TIOM” & PRNT “ CLOSE J

JOBS SuPHy TONER

PRINTING

2 Resolve the cause of the skip following the instructions on the screen.

OB A
RECOVERY INFORMATION
The list below shows the suspended job information.

Cause Unmatched paper size

Select the Cassette or Bypass fray

(1) Place paper of the displayed size and type on the bypass fray.
Recovery condition (2) Press [CLOSE] to close this menu, and [PRINT]
* I there is no such paper, clear the job and set another kind of paper.

PAPER SIZE AS
PAPER TYPE PLAN
DRAWER BYPASS FEED

CLOSE I

JUBSTATUS

If multiple causes exist, the second cause is displayed after you resolve the first one. Resolve all causes
accordingly.
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H Proof Print jobs

Proof Print refers to the function to print only a single copy as a sample and suspend the rest of the job when you print
multiple copies from a computer on the network.

After viewing the first copy, you can decide, on the Proof Print job list, whether to print out the remaining copies or cancel
the job to change the settings. If you select to print the remaining copies, you can change the number of copies to print.
For detailed instructions on Proof Print, see the following page:

P.82 “Printing proof print jobs”

U Displaying the Proof Print job list

Follow the procedure below when you want to display the list of Proof Print jobs.

1 On the control panel, press the [PRINT] button.
) OO e
) OO ©
m@ VQWX@ FUNCTION CLEAR//
@ @ STOP
@ @ @ ST/:QI:T @
ACCESS g : &
0 mEmORY R -

2 Select [PROOF].

& PRINT PRCEGEN (2

JOB TYPE

7

] —PROOF

User01 e

Usero2 HOLD (FAX) '7

User03 1
=

User04 1

User05

User06

ADMIN PASSWORD .J

JOB STATUS

The Proof Print jobs are listed on the screen.

& PRNT 2
JOBTYPE

User Name ‘ Date, Time ‘ Paper ‘ Pages | Sets
User01 10,0855 Ad 2 1
User02 10,0956 Ad 2 1
User03 10,0956 Ad 2 1 1
User04 10,10:01 Ad 2 9 {
User05 10,10:03 Ad 2 2
User06 10,10:03 A4 2 5
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U Printing remaining copies

Follow the procedure below if you have checked the first copy and want to print the remaining copies.

1 On the Proof Print job list (C1 P.164), select the job for printing.

& PRINT 2
JOB TYPE [prRooF =1

User Name ‘ Date,Time ‘ Paper ‘ Pages | Sets
User01 10,0955 Ad 2 1
User02 10,0956 Ad 2 1
Lser03 10 0956 Ad 2 1 1
User04

| uUserus

10,1005

B
AL Z‘

| User06

10,10:03

Z
A4 2 5‘

| DELETE

[ Eomi

& PANT |

If the target job is not displayed on the screen, use and to change between pages.

2 Press [PRINT].

& PRNT ?
JOB TYPE [prRooF [ |
User Name ‘ Date,Time ‘ Paper ‘ Pages | Sets
User01 10,0955 A4 2 1
User02 10,0956 A4 2 1
User03 10,0956 Ad 2 1] 1
s
User0s 10,1003 A4 2 2
User06 10,1003 A4 2 5
| omemE [ Eom i O PANT

The remaining copies are printed out.
The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs (EJ P.159).

Tip

To change the number of copies to print, press [EDIT] and enter the number of copies. Pressing [PRINT] starts

the job.

EDIT

FILE NAME
OWNER

Pages

Sels

Document01.ixt

User04

2

v TEMPLATE .

‘ CANCEL |® PRINT

i e IV
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U Deleting Proof Print jobs

Follow the procedure below to delete Proof Print jobs.

On the Proof Print job list (L1 P.164), select the job that you want to delete, and then
press [DELETE].

& PRINT Y¢ TEMPLATE , ?
JOB TYPE [pRooF [ |
User Name ‘ Date, Time ‘ Paper ‘ Pages | Sets
User01 100955 | A4 2 1
User02 100956 A4 2 1
Llsar03 10 0956 Ad 2 1 1
=

|usevua 10, 1UUS A z z ‘
|User06 101003 | A4 2 5 ‘
| oeeme [ Eomi O PANT |

& E [ osSTATUS |

If the target job is not displayed on the screen, use and to change between pages.

2 When “Delete OK?” appears, press [DELETE].

& PRINT 2
ATTENTION
JOB TYPE
Sets
User01 1
Delete OK?
User02 1
User03 1 1
-
uooe | I - (-
User05 2
User06 5
| oeeme | ECTE. & PRNT |
& | JOBSTATUS |,

The selected job is deleted.
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M Private Print jobs

Private Print refers to the function to print a document from a computer on the network only when a set password is keyed
in to the equipment’s control panel. This function is useful when you want to print confidential documents and prevent
them from being seen by others. Private Print jobs can be released or deleted from the Private Print job list.

For detailed instructions on Private Print, see the following page:

P.80 “Printing private print jobs”

U Displaying the Private Print job list

Follow the procedure below to display the list of Private Print jobs.

1 On the control panel, press the [PRINT] button.

_\ MENU  FUNGTIONS INTERRUPT COUNTER
) O O
T| p e - ENERGY SAVER
(®)
N 2 0 ©
If the Private print job list is not displayed, select [PRIVATE] from @ ®G o
the box of the job types. bt e Wy e @
@ @ _sTop
-FILING ( Y (W)
eoe (2
FAX
= 9 (oo
_/ [ PRINT DATA MA\N'E:)WER

2 On the Private Print job list, select the desired user name and then press [OK].
& PRINT P

JOB TYPE PprRIVATE B

| User Name ‘

Useluz

User03 1

User04 1
User05

User06

* When you enter the nickname for [User name (Alias)] box on the [Others] tab on a Windows computer, and
send the job to the equipment, its nickname will be displayed on the Private Print job list. If not, the user
name that is entered to log in to your computer will be displayed on the Private Print job list.

* If you perform the operation as the administrator, press [ADMIN. PASSWORD] instead of selecting a user
name. The on-screen keyboard appears, with which you can enter the 6-to-64-digit administrator password.
In this case, the jobs can be deleted but are not allowed to be printed.
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3 Enter the password for the Private Print job, which has previously been set via the
computer, and then press [OK].

Rkkkhx
Ej‘j
Basic © | Back Space ‘ Clear

T A g g g ] e
)

e Shift J ‘ Space
‘ CANCEL | oK !

The Private Print jobs are listed on the screen.

& PRNT 2
JOB TYPE [pRVATE =1
» User01
Document Name: ‘ Date, Time ‘ Paper ‘ Pages | Sets
Document01.ixt 10,0903 Ad 2 1
Document02ixt 10,0803 Ad 2 1
1
Document03ixt 10,0903 Ad 2 1 =
2
Document04.ixt 10,0902 Ad 2 1
Document05xt 10,0902 Ad 2 1 ‘ v
[+ RETURN | seLecT AL
JOBSTATUS

Tips

¢ When the Private Print job is sent from a Windows computer:
- When the user name that is entered to log in to your computer is used for [User name (Alias)], the
displayed list contains the Private Print jobs for which the same password has been set.
- When the nickname is entered for [User name (Alias)], the displayed list contains the Private Print jobs
for which the same nickname and the same password have been set.
* When the Private Print job is sent from a Macintosh computer or a UNIX/Linux workstation:
- The displayed list contains the Private Print jobs for which the same password has been set.
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Q Printing Private Print jobs

Follow the procedure below to release your Private Print jobs from the control panel.

On the Private Print job list (E1 P.167), select a job for printing. You can select more

than one job.

& PRINT ¢ TEWPLATE , TS
JOBTYPE PPRIVATE =1
» User01
Document Name: ‘ Date,Time ‘ Paper ‘ Pages | Sets
Document01txt 10,09.03 Ad 2 1
Documant2 txt 100903 Ad 2 1
3
Doctmento3xt 10,0803 - —
2
|UOCUmErﬂU4‘K‘ 10,usuz Ag r4 Al ‘
| Document051xt 100902 | A4 2 ‘ ‘ v
[ meTURN J‘ DELETE J‘ ALL CLEAR J| SELECTALLJ

O PANT |

» If the target job is not displayed on the screen, use and to change between pages.
* If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press

[ALL CLEAR].

2 Press [PRINT].

& PRINT

JOB TYPE [pRVATE =]

» User01

vy TEMPLATE , ?

Document Name

‘ Date, Time ‘ Paper ‘Pages | Sets

Document01.ixt 10,0803

Ad 2 1

Document02ixt 10,0803

Document04.txt 10,0902

Ad 2

Document051xt 10,0902

1
Documento3txt 10,0903 —~
2

1

1

Ad 2
Ad 2

[+ reTan J‘ DELETE J‘ ALL CLEAR J| SELECTALLJ

The equipment starts printing.

The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs (EJ P.159).
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U Deleting Private Print jobs
Follow the procedure below to delete a Private Print job.

On the Private Print job list (E1 P.167), select the job that you want to delete, and then
press [DELETE]. You can select more than one job.

& PRINT Y¢ TEMPLATE , ?
JOB TYPE PRIVATE =]
» User01
Document Name: ‘ Date,Time ‘ Paper ‘ Pages | Sets
Document01txt 10,09.03 Ad 2 1
Documant2 txt 100903 Ad 2 1
3
Doctmento3xt 10,0803 - —
2
|uuuumemu4 Xt (IVAVELVPS A4 z 1 ‘ S
|Documemcs1x1 100902 | A4 2 1 H v
[t metean || peeTE || ALLcLEAR || SELECTALL O PANT |
& E JOBSTATUS

» If the target job is not displayed on the screen, use and to change between pages.
* If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press

[ALL CLEAR].

2 When “Delete OK?” appears, press [DELETE].
& PRINT z

| ATTENTION

JOB TYPE

» User01

Delete OK?
Document01.ix 1

Document021x;

B
]l Jl ]

Document04.ix;
Document051x

| 4 RETURN DELETE ALL CLEAR SELECT ALL

The selected job is deleted.
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H Hold Print jobs

Hold Print refers to the function to retain a document from a computer on the network until a user performs printing from
the equipment’s touch panel. This function is useful to prevent you forgetting to remove printed sheets. Hold Print jobs can
be released or deleted from the Hold Print job list.

For the detailed instructions on Hold Print, see the following page:

P.81 “Printing hold print jobs”

U Displaying the Hold Print job list

Follow the procedure below to display the list of Hold Print jobs.

1 On the control panel, press the [PRINT] button.
[\ MENU  FUNCTIONS INTERRUPT COUNTER
) O ©
00 ©
@ @ ) sToP
co0 G
ACCESS g &
:/ [ PRINT DATA| MAIN POWER

2 Select [HOLD].

& PRINT 7 1ewLATE
JOBTYPE

HOLD
User01 INVALID
s HOLD (FAX)
User03 1

=

User04 1

User05

User06

ADMIN PASSWORD .J

JOB STATUS

The Hold Print jobs are listed on the screen.

& PRNT 2
JOB TYPE HoLD [-|
User Name
User01
User02
User03 1
_—
User04 1
User05
User06
ADMIN PASSWORD _}

JOBSTATUS
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3 On the Hold Print job list, select the desired user name.
& PRINT 7

JOB TYPE [roco [ |

| User Name. ‘

User01

skl Uz

User03 1

User04 1
User05

User06

ADMN PASSWORD _}

M JOBSTATUS ,

The displayed list contains the Hold Print jobs stored in the Hold Print queue.

* When you enter the nickname for [User name (Alias)] box on the [Others] tab on a Windows computer, and
send the job to the equipment, its nickname will be displayed on the Hold Print job list. If not, the user name
that is entered to log in to your computer will be displayed on the Hold Print job list.

* If you perform the operation as an administrator, press [ADMIN. PASSWORD] instead of selecting a user
name. The on-screen keyboard appears, with which you can enter the 6-to-64-digit administrator password.
In this case, the jobs can be deleted but are not allowed to be printed.

& PRINT 2
JOB TYPE HOLD [-]
» User01
Document Name: ‘ Date,Time ‘ Paper ‘ Pages | Sets
Document01ixt 10,0938 Ad 2 1
Document021xt 10,0937 Ad 2 1
1
Document03txt 10,0937 Ad 2 1] —
f
Document04.ixt 10,0937 A4 2 1
Document051xt 10,0937 Ad 2 1
|t RETURN | SELECT ALL

Tips

* When the Hold Print job is sent from a Windows computer:
- When the user name that is entered to log in to your computer is used for [User name (Alias)], the
displayed list contains the Hold Print jobs which have been registered by the selected user.
- When the nickname is entered for [User name (Alias)], the displayed list contains all the Hold Print jobs
which have been registered by users having the same nickname.
* When the Hold Print job is sent from a Macintosh computer or a UNIX/Linux workstation:
- The displayed list contains the Hold Print jobs which have been registered by the selected user.
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Q Printing Hold Print jobs

Follow the procedure below to process your Hold Print jobs from the control panel.

On the Hold Print job list (L1 P.171), select a job for printing. You can select more than

one job.
& PRINT 7 TEWLATE ,
JOB TYPE oo [ |
» User01
Document Name: ‘ Date,Time ‘ Paper ‘ Pages | Sets
Document01ixt 10,09:38 Ad 2 1
Document02ixi 100937 A4 > 1
a
Document031xt 10,0937 —
1
|UOCUmEV“UQ!K! LAV S by A4 4 1 ‘
|Dccumem()51x1 100937 | A4 2 1 ‘
[+ reman J‘ DELETE J‘ ALL CLEAR J| SELECTALLJ

» If the target job is not displayed on the screen, use and to change between pages.
If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press

[ALL CLEAR].

2 Press [PRINT].

& PRINT ?
JOB TYPE oo [ |
» User01

Document Name ‘ Date,Time ‘ Paper ‘ Pages | Sets
Document01ixt 10,0938 Ad 2 1
Document02ixt 10,0937 Ad 2 1 :
;
Document04.ixt 10,0937 Ad 2 1 !
Document05ixt 10,0937 Ad 2 1
[+ rean ” DELETE J‘ ALL CLEAR J| SELECTALLJ [ & PNt

The equipment starts printing.
The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs (E2 P.159).

Tip
The printed job will be deleted from the Hold Print job list.
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U Deleting Hold Print jobs

Follow the procedure below to delete a Hold Print job.

On the Hold Print job list (L1 P.171), select the job that you want to delete, and then
press [DELETE]. You can select more than one job.

& PRINT s TEMPLATE , ?
JOB TYPE oo [ |
» User01
Document Name: ‘ Date,Time ‘ Paper ‘ Pages | Sets

Document01ixt 10,09:38 Ad 2 1
Document? ixt 100937 Ad 5 1

q
Document031xt 10,0937 —

1
|uocumemu4!m LAV S by A4 4 1 ‘
|Dccumem()51x1 100937 | A4 2 1 ‘
|4_ RETURN ‘ DELETE ‘ ALL CLEAR | SELECT ALL

JOBSTATUS ,

» If the target job is not displayed on the screen, use and to change between pages.
* If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press

[ALL CLEAR].

2 When “Delete OK?” appears, press [DELETE].
& PRINT 2

| ATTENTION

JOB TYPE

» User01

Sets

Delete OK?

Document01 tx 1

Document02.x; 1

B =]
|
]l Jl J

Document04.ix; 1
1

Document051x

& PRNT |

| 4 RETURN DELETE ALL CLEAR SELECT ALL

B 108 STATUS |,

The selected job is deleted.

Tip

You cannot use the print job list to delete fax/Internet Fax jobs and E-mail reception print jobs.
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H Invalid jobs

An Invalid job refers to a job being held due to an incorrect or no department code being entered for performing the job. If
the equipment is managed by the Department Management feature with the SNMP network services disabled, entering an
incorrect department code for printing from a computer on the network causes the job to be held as an invalid job and
stored in the Invalid job queue. To release the job from the queue, enter the correct department code on the [JOBS] tab
listing the Invalid jobs.

A print job whose number of copies to print exceeds the limit specified for a particular department code cannot be
printed out. In this case, ask the administrator for help.

U Displaying the Invalid job list

Follow the procedure below to display the list of Invalid jobs.

Displaying the Invalid job list

1 On the control panel, press the [PRINT] button.
) O
0D ©
ptm@) W@WX@ FUION CLEAR//
(©OXOXO) .ﬂ
®o® Gl
ACGESS g : ®
_/ [ PRINT DATA MAIN POWER

2 Enter the correct department code with the on-screen keyboard and digital keys, and
then press [OK].

DEPARTMENT CODE ?
Enter Department Code.

@ ‘ DEPARTMENT CODE
KK K K
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3 Select [INVALID].

vy TEMPLATE , ?

JOB TYPE PRIVATE [-1
S SRIVATE
HOLD
User01 INVALID
Ul T
User03 1
-
User04 1
User05
User06
ADMIN PASSWORD J
JOBSTATUS

The Invalid jobs are listed on the screen.

vy TEMPLATE ,

J08 TYPE

User Name ‘ Date,Time ‘ Paper ‘ Pages | Sets
User01 10,10:16 Ad 2 1
User02 10,1017 A4 2 2
User03 10,1017 Ad 2 3 1
User04 10,1017 Ad 2 4 {
User05 10,1017 Ad 2 5
User06 10,1017 Ad 2 6

O Printing Invalid jobs

If you have entered an incorrect department code for printing, you need to re-enter the correct one. Follow the procedure
below.

1 On the Invalid job list (L1 P.175), select the job for printing.
?

JOB TYPE INVALID |
User Name ‘ Date,Time ‘ Paper ‘ Pages | Sets
User01 10,1016 Al 2 1
User02 10,1017 Ad 2 2
User03 101047 Ad 2 3 1
—~
i
|u=‘evua 10,1017 A4 z 5 ‘
| User06 10,1017 | A4
| DELETE

If the target job is not displayed on the screen, use and to change between pages.
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2 Press [PRINT].

& PRINT % TEVPLATE |,
JOB TYPE [NnvALD =]
User Name ‘ Date, Time ‘ Paper ‘ Pages | Sets
User01 10,1016 As4 2 1
User02 10,1047 Ad 2 2
User03 101017 Ad 2 3 1
P
|USE!UD o, s AL r4 9 ‘
|User()5 101017 A4 2 6 ‘
| DELETE ‘ & PRNT

Printing starts.

The job in progress can be monitored from the [JOBS] tab listing the Normal Print jobs (L P.159).

U Deleting Invalid jobs

Follow the procedure below to delete an Invalid job.

1 On the Invalid job list (1 P.175), select the job that you want to delete, and then press

& PRNT ?
JOB TYPE [nvALD |
User Name ‘ Date, Time ‘ Paper ‘ Pages | Sets
User01 10,10:16 Ad 2 1
User02 10,1047 Ad 2 2
Lser03 101017 Ad 2 3 1
_—
A

| uUserus

0,107 4

| User06

| N
o o

10,10:17 Ad

| DELETE

& PANT |

JOBSTATUS

If the target job is not displayed on the screen, use and to change between pages.

2 When “Delete OK?” appears, press [DELETE].

& PRINT

FSENEY
JOB TYPE

User01

User02

User03

v¢ TEMPLATE , ?

Delete OK?

DELETE CANCEL
e [ 5
User05

User06

| DELETE

The selected job is deleted.
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H Printing files from USB media (USB Direct Printing)

USB Direct Printing refers to the printing of files saved in a USB storage device that is connected to the USB port on the
equipment. With this feature, you can print PDF, encrypted PDF (file extension: “.pdf’), XPS (file extension: “.xps”), JPEG
(file extension: “.jpg” or “.jpeg”), PRN (file extension: “.prn”), and PS (file extension: “.ps”) files.

USB Direct Printing requires the USB Direct Print setting to be enabled on TopAccess. For details, refer to the
TopAccess Guide.

You cannot specify which page(s) of the selected file to print. All pages are to be printed.

USB Direct Printing supports the printing of PDF files whose versions are from 1.3 to 1.7.

With this feature, the equipment can print encrypted PDF files whose encryption level is either “40-bit RC4” or “128-
bit RC4.”

The feature does not support encrypted PDF files whose encryption level is [128bit AES], and some files of other
encryption levels may not be printable as well. In these cases, print these files from a client computer.

PDF files are printed with the sizes defined in the Page Size in each one.

If the size defined in the PDF file is not supported in the equipment, it is printed as a custom paper size.

(If the defined size is outside the supported range, the width and the height are automatically converted into one
within the range.)

When you want to print PDF files with paper placed in a drawer, select it on the touch panel.

If the paper size placed in the drawer is smaller than the one defined in the PDF file, a part of images may not be
printed.

For printing the PRN files, the page description languages supported by USB Direct Printing are PostScript 3,
PCL5e, PCL5c, PCL6 and XPS.

Do not turn on the equipment when a USB storage device is connected to the port.

The USB storage device should meet the following requirements:

- FAT16 and FAT32 formats

- Single-partition (USB media with multiple partitions are not supported.)

However, some of the devices may not be used in this equipment, even though these requirements have been met.

Connect your USB storage device to the USB port on ——
the equipment.

In a few seconds, “Found USB DEVICE” appears at the lower left of
the screen.

Do not disconnect the USB storage device when “USB DEVICE in
use Do not remove USB DEVICE” is displayed on the screen.
Removing the device while the message is displayed could destroy
the data in the device or cause a malfunction of the equipment.

\,
i

NN
/4

On the control panel, press the [PRINT] button.

-
» If the equipment is not managed by department codes, proceedto [ ) = FU&M ' @
Step 4 ENERGY SAVER
(®)
o6 O
s, FUNCTION CLEAR
) 006 gy
@ @ STOP
e-FILING @ (W)
©ee (L
ACCESS @m
—/ g PRINT DATA MMN'E?WER
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Enter the department code using the on-screen keyboard and digital keys, and then
press [OK].

DEPARTMENT CODE ?
Enter Department Code.

0 o
* % %k %

Found USB DEVICE

The above screen will not be displayed when the equipment is not managed by department codes. Proceed to
the next step.

4 Select [USB].

& PRINT ?
JOB TYPE PRIVATE -]
P - 7. =
HOLD
I PROOF
User01 [NIVZYN

“UsB

User02
Sy
User03 h 1
-
S

User04

User05

User06

ADMN PASSWORD _}

Foun USB DEVICE BRI ossTATUS |

Do not disconnect the USB storage device when “USB DEVICE in use Do not remove USB DEVICE” is
displayed on the screen. Removing the device while the message is displayed could destroy the data in the
device or cause a malfunction of the equipment.
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5 In the list of files, select the file that you want to print. Select the files you want to print
from the list.

& PRINT 2
JOBTYPE UsB [-]
Document / Folder Name
FOLDERO1
FOLDER02
FOLDFRO3 001

| File01pdf

12 |
| | | rievzira ‘
[2 |

-| File03ps

Found USB DEVICE = JOBSTATUS ,

 If the target file is not displayed on the screen, use and to change between pages.
* To select a file contained in a folder, select the folder and press [OPEN]. In the list of files that appears, select

the desired file to print.
» If you select an encrypted PDF file for which a password has been set, the password entry screen is displayed.

Proceed to Step 6.
» If you change the paper size, stapling position, 2-Sided Printing setting or PDF Overprint setting, proceed to
Step 9. If you start printing without changing any of them, proceed to Step 10.

Do not disconnect the USB storage device when “USB DEVICE in use Do not remove USB DEVICE” is
displayed on the screen. Removing the device while the message is displayed could destroy the data in the
device or cause a malfunction of the equipment.

6 If you select an encrypted PDF file for which a password has been set, press
[PASSWORD].

= PRIN % TEMPLATE .
USB PRINT

This document is protected by security.

:;F ‘ PASSWORD .

| canceL ] I oK ]

JUBSTAIUS |
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Using the on-screen keyboard and the digital keys, enter the user or master password
for the encrypted PDF file, and then press [OK].

EE
| Back Space ‘ Clear

[ || snit
‘ CANCEL | oK !

 If the selected encrypted PDF file was created on Adobe Acrobat 6.0 or later, enter the document open
password or permissions password.

* To print an encrypted PDF file for which “Low Resolution (150 dpi)” is set on Adobe Acrobat, you must enter
the permissions password that was set for the file when it was created.

8 Press [OK].

Tips

e TEMPLATE

= _PRIN
USB PRINT

This document is protected by security.

I

<0

‘ PASSWORD J ‘ ******
»

‘ CANCEL oK

* If you change the paper size, stapling position, 2-Sided Printing setting or PDF Overprint setting, proceed to
Step 9. If you start printing without changing any of them, proceed to Step 10.
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9 Press [SETTINGS] and then select the setting items as required.

Tips

* To print a JPEG file, you can set [SIZE].
* To print a PDF file, you can set [FINISHING], [2-SIDED] and [PDF Overprint].

1) Press any of [SIZE], [FINISHING], [2-SIDED] and [PDF Overprint].
2) Select the desired item.
3) Press [OK] when you finish the setting.

PRIN sle TEMPLATE .
| SETTNGS

SET

‘k’ SIZE i 2 FINISHNG L_@ 2.SDED EUly
‘ CANCEL | PRINT | \
JUBSTAIUS |
* SIZE
Set the paper size.
= PRI S TEMPLATE .
| SIZE SETTNG 2
Select a paper size.
5 =)
[ LT J[ LG _][ mm_j
FOLIO | 8550 I

RESET J | CANCELJ oK |

* FINISHING
Set the position of stapling.

Select Finishing Mode.

U o

RESET J | CANCELJ oK |

11 S

NON-STAPLE — Select this not to staple.
STAPLE — Select this to staple.
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e 2-SIDED
Set 2-Sided Printing.

= PR sle TEMPLATE .

=11\
[ 2-sbED 2
Select 2-SIDED Print Mode.

o -

‘ RESET ‘ GANGEL oK ‘

1 SIDE — Select this to print only one side.

BOOK — Select this to print on both sides by setting a vertical binding margin. Pages are turned over from right to
left.

TABLET — Select this to print on both sides by setting a horizontal binding margin. Pages are turned over from
bottom to top.

e PDF Overprint
If a PDF file contains an overprint, this is also overprinted on a print job when this option is enabled.

sle TEMPLATE .

= =11\
[ PDF Overprint ?
Select Overprint setting,

ON
ElEN » - | =2 -

‘ RESET ‘ GANGEL oK ‘

OFF — Select this not to overprint the job.

ON — Select this to enable overprint the job.

ON (PDF/X ONLY) — Select this to enable overprint the job only when the original PDF file is complied with PDF/X
specifications.

* The paper size can be set only when you print a JPEG file. (If you print more than one JPEG file
continuously, the paper size you set for the first file in this step is applied to the second and the following.)

* The PDF Overprint setting is applied only to objects overprinted in the original PDF file. If you want to
preview the effect of overprint in the PDF file, you can do it with the Overprint Preview mode of Adobe
Reader by switching the preview screen.
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10 Press [PRINT].
& PRINT 7

JOB TYPE [uss =]

Document [ Folder Name

FOLDERO1
FOLDER02
FOLDERO3 001

[ | Fieo2sra

g File03ps

| ALLCLEAR || sETTRGS |

Found USB DEVICE

* The equipment starts printing. The printouts are directed to the receiving tray.
* The job in progress can be monitored from the [JOBS] tab listing the Normal Print jobs.

Before Disconnecting the USB Storage Device:

Make sure that “USB DEVICE in use. Do not remove USB DEVICE.” is not displayed on the touch panel. Ifitis, do
not disconnect the USB storage device; removing the device while the message is displayed could destroy the data
in the device or cause a malfunction of the equipment.
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Viewing the Print Job Log

You can view the log of print jobs on the touch panel.

Viewing the print job log

1 On the touch panel, press [JOB STATUS].

@3 copy

READY

100 % NON-SORT

ORG - A4 NON-STAPLE
zoom | |5 FnsHNG | (Gee  AUTO
o1 3% coon

»
§ AUTO
o 600

EXIT -
‘\J TRAY. ' 1=1 /
[RATAETE o
] |AUTO| I
’ o ORIGINAL »
>

MODE
BASIC EDIT IMAGE

3

L PROOF COPY

JOBSTATUS

O

2 Press [LOG] to display the [LOG] tab.

JOB STATUS ?

e R T

User Name ‘ Date,Time ‘ Paper ‘ Pages ‘ Sets | Status
-:% User01 10,08:15 Ad 1 1 | Scheduled
v% User02 10,1207 A4 1 5 | Scheduled :
ﬁ User03 10,1208 A4 1 1 | Scheduled {
»& User04 10,1208 A4 82 1 | Scheduled
% User05 10,12:09 A4 2 1 | Scheduled

CLOSE

JOBS LOG SUPPLY TONER

2011/05/ 10
[ JoBSTATUS |,
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3 Press [PRINT].

JOB STATUS ?

‘ PRINT ‘ SEND
>

REGEIVE

SCAN
>

CLOSE

SUPPLY TONER

W JOBSTATUS .

The Print Log is displayed.

OB A

| PRNT LOG 2
User Name Date,Time Paper | Pages | Seis
=) User0t 10,1226 A4 3 1
=) User02 10,1225 A4 2 2 ;
[j 10,1224 Ad 1 1]
8
10,1223 A4 f [T ——
B |- 10,1222 A4 1 1 | v I
CLOSE I

JUBSITATUS

On the Print Log, each job’s user name, date and time of the job, paper size, the number of pages and the number
of copies are displayed.
Up to 1000 jobs can be listed on the log. For equipment with no hard disk installed, up to 100 jobs are displayed.

To display the previous or next page, press or . The number of jobs displayed on a page may vary
depending on the equipment used.

To exit from the Print Log screen, press [CLOSE].
Tip

If the equipment encounters an error while printing, it records and displays an error code in the User Name
column. For details on print job errors and error codes, refer to the Troubleshooting Guide.
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Checking Supplies

H Viewing the drawer status

When the equipment is idle, pressing [JOB STATUS] > [SUPPLY] displays the [SUPPLY] tab. From this tab, you can view
the paper size setting selected for each drawer. If you press [SUPPLY] when printing is in progress, the drawer from which
paper is being fed is highlighted.

If you try to print a document from a client computer and specify a paper size while none of the drawers or bypass tray on
the equipment has the specified size of paper, a printing error occurs, and [JOB STATUS] blinks. In this case, pressing
[JOB STATUS] displays the [SUPPLY] tab, from which you can learn which drawer needs additional sheets of paper. For
further instructions on how to clear a printing error, refer to the Troubleshooting Guide.

l Checking remaining toner levels

Pressing [JOB STATUS] > [TONER] displays the [TONER] tab from which you can check the approximate amount of toner

remaining in the toner cartridges.

If any of the toner cartridges is running out, be sure to get a new cartridge ready. For more information about replacing H
toner cartridges, refer to the Troubleshooting Guide.
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OTHER PRINTING METHODS

This equipment also supports the following printing methods:
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FTP Printing

FTP printing is available when the FTP print service is enabled in this equipment.

You can print a document by sending the print file to this equipment using the FTP. This equipment can accept the
following files for printing:

* PCL file

* PS (PostScript) file

* Textfile

When the User Management setting is enabled, a print job sent in FTP printing is processed as an invalid job
according to the User Authentication Enforcement setting. For more information about the User Authentication
Enforcement setting, refer to the TopAccess Guide.

Tips
* In Windows, you can create the PCL file and PS file using the printer driver. To create the PCL file or PS file,
change the printer port of the printer driver to “FILE:” port and print a document using the printer driver. For more
information about printing to a file, refer to the Windows documentation.
¢ In Macintosh, you can create the PS file using the printer driver. To create the PS file, select “File” at the
[Destination] box in the Print dialog box to print. For more information about printing to a file, refer to the Macintosh
documentation.

Printing a file using the FTP command

The procedure below describes the example of printing using the FTP command with the MS-DOS Prompt.
1 Launch the MS-DOS Prompt.
2 Change the current directory to that in which the print file is located.

3 Type following command and press the [Enter] key:

ftp <IP Address>
In the <IP Address> section, enter the IP address of this equipment.

4 If it prompts you to enter the user name, enter the FTP Print User Name and press the
[Enter] key.

It prompts you to enter the user name if the FTP Print User Name is assigned by an administrator. Ask your
administrator for the FTP Print User Name.

5 If it prompts you to enter the password, enter the FTP Print Password and press the
[Enter] key.

* It prompts you to enter the password if the FTP Print User Name is assigned by an administrator. Ask your
administrator for the FTP Print Password.

* If the FTP Print User Name has been assigned but the FTP Print Password is blank, do not enter when it
prompts you to enter the password and press the [Enter] key.

6 Type the following command and press the [Enter] key:

put <file name>
For example, if the print file name is “sample.ps”:
put sample.ps

7 The file is sent to this equipment and spooled in the queue.

190 FTP Printing



Email Printing

Email printing is available only when the Email print service is enabled in this equipment.

You can print a document by sending the print file to this equipment as an email attachment using the mail client software.
This equipment can accept the following for printing; TIFF-FX (Profile S), TIFF-FX (Profile F), TIFF-FX (Profile J), TIFF
images scanned in black and white, and text data (email messages in the plain text format).

If any files failing to meet the above conditions are attached to a received e-mail, an e-mail printing error occurs and is
recorded as an error code on the RECEIVE log. On TopAccess, the “Email Print” settings are available for the
administrator so that error codes can be printed as a report. The administrator can also set the equipment to forward such
e-mail to another e-mail address. For details, refer to the TopAccess Guide.

* When the User Management setting is enabled, a print job sent by Email is processed as an invalid job according
to the User Authentication Enforcement setting. For more information about the User Authentication Enforcement
setting, refer to the TopAccess Guide.

* An Email print job has two printing types, Discard Printing and RX Reduction Printing, that can be set by pressing
the [RX PRINT] button in [FAX] of the ADMIN menu on the control panel.

When Discard Printing is ON, the part of the print image that exceeds the paper printing area is discarded if the
printimage is up to 10 mm larger than the printing area. If the printimage is 10 mm larger or more than the printing
area, the print image is printed on the largest sheet of paper.

When Discard Printing is OFF, the print image is printed on the largest sheet of paper if its length exceeds the
paper printing area.

When RX Reduction Printing is ON, it will be vertically reduced to fit on the paper if the print image is longer than
the paper. When the print image cannot fit in the paper even if the print image is reduced, the print image is printed
on the largest sheet of paper.

When RX Reduction Printing is OFF, the print image is printed on the largest sheet of paper if its length exceeds
the paper printing area.

Printing a file using the email client

The procedure below gives an example of printing using Microsoft Outlook Express.

When you send an email message to this equipment to print a file, send it in plain text format. If you send an email
message in HTML format, this equipment prints the HTML source code of the message.

Open your email application and create a new mail message.
Enter the email address of the equipment in the To: line.
Enter text in the Subject line or leave the Subject line blank.
Enter text in the body field.

Attach the file you want to print.

oONhLhWN-

Send the email.

The header and body of the email will be printed only when the “Print Header” and “Print Message Body” for the
Email print service are enabled in this equipment.
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APPENDIX

This chapter provides the following contents.
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Internal Fonts List

The following fonts are included in this equipment.

H Internal PCL fonts list

0 | Courier 42 | Helvetica-Narrow-Bold

1 CG-Times 43 | Helvetica-Narrow-Oblique

2 | CG-Times Bold 44 | Helvetica-Narrow-BoldOblique
3 | CG-Times ltalic 45 | Palatino-Roman

4 | CG-Times Bold Italic 46 | Palatino-Bold

5 | CG Omega 47 | Palatino-ltalic

6 | CG Omega Bold 48 | Palatino-Boldltalic

7 | CG Omega ltalic 49 | ITC AvantGarde-Book

8 | CG Omega Bold ltalic 50 | ITC AvantGarde-BookOblique
9 | Coronet 51 | ITC AvantGarde-Demi

10 | Clarendon Condensed 52 | ITC AvantGarde-DemiOblique
11 | Univers Medium 53 | ITC Bookman-Light

12 | Univers Bold 54 | ITC Bookman-Lightltalic

13 | Univers ltalic 55 | ITC Bookman-Demi

14 | Univers Bold Italic 56 | ITC Bookman-Demiltalic

15 | Univers Medium Condensed 57 | NewCenturySchibk-Roman
16 | Univers Condensed Bold 58 | NewCenturySchibk-Bold

17 | Univers Medium Condensed ltalic 59 | NewCenturySchlbk-Italic

18 | Univers Condensed Bold ltalic 60 | NewCenturySchibk-Boldltalic
19 | Antique Olive 61 | Times-Roman

20 | Antique Olive Bold 62 | Times-Bold

21 | Antique Olive Italic 63 | Times-ltalic

22 | Garamond Antiqua 64 | Times-Boldltalic

23 | Garamond Halbfett 65 | ITCZapfChancery-Mediumltalic
24 | Garamond Kursiv 66 | Symbol

25 | Garamond Kursiv Halbfett 67 | Symbol PS

26 | Mrigold 68 | Wingdings

27 | Albertus Medium 69 | ITCZapfDingbats

28 | Albertus Extra Bold 70 | Courier Bold

29 | Arial 71 | Courier ltalic

30 | Arial Bold 72 | Courier Bold ltalic

31 | Arial ltalic 73 | Letter Gothic Regular

32 | Arial Bold Italic 74 | Letter Gothic Bold

33 | Times New Roman 75 | Letter Gothic ltalic

34 | Times New Roman Bold 76 | CourierPS

35 | Times New Roman ltalic 77 | CourierPS Oblique

36 | Times New Roman Bold Italic 78 | CourierPS Bold

37 | Helvetica 79 | CourierPS BoldOblique

38 | Helvetica-Bold AndaleMonoWTJ "1

39 | Helvetica-Oblique AndaleMonoWTK ™

40 | Helvetica-BoldOblique AndaleMonoWTT "1

41 | Helvetica-Narrow AndaleMonoWTS "1

*1  These fonts can be added when the optional Unicode Font Enabler is installed.
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H Internal PS fonts list

AlbertusMT-Light

Eurostile-ExtendedTwo

AlbertusMT

Eurostile-BoldExtendedTwo

AlbertusMT-lItalic Geneva
AntiqueOlive-Roman GillSans-Light
AntiqueOlive-Italic GillSans-Lightltalic
AntiqueOlive-Bold GillSans
AntiqueOlive-Compact GillSans-ltalic
Apple-Chancery GillSans-Bold

ArialMT GillSans-Boldltalic
Avrial-ltalicMT GillSans-ExtraBold
Arial-BoldMT GillSans-BoldCondensed
Avrial-BoldltalicMT GillSans-Condensed
AvantGarde-Book Goudy
AvantGarde-BookOblique Goudy-ltalic
AvantGarde-Demi Goudy-Bold

AvantGarde-DemiOblique

Goudy-Boldltalic

Bodoni Goudy-ExtraBold
Bodoni-Italic Helvetica
Bodoni-Bold Helvetica-Oblique

Bodoni-Boldltalic

Helvetica-Bold

Bodoni-Poster

Helvetica-BoldOblique

Bodoni-PosterCompressed

Helvetica-Condensed

Bookman-Light

Helvetica-Condensed-Oblique

Bookman-Lightltalic

Helvetica-Condensed-Bold

Bookman-Demi

Helvetica-Condensed-BoldObl

Bookman-Demiltalic

Helvetica-Narrow

Candid

Helvetica-Narrow-Oblique

Chicago

Helvetica-Narrow-Bold

Clarendon-Light

Helvetica-Narrow-BoldOblique

Clarendon

HoeflerText-Regular

Clarendon-Bold

HoeflerText-Italic

CooperBlack

HoeflerText-Black

CooperBlack-Italic

HoeflerText-Blackltalic

Copperplate-ThirtyTwoBC

HoeflerText-Ornaments

Copperplate-ThirtyThreeBC

JoannaMT

Coronet-Regular

JoannaMT-Italic

Courier

JoannaMT-Bold

Courier-Oblique

JoannaMT-Boldltalic

Courier-Bold

LetterGothic

Courier-BoldOblique

LetterGothic-Slanted

Eurostile

LetterGothic-Bold

Eurostile-Bold

LetterGothic-BoldSlanted

LubalinGraph-Book

Univers-CondensedBold

LubalinGraph-BookOblique

Univers-CondensedBoldOblique

LubalinGraph-Demi

Univers-Extended

LubalinGraph-DemiOblique

Univers-ExtendedObl

Marigold

Univers-BoldExt

Monaco

Univers-BoldExtObl

MonalLisa-Recut

Wingdings-Regular

NewCenturySchlbk-Roman

ZapfChancery-Mediumltalic
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NewCenturySchlbk-Italic ZapfDingbats
NewCenturySchlbk-Bold IPAexGothic
NewCenturySchlbk-Boldltalic IPAexMincho

NewYork

Optima

Optima-ltalic

Optima-Bold

Optima-Boldltalic

Oxford

Palatino-Roman

Palatino-Italic

Palatino-Bold

Palatino-Boldltalic

StempelGaramond-Roman

StempelGaramond-ltalic

StempelGaramond-Bold

StempelGaramond-Boldltalic

Symbol

Taffy

Times-Roman

Times-Italic

Times-Bold

Times-Boldltalic

TimesNewRomanPSMT

TimesNewRomanPS-ItalicMT

TimesNewRomanPS-BoldMT

TimesNewRomanPS-BoldltalicMT

Univers-Light

Univers-LightOblique

Univers

Univers-Oblique

Univers-Bold

Univers-BoldOblique

Univers-Condensed

Univers-CondensedOblique
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